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 Introduction Microsoft Office XP provides you with all the familiar Office applications and provides you with many new enhancements that make it easier for you to create your various Office documents. Microsoft Office XP includes the following applications: • Word—A versatile word-processing application that enables you to create every possible type of document from simple letters to newsletters to reports that include charts and tables. • Excel—A powerful spreadsheet program that enables you to create simple worksheets or specialty worksheets such as invoices and financial statements. Excel provides all the tools and formulas for doing simple math or special statistical and financial calculations. • PowerPoint—An easy-to-use presentation application that enables you to create eye-catching and impressive slide shows that can be shown from your computer monitor or other video output device. PowerPoint also enables you to print presentation outlines and speaker’s notes for your presentations. • Access—A relational database application that is extremely powerful, yet very straightforward to use. Access provides several database wizards that help you create your own databases quickly and efficiently. • Outlook—A personal information manager that will help you keep organized. Outlook not only helps you manage your contacts, appointments, and tasks, it also serves as your e-mail and fax client. • FrontPage—A Web design tool that provides wizards to create several kinds of Web sites. You can quickly create a personal, business, or other type of Web site using FrontPage, and you can include graphics and navigational tools, such as hyperlinks.
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 Office XP provides you with all the applications that you need to do everything from creating letters, to balancing your sales books, to managing your contacts, to creating great presentations and Web pages. It’s all here: word processing, spreadsheets, databases, personal information management, Web site creation, and much, much more.
 
 WHY QUE’S 10 MINUTE GUIDE OFFICE XP?
 
 TO
 
 MICROSOFT
 
 The 10 Minute Guide to Microsoft Office XP can save you precious time as you get to know the different applications included in the Office suite. Each lesson is designed to be completed in 10 minutes or less, so you’ll be able to quickly learn many of the features provided by the Office applications such as Word, Excel, or FrontPage. Although you can jump around among lessons, starting at the beginning is a good plan. The new features found in the Office XP applications are discussed first and then you are provided with a basic overview of the application workspace provided by the Office applications. Since the interface is similar for each of the Office applications, the information covered related to one application may apply to other Office applications as well. For example, formatting text in Word is similar to formatting text in all the Office applications. So, Lesson 10, “Changing How Text Looks,” will not only get you up to speed on formatting text in Word, but the other Office applications as well.
 
 INSTALLING MICROSOFT OFFICE You can install Microsoft Office XP on a computer running Microsoft Windows 98, Windows NT 4.0, Windows 2000, and Windows XP. Microsoft FrontPage can be purchased as a stand-alone product on its own CD-ROM or it can be purchased as part of the Microsoft Office XP Special Edition (which comes on several CD-ROMs). Whether you are installing FrontPage as a stand-alone product or as part of the Microsoft Office XP suite, the installation steps are basically the same.
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 Introduction
 
 To install Office XP, follow these steps: 1. Start your computer. Then insert the Microsoft Office XP CD in
 
 the CD-ROM drive. The CD-ROM should autostart, providing you with the opening installation screen (for either FrontPage or Office, depending on the CD you are working with). 2. If the CD-ROM does not autostart, choose Start, Run in the
 
 Run dialog box, type the letter of the CD-ROM drive, followed by setup (for example, d:\setup). If necessary, use the Browse button to locate and select the CD-ROM drive and the setup.exe program. 3. When the Setup Wizard prompts you, enter your name, orga-
 
 nization and CD key in the appropriate box. 4. Choose Next to continue. 5. The next Wizard screen provides instructions to complete the
 
 installation. Complete the installation, select Next to advance from screen to screen after providing the appropriate information requested by the wizard. After you complete the installation from the CD, icons for the Office applications you have installed will be provided on the Windows Start menu. You can start any of the Office applications quickly; just click the Start button, point at Programs and then click the appropriate icon for the applications you wish to start.
 
 CONVENTIONS USED
 
 IN
 
 THIS BOOK
 
 To help you move through the lessons easily, these conventions are used: On-screen text
 
 On-screen text appears in bold type.
 
 Text you should type
 
 Information you need to type appears in a different bold type.
 
 Items you select
 
 Commands, options, and icons you are to select and keys you are to press appear in bold type.
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 In telling you to choose menu commands, this book uses the format menu title, menu command. For example, the statement “choose File, Properties” means to “open the File menu and select the Properties command.” In addition to those conventions the 10 Minute Guide uses the following icons to identify helpful information: PLAIN ENGLISH Term New or unfamiliar terms are defined in term sidebars.
 
 TIP Tips Read these tips for ideas that cut corners and confusion.
 
 CAUTION Cautions This icon identifies areas where new users often run into trouble; these tips offer practical solutions to those problems.
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 What’s New in Office XP In this lesson, you learn about the new features provided by the Office XP application suite.
 
 INTRODUCING MICROSOFT OFFICE XP Microsoft Office XP is the latest version of the popular Office application suite. Microsoft Office XP includes Outlook, Word, Excel, Access, PowerPoint, and FrontPage. These different application tools enable you to tackle a large variety of business and personal tasks on the computer. Microsoft Office XP offers a number of new enhancements to the Office suite. This lesson serves as a quick overview of some of these new features. Coverage of these features as they relate to specific applications in Office XP, such as Word or PowerPoint, are covered in the part of the book that is dedicated to that particular application.
 
 INTRODUCING VOICE DICTATION
 
 AND
 
 VOICE COMMANDS
 
 One of the most exciting new features in Office XP is voice dictation and voice-activated commands. If your computer is outfitted with a sound card, speakers, and a microphone (or a microphone with an earphone headset), you can dictate information into your Microsoft applications, such as Word and Excel. You also can use voice commands to activate the menu system in that application.
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 CAUTION Requirements for Getting the Most Out of the Speech Feature To make the Speech feature useful, you will need a fairly high-quality microphone. Microsoft suggests a microphone/headset combination. The Speech feature also requires a more powerful computer than the other Office XP applications typically need. Whereas Office XP needs only 32MB of RAM (memory) on a computer using Windows 98/Me (64MB for Windows 2000), Microsoft suggests using a computer with 128MB of RAM and a Pentium II (or later) processor running at a minimum of 400MHz. A computer that meets or exceeds these higher standards should be capable of getting the most out of the Speech feature.
 
 TRAINING
 
 THE
 
 SPEECH FEATURE
 
 Before you can really take advantage of the Speech feature, you must provide it with some training so that it can more easily recognize your speech patterns and intonation. After the Speech feature is trained, you can effectively use it to dictate text entries or access various application commands without a keyboard or mouse. The first time you start the Speech feature in an Office application, you are required to configure and train the feature. Follow these steps to get the Speech feature up and running: 1. In an Office application window such as Word or Excel,
 
 select the Tools menu and select Speech. The Welcome to Office Speech Recognition dialog box appears. To begin the process of setting up your microphone and training the Speech feature, click the Next button. 2. The first screen of the Microphone Wizard appears. It asks
 
 you to make sure that your microphone and speakers are connected to your computer. If you have a headset microphone, this screen shows you how to adjust the microphone for use. Click Next to continue.
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 3. The next wizard screen asks you to read a short text passage
 
 so that your microphone volume level can be adjusted (see Figure 1.1). When you have finished reading the text, click Next to continue.
 
 FIGURE 1.1 The Microphone Wizard adjusts the volume of your microphone.
 
 4. On the next screen, you are told that if you have a headset
 
 microphone, you can click Finish and proceed to the speech recognition training. If you have a different type of microphone, you are asked to read another text passage. The text is then played back to you. This is to determine whether the microphone is placed at an appropriate distance from your mouth; when you get a satisfactory playback, click Finish. When you finish working with the Microphone Wizard, the Voice Training Wizard appears. This wizard collects samples of your speech and, in essence, educates the Speech feature as to how you speak. To complete the voice training process, follow these steps: 1. After reading the information on the opening screen, click
 
 Next to begin the voice training process. 2. On the next screen, you are asked to provide your gender and
 
 age (see Figure 1.2). After specifying the correct information, click Next.
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 FIGURE 1.2 Supply the voice trainer with your gender and age.
 
 3. On the next wizard screen, you are provided an overview of
 
 how the voice training will proceed. You are also provided with directions for how to pause the training session. Click Next. 4. The next wizard screen reminds you to adjust your micro-
 
 phone. You are also reminded that you need a quiet room when training the Speech feature. When you are ready to begin training the speech recognition feature, click Next. 5. On the next screen, you are asked to read some text. As the
 
 wizard recognizes each word, the word is highlighted. After finishing with this screen, continue by clicking Next. 6. You are asked to read text on several subsequent screens. Words
 
 are selected as the wizard recognizes them (see Figure 1.3). 7. When you complete the training screens, your profile is
 
 updated. Click Finish on the wizard’s final screen. You are now ready to use the Speech feature. If you are new to Microsoft Office, you may want to explore using applications like Word and Excel in this book before trying to actually use the Speech feature. The next two sections discuss using the Voice Dictation and Voice Command features.
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 FIGURE 1.3 Read the text provided by each of the wizard screens.
 
 USING VOICE DICTATION When you are ready to start dictating text into an Office application such as Word, put on your headset microphone or place your standalone microphone in the proper position that you determined when you used the Microphone Wizard. When you’re ready to go, select the Tools menu and then select Speech. The Language bar appears, as shown in Figure 1.4. If necessary, click the Dictation button on the toolbar (if the Dictation button is not already activated or depressed). After you enable the Dictation button, you can begin dictating your text into the Office document. Figure 4.4 shows text being dictated into a Word document. When you want to put a line break into the text, say “new line.” Punctuation is placed in the document by saying the name of a particular punctuation mark, such as “period” or “comma.” CAUTION How Do I Insert the Word “Comma” Rather Than the Punctuation Mark? Because certain keywords, such as “period” or “comma,” are used to insert punctuation during dictation, you must spell these words out if you want to include them in the text. To do this, say “spelling mode,” and then spell out the word, such as co-m-m-a. As soon as you dictate an entire word, the spelling mode is ended.
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 FIGURE 1.4 Dictating text into the Office application.
 
 When you have finished dictating into the document, click the Microphone button on the Language bar (the second Microphone button from the left; the first is used to select the current speech driver, which you can leave as the default). When you click the Microphone button, the Language bar collapses, hiding the Dictation and the Voice Command buttons. You can also stop Dictation mode by saying “microphone.” You can minimize the Language bar by clicking the Minimize button on the right end of the bar. This sends the Language bar to the Windows System Tray (it appears as a small square icon marked EN if you are using the English version of Office). With the Language bar minimized in the System Tray, you can quickly open it when you need it. Click the Language Bar icon in the System Tray, and then select Show the Language Bar (which is the only choice provided when you click on the Language Bar icon).
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 Using the Dictation feature correctly requires that you know how to get the Speech feature to place the correct text or characters into an Office document. For more help with the dictation feature, consult the Microsoft Office Help system from any Office application.
 
 USING VOICE COMMANDS Another tool the Speech feature provides is voice commands. You can open and select menus in an application and even navigate dialog boxes using voice commands. To use voice commands, open the Language bar (click Tools, Speech). Click the Microphone icon, if necessary, to expand the Language bar. Then, click the Voice Command icon on the bar (or say “voice command”). To open a particular menu such as the Format menu, say “format.” Then, to open a particular submenu such as Font, say “font.” In the case of these voice commands, the Font dialog box opens. You can then navigate a particular dialog box using voice commands. In the Font dialog box, for example, to change the size of the font, say “size”; this activates the Size box that controls font size. Then, say the size of the font, such as “14.” You can also activate other font attributes in the dialog box in this manner. Say the name of the area of the dialog box you want to use, and then say the name of the feature you want to turn on or select. When you have finished working with a particular dialog box, say “OK,” (or “Cancel” or “Apply,” as needed) and the dialog box closes and provides you with the features you selected in the dialog box. When you have finished using voice commands, say “microphone,” or click the Microphone icon on the Language bar. Believe it or not, you can also activate buttons on the various toolbars using voice commands. For example, you could turn on bold by saying “bold.” The Bold button on the Formatting toolbar becomes active. To turn bold off, say “bold” again.
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 TIP Additional Training If you find that you aren’t getting very good results with either voice dictation or voice commands, you can do some additional training for the Speech feature. On the Language bar, click the Tools icon and then select Training from the shortcut menu that appears. Do the additional training exercises supplied by the wizard.
 
 SMART TAGS PROVIDE QUICK OPTIONS Another new enhancement that Microsoft Office XP provides is the smart tag. A smart tag is a special shortcut menu that provides you with additional options related to a particular feature. There are paste smart tags, AutoCorrect smart tags, and smart tags for dates, times, and addresses that you place in your Office documents. PLAIN ENGLISH Document A document is any file you create or use in an Office application. These files include Word documents, Excel workbooks, and PowerPoint presentations.
 
 For example, in the case of date and addresses smart tags, if you are typing a letter to a new contact, you can quickly add the address information that you place in the Word document into the Outlook Contacts list. The different Office XP applications, such as Microsoft Word, automatically detect date, time, and address information and provide you with the appropriate smart tag. Figure 1.1 shows a smart tag that has been placed on an address that has been entered into a letter. You can tell whether information has been “smart tagged” because it is underlined with a dotted red line. When you place your mouse on a smart tag, you can click to open a menu of options.
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 FIGURE 1.5 Smart tags provide you with quick access to additional options.
 
 Notice in Figure 1.5 that, in addition to the name “Smith” having a smart tag, Word has underscored the date with a dotted red line, indicating the presence of a smart tag. When you paste information into an Office application, you will find that a paste smart tag appears at the bottom of the pasted item. This enables you to access options related to your paste job, such as whether the information pasted should maintain its original formatting or be formatted the same as text or numbers that are in the same part of the document where you pasted the new information.
 
 INTRODUCING
 
 THE
 
 OFFICE TASK PANES
 
 One of the biggest changes to the Office environment in Microsoft Office XP is the introduction of the Office task pane. The task pane is a special pane that appears on the right side of a particular application
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 window. It is used in each Office application to house a number of features that were formerly controlled using dialog boxes. For example, there are task panes for using the Office Clipboard and the Clip Gallery. Figure 1.6 shows the Insert Clip Art task pane in the Microsoft Excel Application window. You will learn more about task panes in this book as you explore the various features supplied by the Office applications.
 
 FIGURE 1.6 Office task panes provide easy access to a number of Office application features.
 
 USING DOCUMENT RECOVERY Another new Office XP feature relates to document recovery when your computer crashes. When an Office application locks up and closes or when your entire computer crashes, a special Recovery pane opens the next time you start the application. This Recovery pane lists all the documents that were open in a particular application when the crash occurred.
 
 02 6602 ch01
 
 11/8/01
 
 2:25 PM
 
 Page 15
 
 What’s New in Office XP
 
 Only the last saved version of a particular document, workbook, database, or presentation opens in the Recovery pane, but you can quickly reopen it in the particular application by clicking the document’s name. The Recovery pane is meant to get you back up and working on a particular document as soon as you restart your system and open the application that you were working with.
 
 UNDERSTANDING PRODUCT ACTIVATION After you install Microsoft Office XP (which is discussed in the introduction of this book) and start one of the Office applications, a product activation window opens, as shown in Figure 1.7. You can activate Microsoft Office XP on only one computer; trying to activate it on subsequent computers will fail.
 
 FIGURE 1.7 Activation is required for you to use your copy of Office XP.
 
 Activating your copy of Microsoft Office XP is crucial. If the product is not activated, it runs only for a limited number of times before it becomes deactivated and unusable (it can be started 49 times before
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 deactivation). This new feature is an effort by Microsoft to stop software piracy related to Microsoft Office. You can activate Microsoft Office XP using the Internet or by phone. Just follow the prompts for activation after you install Microsoft Office XP from the Office CD. In this lesson you learned about some of the important new features provided by Microsoft Office XP. In the next lesson you will learn the basics of working in the Office environment.
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 Using Common Office Features In this lesson, you learn how to use common Office features such as menus, toolbars, dialog boxes, and task panes. You also learn how to set options for your Office applications.
 
 STARTING OFFICE APPLICATIONS The Microsoft Office applications can be quickly started from the Windows Start menu. Desktop icons can also be quickly created for an Office application to provide quick access to that application. To start an Office application from the Start menu, follow these steps: 1. From the Windows desktop, click Start, and then point at
 
 Programs. The Programs menu appears. 2. To open a particular Office application, click that applica-
 
 tion’s icon on the menu. The program window for that application appears. You can also start a particular Office application by choosing the type of Office document that you are going to create. This is done using the Start menu. 1. From the Windows desktop, click Start, New Office
 
 Document. The New Office Document dialog box appears. 2. All the Office application templates are available on the dif-
 
 ferent tabs of the New Office Document dialog box. You can create blank documents or special documents from the templates that are provided (specific templates are discussed in
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 more detail in the various parts of this book as they relate to a particular Office application). Select a particular template in the dialog box. 3. Click OK. The application that uses that particular template
 
 opens (such as Word if you select the Blank Document icon), and the new document appears in the application window.
 
 USING
 
 THE
 
 MENU SYSTEM
 
 The menu bar that you find in the Office applications gives you access to all the commands and features a particular application provides. These specific menu systems are found below the title bar and are activated by selecting a particular menu choice. The menu then opens, providing you with a set of command choices. The Office XP applications use a personalized menu system that was first introduced in Microsoft Office 2000 (the previous version of Office). It enables you to quickly access the commands you use most often. When you first choose a particular menu, you find a short list of menu commands. As you use commands, the Office application adds them to the menu list. To access a particular menu, follow these steps: 1. Select the menu by clicking its title. The most recently used
 
 commands appear; hover the mouse pointer for just a moment and all the commands on a particular menu appear. 2. Select the command on the menu that invokes a particular
 
 feature. You will find that several of the commands found on the menu are followed by an ellipsis (…). These commands, when selected, open a dialog box or a task pane. Dialog boxes require you to provide the application with additional information before the particular feature or command can be used (more information on working with dialog boxes appears later in this lesson).
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 Some of the menus also contain a submenu or a cascading menu that you can use to make your choices. The menu commands that produce a submenu are indicated by an arrow to the right of the menu choice. If a submenu is present, you point at the command (marked with the arrow) on the main menu to open the submenu. TIP Activating Menus with the Keyboard You can also activate a particular menu by holding down the Alt key and then pressing the keyboard key that matches the underscored letter, also called a hotkey, in the menu’s name. For example, to activate the File menu in Office applications, press Alt+F.
 
 If you would rather have access to all the menu commands (rather than just those you’ve used recently), you can turn off the personalized menu system. To do this, follow these steps in any Office application: 1. Click the Tools menu, and then click Customize. 2. In the Customize dialog box, click the Options tab. 3. To show all the commands on the menus (without delay),
 
 click the Always Show Full Menus check box. 4. Click OK to close the dialog box.
 
 USING SHORTCUT MENUS A fast way to access commands that are related to a particular item on an Office document, such as selected text or a picture, is to right-click that item. This opens a shortcut menu that contains commands related to the particular item you are working with. For example, if you select a chart on an Excel worksheet, right-clicking the chart (see Figure 2.1) opens a shortcut menu with commands such as Cut, Copy, and Paste.
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 FIGURE 2.1 Shortcut menus provide quick access to application commands.
 
 You will learn about shortcut menus as you work with the Office applications in the various parts of this book.
 
 WORKING
 
 WITH
 
 TOOLBARS
 
 Toolbars provide you with a very quick and straightforward way of accessing commands and features in the Office applications. When you first start one of the Office applications, you typically see the Standard and Formatting toolbars sharing one row, as shown in Figure 2.2. To access a particular command using a toolbar button, click the button. Depending on the command, you see an immediate result in your document (such as the removal of selected text when you click the Cut button), or a dialog box appears, requesting additional information from you.
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 FIGURE 2.2 Toolbars, such as the Standard and Formatting toolbars in this PowerPoint window, provide quick access to an application’s features and commands.
 
 TIP Finding a Toolbar Button’s Purpose You can place the mouse pointer on any toolbar button to view a description of that tool’s function.
 
 Other toolbars, such as the Drawing toolbar and toolbars that are specific to a particular Office application, open when you access a particular application. You can also open them manually by right-clicking any visible toolbar and then selecting the toolbar you want to use from the list that is provided. You can also use this method to close a toolbar you no longer need.
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 CAUTION Missing Toolbar Buttons? If the Standard and Formatting toolbars have been configured to share one row, you might not be able to see every button on the toolbars. To find a hidden button, click the More Buttons button on either toolbar.
 
 UNDERSTANDING DIALOG BOXES When you are working with the various commands and features found in Office applications, you will invariably come across dialog boxes. Dialog boxes are used when an Office application needs more information from you before it can complete a particular command or take advantage of a special feature. Figure 2.3 shows the Word Font dialog box. This dialog box enables you to make selections using check boxes and drop-down lists. Other dialog boxes use option buttons, spinner boxes, and other methods of enabling you to quickly make selections in a particular box.
 
 FIGURE 2.3 Dialog boxes are used to allow you to make your choices related to a particular feature.
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 In most cases, when you complete your selections in a dialog box, you click the OK button to close the box and complete the command, which was originally started with a menu choice or a toolbar button.
 
 UNDERSTANDING
 
 THE
 
 TASK PANE
 
 A major change to the Office XP application environment is the introduction of task panes. A task pane is a multipurpose windowpane that appears on the right side of the window of an Office application. A task pane basically takes the place of dialog boxes that were used to navigate certain application features, such as opening a new file or inserting clip art into an application document. The list that follows describes the global task panes that you will find in all the Office applications: • New File Task Pane—Enables you to start a new file in a particular application (for example, in Word it is called the New Document task pane; in Excel it is called the New Workbook task pane). It also provides access to various document templates and the capability to open recently used files. • Office Clipboard Task Pane—Enables you to view items that you copy and cut to the Office Clipboard. You can manage up to 24 items on the Clipboard and paste them within an application or between applications. • Insert Clip Art Task Pane—Enables you to search the Office Clip Gallery and insert clip art into your Office application documents. • Search Task Pane—Enables you to search for files from any of the Office applications. TIP Outlook and Access Outlook does not use task panes, and Access uses them only in a very limited way. The New File task pane is used in Access to create new database files. Access also uses the Search task pane to search for files on your computer.
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 Task panes also house features that handle specific purposes in each of the Office applications. For example, in PowerPoint, the Slide Layout task pane (shown in Figure 2.4) is used to select a design format for a new or existing PowerPoint presentation slide. You learn about the different task panes in the Office applications as you use them in the different parts of this book.
 
 FIGURE 2.4 The task pane provides specific features in the different Office applications.
 
 When you are working in an Office application, such as Word or Excel, you can open a task pane and switch between the different task pane features offered in that particular application. To open a task pane, follow these steps: 1. In the Office application window, select the View menu and
 
 select Task Pane. The New File task pane appears on the right side of the application window (the New File task pane is the default task pane for the Office applications).
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 2. To switch to a particular task pane that is available in the cur-
 
 rent Office application, click the task pane’s drop-down arrow. 3. Click the task pane on the menu that you want to use.
 
 You will find that a particular task pane may also pop up when you select specific features in an application. For example, in Word, when you select Format and then Styles and Formatting, the Styles and Formatting task pane appears in the Word window. Office applications provide you with a great deal of control over the desktop environment that you work in. You can control options such as how the application window looks for a particular Office application and where the application should store files, by default, when you save them.
 
 SETTING APPLICATION OPTIONS Every one of the Office applications has an Options dialog box that provides access to different settings that you can customize. Next, you take a look at how you open and navigate the Options dialog box in an Office application. Then, you look at several of the applications and some of the key options they offer that you might want to customize. CAUTION Customizing Office Applications You might want to work with the Office applications described in this book before you change a lot of options for the applications. A good way for you to do this is to explore the other parts of this book and then return to this lesson when you are ready to customize some of the options in the Office applications you use most.
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 To open and navigate the Options dialog box in an Office application, follow these steps: 1. In an Office application (such as Word), select Tools,
 
 Options. The Options dialog box for that application appears (see Figure 2.5).
 
 FIGURE 2.5 The Options dialog box in an application enables you to customize various settings.
 
 2. To switch between the different options, click the appropriate
 
 tab on the Options dialog box. Each tab controls a subset of the options available in that application. 3. To change settings on the various tabs, use the check boxes,
 
 drop-down lists, or spinner boxes to make your selections for various features. 4. When you have finished customizing the various options in
 
 the Option dialog box, click OK. You are returned to the application window.
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 You will find that you can set a large number of options in the Options dialog box for each Office application. This doesn’t mean that you have to change them all (if you’re not sure what you’re doing, in many cases you shouldn’t change them). In this lesson you learned about the Office environment including menus, toolbars, dialog boxes and task panes. You also learned how to set options in your Office applications. In the next lesson you learn how to get help in Microsoft Office.
 
 27
 
 04 6602 ch03
 
 11/8/01
 
 2:28 PM
 
 Page 28
 
 LESSON 3
 
 Getting Help in Microsoft Office In this lesson, you learn how to access and use the Help system in Microsoft Office.
 
 HELP: WHAT’S AVAILABLE? Microsoft Office supplies a Help system that makes it easy for you to look up information on application commands and features as you work in a particular Office application. Because every person is different, the Office Help system can be accessed in several ways. You can • Ask a question in the Ask a Question box. • Ask the Office Assistant for help. • Get help on a particular element you see onscreen with the What’s This? tool. • Use the Contents, Answer Wizard, and Index tabs in the Help window to get help. • Access the Office on the Web feature to view Web pages containing help information (if you are connected to the Internet).
 
 USING
 
 THE
 
 ASK
 
 A
 
 QUESTION BOX
 
 The Ask a Question box is a new way to access the Office Help system that Microsoft Office XP provides. It is also the easiest way to quickly get help. An Ask a Question box resides at the top right of every Office application.
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 For example, if you are working in Excel and would like to get some help with Excel functions, type functions into the Ask a Question box. Then press the Enter key. A shortcut menu appears below the Ask a Question box, as shown in Figure 3.1.
 
 FIGURE 3.1 The Ask a Question box provides a list of Help topics that you can quickly access.
 
 To access one of the Help topics supplied on the shortcut menu, click that particular topic. The Help window opens with topical matches for that keyword or phrase displayed. In the case of the “functions” question used in this figure (which was really just a keyword; you can type more complete questions into the box, such as How do I format numbers?), the Help window opens and displays a list of the Excel functions by category (see Figure 3.2).
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 FIGURE 3.2 The Ask a Question box provides a quick way to access the Help window.
 
 In the Help window, you can use the links provided to navigate the Help system. You can also use the Contents, Answer Wizard, and Index tabs to find additional information or look for new information in the Help window. You learn more about these different Help window tabs later in this lesson.
 
 USING
 
 THE
 
 OFFICE ASSISTANT
 
 Another way to get help in an Office Application is to use the Office Assistant. The Office Assistant supplies the same type of access to the Help system as the Ask a Question box. You ask the Office Assistant a question, and it supplies you with a list of possible answers that provide links to various Help topics. The next two sections discuss how to use the Office Assistant.
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 TURNING
 
 THE
 
 OFFICE ASSISTANT ON
 
 AND
 
 OFF
 
 By default, the Office Assistant is off. To show the Office Assistant in your application window, select the Help menu and then select Show the Office Assistant. You can also quickly hide the Office Assistant if you no longer want it in your application window. Right-click the Office Assistant and select Hide. If you want to get rid of the Office Assistant completely so it isn’t activated when you select the Help feature, right-click the Office Assistant and select Options. Clear the Use the Office Assistant check box, and then click OK. You can always get the Office Assistant back by selecting Help, Show Office Assistant.
 
 ASKING
 
 THE
 
 OFFICE ASSISTANT
 
 A
 
 QUESTION
 
 When you click the Office Assistant, a balloon appears above it. Type a question into the text box. For example, you might type How do I print? for help printing your work. Click the Search button. The Office Assistant provides some topics that reference Help topics in the Help system. Click the option that best describes what you’re trying to do. The Help window appears, containing more detailed information. Use the Help window to get the exact information that you need. Although not everyone likes the Office Assistant because having it enabled means that it is always sitting in your application window, it can be useful at times. For example, when you access particular features in an application, the Office Assistant can automatically provide you with context-sensitive help on that particular feature. If you are brand new to Microsoft Office, you might want to use the Office Assistant to help you learn the various features that the Office applications provide.
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 TIP Select Your Own Office Assistant Several different Office Assistants are available in Microsoft Office. To select your favorite, click the Office Assistant and select the Options button. On the Office Assistant dialog box that appears, select the Gallery tab. Click the Next button repeatedly to see the different Office Assistants that are available. When you locate the assistant you want to use, click OK.
 
 USING
 
 THE
 
 HELP WINDOW
 
 You can also forgo either the Type a Question box or the Office Assistant and get your help directly from the Help window. To directly access the Help window, select Help and then the help command for the application you are using, such as Microsoft Word Help. You can also press the F1 key to make the Help window appear. The Help window provides two panes. The pane on the left provides three tabs: Contents, Answer Wizard, and Index. The right pane of the Help window provides either help subject matter or links to different Help topics. It functions a great deal like a Web browser window. You click a link to a particular body of information and that information appears in the right pane. The first thing that you should do is maximize the Help window by clicking its Maximize button. This makes it easier to locate and read the information that the Help system provides. When you first open the Help window, a group of links in the right pane provides you with access to new features for the current application and other links, such as a link to Microsoft’s Office Web site. Next, take a look at how you can take advantage of different ways to find information in the Help window: the Contents tab, the Answer Wizard tab, and the Index tab.
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 TIP View the Help Window Tabs If you don’t see the different tabs in the Help window, click the Show button on the Help window toolbar.
 
 USING
 
 THE
 
 CONTENTS TAB
 
 The Contents tab of the Help system is a series of books you can open. Each book has one or more Help topics in it, which appear as pages or chapters. To select a Help topic from the Contents tab, follow these steps: 1. In the Help window, click the Contents tab on the left side of
 
 the Help window. 2. Find the book that describes, in broad terms, the subject for
 
 which you need help. 3. Double-click the book, and a list of Help topics appears below
 
 the book, as shown in Figure 3.3.
 
 FIGURE 3.3 Use the Contents tab to browse through the various Help topics.
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 4. Click one of the pages (the pages contain a question mark)
 
 under a Help topic to display it in the right pane of the Help window. 5. When you finish reading a topic, select another topic on the
 
 Contents tab or click the Help window’s Close (X) button to exit Help.
 
 USING
 
 THE
 
 ANSWER WIZARD
 
 Another way to get help in the Help window is to use the Answer Wizard. The Answer Wizard works the same as the Ask a Question box or the Office Assistant; you ask the wizard questions and it supplies you with a list of topics that relate to your question. You click one of the choices provided to view help in the Help window. To get help using the Answer Wizard, follow these steps: 1. Click the Answer Wizard tab in the Help window. 2. Type your question into the What Would You Like to Do?
 
 box. For example, you might type the question, How
 
 do I
 
 format text?
 
 3. After typing your question, click the Search button. A list of
 
 topics appears in the Select Topic to Display box. Select a particular topic, and its information appears in the right pane of the Help window, as shown in Figure 3.4. TIP Print Help If you want to print information provided in the Help window, click the Print icon on the Help toolbar.
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 FIGURE 3.4 Search for help in the Help window using the Answer Wizard tab.
 
 USING
 
 THE INDEX
 
 The Index is an alphabetical listing of every Help topic available. It’s like an index in a book. Follow these steps to use the index: 1. In the Help window, click the Index tab. 2. Type the first few letters of the topic for which you are look-
 
 ing. The Or Choose Keywords box jumps quickly to a keyword that contains the characters you have typed. 3. Double-click the appropriate keyword in the keywords box.
 
 Topics for that keyword appear in the Choose a Topic box. 4. Click a topic to view help in the right pane of the Help window.
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 TIP Navigation Help Topics You can move from topic to topic in the right pane of the Help window by clicking the various links that are provided there. Some topics are collapsed. Click the triangle next to the topic to expand the topic and view the help provided.
 
 GETTING HELP
 
 WITH
 
 SCREEN ELEMENTS
 
 If you wonder about the function of a particular button or tool on the screen, wonder no more. Just follow these steps to learn about this part of Help: 1. Select Help and then What’s This? or press Shift+F1. The
 
 mouse pointer changes to an arrow with a question mark. 2. Click the screen element for which you want help. A box
 
 appears explaining the element. In this lesson you learned how to get help in your Office applications. In the next lesson you learn how to create mail in Outlook.
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 Creating Mail In this lesson, you learn how to compose a message, format text, and send e-mail in Microsoft Outlook. You also learn how to use different e-mail formats such as plain text and HTML.
 
 UNDERSTANDING MICROSOFT OUTLOOK Outlook 2002 is the latest version of Microsoft’s popular personal information manager (PIM). Outlook can help you manage incoming and outgoing e-mail messages and help you keep organized by providing a personal calendar, a contacts list, and a personal to-do list. Since Outlook’s ultimate purpose is to keep you organized, its basic “look and feel” makes it easy for you to manage your e-mail, contacts, and appointments. PLAIN ENGLISH Personal Information Manager (PIM) A PIM is a software package that helps you keep track of your appointments, meetings, contacts, and messages, such as e-mail and faxes.
 
 Outlook provides an environment that’s very much like a filing cabinet. Items of information are kept in folders, which you can access with one click of the mouse. For instance, your new e-mail messages can be found in the Inbox. Appointments, meetings, and events are stored in the Calendar folder. The names of your contacts, their e-mail addresses, business addresses, and phone numbers are stored in the Contacts folder. Folders are also provided for your Tasks, Journal Entries, and Notes.
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 COMPOSING
 
 A
 
 MESSAGE
 
 You can send an e-mail message to anyone for whom you have an email address, whether that address is in your list of contacts or scribbled on a Post-it note. In addition to sending a message to one or more recipients, in Outlook you can forward or copy messages to individuals in your Contacts list. You can even e-mail groups of people who are listed in your various distribution lists. To open format the text of a new e-mail message while in the Outlook Inbox, select File, point at New, and then select Mail Message in the Outlook Inbox window. (You can also click the New button on the Standard toolbar.) A new message window appears (see Figure 4.1).
 
 FIGURE 4.1 Compose a new message in the Untitled Message window.
 
 E-mail addresses can be placed in the To box of a message that you want to send (a message you create from scratch or an existing message that you are forwarding) in several ways. You can • Use your Outlook Contacts list (see Lesson 6, “Creating a Contacts List” for more information).
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 • Use your Outlook Address Book. • Type in an e-mail address that you don’t currently have in any of your lists. In the case of e-mail messages that you reply to, the e-mail address of the person who sent you the message is automatically placed in the To box, making it ready to be sent. Having e-mail addresses listed in either your Contacts list or the Outlook Address Book is the easiest way to add an e-mail address to a list. It also helps you keep organized, and that is probably one of the reasons why you’re using Outlook in the first place. You will also find that having e-mail addresses readily available in an Outlook list makes it easier to send carbon copies (duplicate e-mails) or blind carbon copies of messages when you are composing a particular message. To address a new e-mail message, follow these steps: 1. In the message window, click the To button to display the
 
 Select Names dialog box. Names that have been entered in your Contacts list appear on the left side of the dialog box. If you want to switch to a different list, such as the Outlook Address Book, click the drop-down list on the upper-right corner of the dialog box and make a new selection. If the e-mail address you want isn’t in your Contacts list, instead of clicking the To button, type the e-mail address directly into the To text box (if you do this, you can then skip steps 3 through 7). 2. From the list of addresses that appears on the left of the dia-
 
 log box, choose the name of the intended recipient and select the To button (or you can double-click the name). Outlook copies the name to the Message Recipients list. You can also add any distribution lists to the To box that appear in your address list. To send a carbon copy or blind carbon copy to a recipient, use the Cc or Bcc buttons.
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 Figure 4.2 shows a message that is addressed to an individual whose address was contained in the Contacts list and also to a group of people who are listed in a distribution list (you can enter as many addresses as you want).
 
 FIGURE 4.2 Add e-mail addresses or distribution list names quickly with the Select Names dialog box.
 
 3. Click OK to return to the message window. Click in the
 
 Subject box and type the subject of your message. 4. Click in the text area, and then enter the text of the message.
 
 You do not have to press the Enter key at the end of a line; Outlook automatically wraps the text at the end of a line for you. You can use the Delete and Backspace keys to edit the text you enter. 5. When you finish typing the message, you can send the mes-
 
 sage, or you can format the message or check the spelling as detailed later in this lesson. To send the message, click the Send button on the message’s Standard toolbar.
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 CAUTION No Address If you try to send a message without entering an address, Outlook displays a message that at least one e-mail address must be in the To box. Type in an address or select an address from your Contacts list or Address Book.
 
 FORMATTING TEXT You can enhance the format of the text in your message to make it more attractive, to make it easier to read, or to add emphasis. Any formatting you do transfers to the recipient with the message if the recipient has Outlook or another e-mail client that can work with HTML or Rich Text Format messages. However, if the recipient doesn’t have an e-mail client that can handle these special message formats, formatting might not transfer and the message will be received in plain text. PLAIN ENGLISH HTML Hypertext Markup Language is used to design Web pages for the World Wide Web. Outlook can send messages in this format, providing you with several text formatting options. Graphics can even be pasted into an HTML message.
 
 PLAIN ENGLISH Rich Text Format A special e-mail format developed by Microsoft for use with Microsoft mail systems. Outlook can send and receive messages in Rich Text Format. This enables you to send and receive messages with special formatting, such as bold, italic, various fonts, and other special characters and graphics.
 
 You format text in two ways. You can format the text after you type it by selecting it and then choosing a font, size, or other attribute; or you
 
 41
 
 05 6602 ch04
 
 42
 
 11/8/01
 
 2:33 PM
 
 Page 42
 
 LESSON 4
 
 can select the font, size, or other attribute to toggle it on, and then enter the text, which will be formatted as you type. To format the text in your message, first make sure the Formatting toolbar is showing. On the menu system provided by the message window, select View, and then select Toolbars and click Formatting. Figure 4.3 shows a message with the Formatting toolbar displayed. Formatting options have also been applied to the text in the message. Table 4.1 explains the buttons found on the Formatting toolbar. CAUTION The Formatting Toolbar Buttons Don’t Work Only messages sent in HTML or Rich Text Format can be formatted. Plain-text messages don’t supply you with any formatting options. So, even if the Formatting toolbar appears at the top of a plain-text message, the formatting options will not be available. Selecting the message type (such as HTML or plain text) is discussed in the section “Selecting the E-mail Message Format,” found later in this lesson.
 
 Formatting toolbar
 
 FIGURE 4.3 Use the Formatting toolbar to modify format of your message text.
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 Table 4.1
 
 Formatting Toolbar Buttons
 
 Button
 
 Name Font Color Bold Italic Underline Align Left Center Align Right Bullets Numbering Decrease Indent Increase Indent Insert Horizontal Line
 
 CAUTION My Toolbars Look Completely Different! If you are using Microsoft Word as your e-mail editor, the toolbars that are present in the new message window reflect those you have selected in your Word installation. The Word and Outlook toolbars have many of the same buttons.
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 1. To apply a new font to format the selected text, on the
 
 Formatting toolbar, click the down arrow in the Font box. Scroll through the font list, if necessary, to view all fonts on the system, and then click the font you want to apply to the text. You can also apply a style to selected text in the message. On the Formatting toolbar, click the Style drop-down arrow. The styles available range from a set of predefined heading styles to special styles such as Numbered list and Bulleted list. 2. Assign a size by clicking the down arrow beside the Font
 
 Size drop-down list and choosing the size; alternatively, you can type a size into the Font Size text box. 3. To choose a color, click the Color button and select a color
 
 from the palette box that appears. 4. Choose a type style to apply to text by clicking the Bold,
 
 Italic, and/or Underline buttons on the Formatting toolbar. 5. Choose an alignment by selecting the Align Left, Center, or
 
 Align Right button from the Formatting toolbar. 6. Add bullets to a list by clicking the Bullets button on the
 
 Formatting toolbar. If you prefer a numbered list, click the Numbering button. 7. Create text indents or remove indents in half-inch increments by clicking the Increase Indent or Decrease Indent buttons. (Each time you click the Indent button, the indent changes by one-half inch.) 8. If you want to divide the text in the message using a horizon-
 
 tal line, place the insertion point at the appropriate place in the text and then click the Add Horizontal Line button. TIP Yuck, No Thanks! If you assign formatting to your text and don’t particularly like it, click Edit and select Undo to remove the last formatting that you assigned.
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 SELECTING
 
 THE
 
 E-MAIL MESSAGE FORMAT
 
 The default message format in Outlook is HTML. If you send most of your messages to individuals who don’t have mail clients that can read the HTML format, you might want to change the default to plain text. On corporate networks, you might find an advantage to using the Rich Text Format as the default text format for your messages. This file format was developed for the Exchange Server mail environment used on most business networks. The default format is set in the Outlook Options dialog box on the Mail Format tab. Fortunately, Outlook makes it very easy for you to switch the format of a mail message while you are composing the message. First, take a look at how to set the default mail type, and then look at how to change the message format while composing the message. To set the default message format: 1. Click Tools, Options. The Options dialog box appears. 2. Click the Mail Format tab (see Figure 4.4).
 
 TIP Include Hyperlinks If you use the HTML or Rich Text Format message formats, you can include hyperlinks in your e-mails. Hyperlinks are Web addresses and e-mail addresses that can be accessed by clicking them in the message. Just type the Web address or e-mail address, and the hyperlink is created automatically in the message.
 
 3. To select the message format, click the Compose in This
 
 Message Format drop-down box. Select HTML, Rich Text, or Plain Text. If you want to use Microsoft Word as your e-mail editor, click the Use Microsoft Word to Edit E-mail Messages check box.
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 FIGURE 4.4 You can send your messages in HTML, Rich Text Format, or plain-text format.
 
 TIP Using HTML Stationery If you use the HTML format for your messages, you can also select to use a particular stationery on the Mail Format tab. Stationery types can be previewed using the Stationery Picker button. Be advised that HTML stationery will slow down the loading of e-mail messages on the recipient’s computer, and not everyone will have a mail client that can view the stationery. You probably should use the stationery only for personal messages to friends and family members who also use Outlook as their e-mail client.
 
 ADD
 
 A
 
 SIGNATURE
 
 You can further personalize your e-mails by adding a signature to the message. A signature can be as simple as just your name, or the signature can include your phone number or extension or other information. Some people even add a favorite quote to their signature. If you use HTML as your message format, you can even include signature files
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 that contain graphics. Plain-text signatures (for use with plain-text messages) will consist only of text characters. First, take a look at how you can create a signature. Then you can take a look at how you apply it to a message.
 
 CREATING
 
 A
 
 SIGNATURE
 
 1. Choose Tools, Options to open the Options dialog box, and
 
 then select the Mail Format tab. 2. Click the Signatures button at the bottom of the dialog box.
 
 The Create Signature dialog box opens. 3. Click the New button; the Create a New Signature dialog box
 
 opens as shown in Figure 4.5.
 
 FIGURE 4.5 Outlook walks you through the steps of creating a signature.
 
 4. Type a name for your new signature, and then click Next. 5. The Edit Signature dialog box appears. Enter the text you
 
 want included in the signature. You can use the Paragraph or Font buttons to add formatting to the text in the signature. 6. When you have finished creating your signature, click the
 
 Finish button. Click Close to close the Create Signatures dialog box, and then click OK to close the Options dialog box.
 
 47
 
 05 6602 ch04
 
 48
 
 11/8/01
 
 2:34 PM
 
 Page 48
 
 LESSON 4
 
 TIP You Can Edit Signatures To edit a signature, select the signature in the Create Signatures dialog box and then click Edit.
 
 INSERTING
 
 THE
 
 SIGNATURE
 
 After you’ve created a signature or signatures, you can quickly add it to any message by placing the insertion point where you want to place the signature, choosing Insert, and then choosing Signature; all the signatures that you have created appear on the menu. Select the signature from the list you want to use in the message you are currently composing. You can also preview the signatures before inserting them; choose Insert, Signature, and then select More from the cascading menu. The Select a Signature dialog box opens. Select any of your signatures to view a preview of the signature. When you find the signature you want to use, click OK.
 
 SENDING MAIL You probably know that after you add recipient addresses, compose your message, format the text, spell-check the message, and insert a signature in the e-mail, you are ready to send the message. But you can use a couple of ways to actually send the message on its way. The fastest way to send the message using the mouse is to click the Send button on the Message toolbar. If you prefer, press Ctrl+Enter. In either case, your message is heading out to its destination. If you are working offline, the message is placed in the Outbox until you connect to the Internet and send and receive your messages. In this lesson, you learned to compose a message, format text, and send mail. You also learned how to select different e-mail formats such as HTML and plain text and add a signature to an e-mail message. In the next lesson, you learn to work with received e-mail.
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 Working with Received Mail In this lesson, you learn how to read your mail, save an attachment, answer mail, and close a message.
 
 READING MAIL When you log on to Outlook, your Inbox folder appears, and any new messages you’ve received are downloaded from your ISP’s (or your company’s) mail server. If you use Internet mail and a dial-up connection (in contrast to DSL or cable modem connections, which are always connected), a dial-up connection must be made before Outlook can check the mail server for new mail. No matter what the connection situation, after you download any new e-mail to your computer, the new mail appears in the Outlook Inbox (see Figure 5.1). If you watch closely when you connect to your network or Internet service provider, a downloading mail icon appears in the lower right of the Outlook window, showing you that new mail is being received. As you can see in Figure 5.1, the Inbox provides important information about each message. For example, one message has been labeled as high priority and one message has an attachment. Messages that have already been replied to are marked with a curved reply arrow. Additional information about a particular message, such as the actual reply date, is contained at the top of the Preview pane when that particular message is selected. At the bottom of the Outlook status bar (on the left), information such as how many items are in the Inbox and how many message are unread is also provided.
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 High priority
 
 Message with attachment
 
 Read and replied to message
 
 Unread message
 
 FIGURE 5.1 The Inbox provides information related to your received messages: the sender, the subject, the date received, and priority and attachment icons.
 
 To read a message, you can select it, and its contents appear in the Outlook Preview pane. You can also open a message in its own window; double-click a mail message to open it. Figure 5.2 shows an open message. To read the next or previous mail message in the Inbox when you have opened a mail message, click either the Previous Item or the Next Item button on the message window toolbar. To access more view choices, select the View menu, and then point at Previous or Next; submenu choices are provided for each of these choices that allow you to jump to another item, an unread item, or to a message that has been assigned a particular priority or that has been flagged.
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 Previous Item button
 
 Next Item button
 
 FIGURE 5.2 The message window displays the message and tools for responding to the message or moving to the previous or next message in the Inbox.
 
 PLAIN ENGLISH Item Outlook uses the word item to describe a mail message, an attached file, an appointment or meeting, a task, and so on. Item is a generic term in Outlook that describes the currently selected element.
 
 After you open a message in the Inbox, it is marked as read (notice that the envelope that represents the message is opened). You can also mark messages as read or unread by selecting Edit and then selecting either Mark As Read or Mark As Unread. Additionally, you can mark all the messages in the Inbox as read by choosing Edit, Mark All As Read. You might want to mark mail messages as read so you don’t read them again; you might want to mark important mail as unread so you’ll be sure to open it and read it again.
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 TIP No Mail? Maybe Outlook is not configured to check for mail automatically. To force Outlook to look for mail, click the Send and Receive button on the toolbar, or choose Tools, point at Send/Receive, and then select Send/Receive All. Any new messages are placed in the Inbox.
 
 SAVING
 
 AN
 
 ATTACHMENT
 
 You often receive messages that have files or other items attached to them, such as graphical images. In the Inbox list of messages, an attachment is represented by a paper clip icon beside the message. Save any attachments sent to you so that you can open, modify, print, or otherwise use the attached document or image. Messages can contain multiple attachments. To save an attachment, follow these steps: 1. Open the message containing an attachment by double-click-
 
 ing the message. The attachment appears as an icon below the subject area of the message (see Figure 5.3).
 
 FIGURE 5.3 An icon represents the attached file.
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 2. (Optional) You can open the attachment from within the mes-
 
 sage by double-clicking the attachment icon. A message appears, as shown in Figure 5.4, warning you that attachments can contain viruses. To open the file, click the Open It option button and then click OK. The attachment will be opened in the application in which it was created (such as Word or Excel). When you have finished looking at the attachment, you can return to the e-mail message by closing the open application. If you choose Save the File to Disk, a Save Attachment dialog box appears, allowing you to save the file to your hard drive.
 
 FIGURE 5.4 You can open or save an attachment by double-clicking its icon.
 
 3. You probably noticed in the Opening Mail Attachment mes-
 
 sage box that you also had the option to save the attachment (see Figure 5.4). There is another way to save your attachments, and it actually makes it easier when you have to save multiple attachments attached to the same e-mail message. In the message window, select File, Save Attachments. The Save Attachment dialog box appears (see Figure 5.5).
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 FIGURE 5.5 Save the attachment to a convenient folder.
 
 4. Choose the folder in which you want to save the attachment
 
 or attachments and click Save. The dialog box closes and returns to the message window. You can change the name of the file in the File Name box, if you want. After you save the attachment, you can open the attachment, which is now like any other saved file on your computer, at any time from the application in which it was created. TIP Use the Right Mouse Button You can also quickly save an attachment by right-clicking the attachment icon. On the shortcut menu that appears, click Save As, and then save the attachment to an appropriate folder.
 
 ANSWERING MAIL You might want to reply to a message after you read it. The message window enables you to answer a message immediately, or at a later time if you prefer. To reply to any given message, follow these steps: 1. Select the message in the Inbox window, and then click the
 
 Reply button on the Inbox toolbar.
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 If you have the message open, click the Reply button in the message window. The Reply message window appears, with the original message in the message text area and the sender of the message already filled in for you (see Figure 5.6).
 
 FIGURE 5.6 You can reply to a message quickly and easily.
 
 TIP Reply to All If you receive a message that has also been sent to others—as either a message or a carbon copy (Cc)—you can click the Reply to All button to send your reply to each person who received the message.
 
 2. The insertion point is automatically placed above the message
 
 text that you are replying to. Enter your reply text. 3. When you finish your reply, click the Send button. Outlook
 
 sends the message. The next time you open a message to which you’ve replied, there is a reminder at the top of the message window telling you the date and time you sent your reply. Don’t forget that the purple arrow next to a message in the Inbox window shows that the message has been replied to.
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 PRINTING MAIL You can print mail messages, either directly from the Inbox when they have been selected or from a message window when you have opened a particular message. To print an unopened message, select the message in the message list of the Inbox or other folder and choose File, Print. The Print dialog box opens; click OK to send the message to the printer. If the message is already open, you can follow these steps: 1. Open the message in Outlook. 2. Choose File and then select Print, or press Ctrl+P to view
 
 the Print dialog box. 3. In the Print dialog box, click OK to print one copy of the
 
 entire message using the printer’s default settings. TIP Toolbar Shortcut Click the Print button on the toolbar to print an unopened or opened message using the default print settings.
 
 When you finish reading or printing a message, click the Close button on the message window.
 
 DELETING MAIL Although you might want to store certain important messages and perhaps even create folders to store them in, which is discussed later in this lesson, you’ll definitely want to delete much of the mail that you receive after reading it. You can easily delete messages in Outlook when you’re finished reading and sending replies to them. The easiest way to delete a selected message is to click the Delete button on the Outlook toolbar. If the message is open, just click the Delete button on the message window toolbar instead.
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 If you want to delete several messages in the Inbox, just select the messages using the mouse. To select several contiguous messages, click the first message, and then hold down the Shift key when you click the last message in the series. To select noncontiguous messages, hold down the Ctrl key and click each message. When you have all the messages selected that you want to delete, click the Delete button (or you can select the Edit menu and then select Delete).
 
 UNDELETING ITEMS If you change your mind and want to get back items you’ve deleted, you can usually retrieve them from the Deleted Items folder. By default, when you delete an item, it doesn’t disappear from your computer; it merely moves to the Deleted Items folder. Items stay in the Deleted Items folder until you delete them from that folder—at which point they are unrecoverable. Typically, when you exit Outlook, the Deleted Items folder is emptied automatically. To retrieve a deleted item from the Deleted Items folder, follow these steps: 1. Click the scroll-down arrow on the Outlook bar to locate the
 
 Deleted Items folder. 2. Click the Deleted Items icon in the Outlook bar to open the
 
 folder. 3. Select the items you want to retrieve; you can then drag them
 
 back to the Inbox by dragging them and dropping them onto the Inbox icon in the Outlook bar. Or if you don’t like dragging messages, select the files you want to move from the Deleted Items folder, and then select Edit, Move to Folder. The Move Items dialog box appears. 4. Select the folder you want to move the items into (such as the
 
 Inbox) and then click the OK button. TIP Use Undo Immediately If you want to undelete a message or messages that you just deleted, select the Edit menu, and then select Undo Delete.
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 EMPTYING
 
 THE
 
 DELETED ITEMS FOLDER
 
 If you’re sure you want to delete the items in the Deleted Items folder, empty the contents of the folder. To delete items in the Deleted Items folder, follow these steps: 1. On the Outlook bar, choose Outlook Shortcuts, and then
 
 select the Deleted Items folder. All deleted items in that folder appear in the message list. 2. To permanently delete an item or items, select it (or them) in
 
 the Deleted Items folder. 3. Click the Delete button, or choose Edit and then select
 
 Delete. Outlook displays a confirmation dialog box asking whether you’re sure you want to permanently delete the message. Choose Yes to delete the selected item. 4. To switch back to the Inbox or another folder, select the
 
 folder from either the Outlook bar or the Folder List. TIP Automatic Permanent Delete You can set Outlook to permanently delete the contents of the Deleted Items folder every time you exit the program. To do so, in the Outlook window choose Tools, and then click Options. Select the Other tab of the Options dialog box and click the Empty the Deleted Items Folder Upon Exiting check box. Then click OK.
 
 FORWARDING MAIL You can forward mail that you receive to a co-worker or anyone else with an e-mail address. When you forward a message, you can also add comments to the messages if you so desire.
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 PLAIN ENGLISH Forward Mail When you forward mail, you send a copy of a message you have received to another person; you can add your own comments to the forwarded mail, if you want.
 
 You can forward an open message or a message selected in the message list in the Inbox in the same way. To forward mail, follow these steps: 1. Select or open the message you want to forward. Then click
 
 the Forward button. The FW Message window appears (see Figure 5.7).
 
 FIGURE 5.7 When you forward a message, the original message appears at the bottom of the message window.
 
 2. In the To text box, enter the addresses of the people to whom
 
 you want to forward the mail. If you want to choose an address or addresses from a list, click the To button to display the Select Names dialog box, and then select the address or addresses from your Contacts list.
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 3. (Optional) In the Cc text box, enter the addresses of anyone
 
 to whom you want to forward copies of the message. 4. In the message area of the window, enter any message you
 
 want to send with the forwarded text. TIP Attachments Are Forwarded, Too If the message that you forward contains attached files, the attachments are also forwarded.
 
 5. When you are ready to send the message, click the Send
 
 button.
 
 CREATING FOLDERS Although Outlook provides you with an Inbox, an Outbox, a Sent Items folder, and a Deleted Items folder, you might find it advantageous to create your own folders. This provides you with alternative places to store items and can make finding them in the future easier (rather than just having all your messages languish in the Inbox). Folders can also be used to store items other than messages, so you could even create subfolders for your Contacts folder or Calendar. To create a folder, follow these steps: 1. Click the Folder List drop-down button, and then click the
 
 Folder List pin to “pin it down” to the Outlook window. 2. To create a folder in the Folder List, right-click the folder,
 
 such as the Inbox, that will serve as the parent folder for the new folder. 3. On the shortcut menu that appears (see Figure 5.8), select
 
 New Folder. The Create New Folder dialog box appears.
 
 06 6602 ch05
 
 11/8/01
 
 2:32 PM
 
 Page 61
 
 Working with Received Mail
 
 FIGURE 5.8 Folders can be created anywhere in the Folder List.
 
 4. In the Create New Folder dialog box, type a name for the
 
 folder into the Name box. 5. Use the icons in the New Folder dialog box main pane area
 
 to select the type of folder that you want to create. For example, if you want to hold mail messages in the folder, select the Mail and Post icon. 6. Select the Location drop-down list to select the location for
 
 the new folder. If you want to nest the new folder in an existing folder, such as the Inbox, select that folder on the list. If you want to create the new folder as a first-level folder, select Personal Folders. 7. When you have finished making your entries and selections
 
 in the New Folder dialog box, click OK to create the folder.
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 8. You are asked whether you want to add a shortcut icon for
 
 the new folder to the Outlook bar. If you want to create the icon, click Yes. The new folder appears on the Outlook bar and in the Folder List. TIP Add an Outlook Bar Shortcut for a Folder Even if you choose not to add a shortcut for the folder to the Outlook bar when you create the folder, you can add it later. Right-click any folder you’ve created in the Folder List and select Add to Outlook Bar from the shortcut menu that appears.
 
 CAUTION I Want to Delete a Folder If you add a folder and then decide you don’t want it, right-click the folder in the Folder List and select Delete from the shortcut menu. You then must verify the deletion; click Yes.
 
 In this lesson, you learned to read your mail, save an attachment, answer mail, and print a message. You also learned how to delete and forward a message and create your own folders. In the next lesson, you learn how to create a contacts list.
 
 07 6602 ch06
 
 11/8/01
 
 2:26 PM
 
 Page 63
 
 LESSON 6
 
 Creating a Contacts List In this lesson, you learn how to create and view a Contacts list and how to send mail to someone on your Contacts list. You also learn how to create a distribution list.
 
 CREATING
 
 A
 
 NEW CONTACT
 
 You use the Contacts folder to create, store, and access your Contacts list. You can enter any or all of the following information about each contact: • Name • Job title • Company name • Address (street, city, state, ZIP code, and country) • Phone (business, home, business fax, mobile) • E-mail address • Web page address • Comments, notes, or descriptions • Categories PLAIN ENGLISH Contact In Outlook, a contact is any person or company for which you’ve entered a name, address, phone number, or other information. You can communicate with a contact in Outlook by sending an e-mail message, scheduling a meeting, sending a letter, and so on.
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 You also can edit the information at any time, add new contacts, or delete contacts from the list. To open the Contacts folder and create a new contact, follow these steps: 1. To open the Contacts folder, click the Contacts shortcut on
 
 the Outlook bar. The Contacts folder opens. 2. To create a new contact, select Actions and then choose New
 
 Contact, or click the New Contact button on the Standard toolbar. The Contact dialog box appears, with the General tab displayed (see Figure 6.1).
 
 FIGURE 6.1 You can enter as much or as little information about each contact as you need.
 
 3. Enter the contact’s name into the Full Name text box. If you
 
 want to add more detailed information for the name, click the Full Name button to display the Check Full Name dialog box, and then enter the contact’s title and full name (including first, middle, and last names) and any suffix you want to
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 include. Click OK to close the Check Full Name dialog box and return to the Contact dialog box. 4. Press the Tab key to navigate from one field in this dialog
 
 box to the next. After the name field, the insert point moves down to the contact’s job title and then the company name. This information is optional. 5. In the File As drop-down box, enter or select the method by
 
 which you want to file your contact’s names. You can choose Last Name First or First Name First, or you can enter your own filing system, such as by company or state. TIP Keep It Simple The default filing method for contacts is last name first, which makes it easy to quickly find the contact when you need it.
 
 6. Enter the address into the Address box and choose whether
 
 the address is Business, Home, or Other. Alternatively, you can click the Address button to enter the street, city, state, ZIP code, and country in specified areas instead of all within the text block. You can add a second address (the Home address, for example) if you want. Address information is optional. 7. In the Phone drop-down lists, choose the type of phone num-
 
 ber—Business, Callback, Car, Home Fax, ISDN, Pager, and so on—and then enter the number. You can enter up to 19 numbers into each of the four drop-down boxes in the Phone area of the dialog box. 8. You can enter up to three e-mail addresses into the E-Mail text
 
 box. The box below the e-mail address allows you to enter how the e-mail address appears when you send a message to a person (for example, [email protected] could appear as Bob Smith); in the Web Page Address text box, enter the address for the company or contact’s URL on the World Wide Web.
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 If you have more than one e-mail address for a contact, the first number or address in the list serves as the default. For example, when e-mailing a contact, the first e-mail address in the list is placed in the To box on the new message. If you want to use a different e-mail address for the contact, doubleclick the contact’s name in the Message To box and select one of the other e-mail addresses in the contact’s Properties box. When you want to call a contact for whom you have multiple numbers, a drop-down list appears in the New Call dialog box that enables you to choose the appropriate number. PLAIN ENGLISH URL (Uniform Resource Locator) The address for a Web page on the World Wide Web. A typical URL is written http://www.companyname.com, such as http://www.mcp.com.
 
 9. In the comment text box, enter any descriptions, comments,
 
 or other pertinent information. Then, select or enter a category to classify the contact. 10. After you have finished entering the new contact information,
 
 click the Save and Close button to return to the Contacts folder. You can also save the new contact by opening the File menu and choosing one of the following commands: • Save—Saves the record and closes the Contact dialog box. • Save and New—Saves the record and clears the Contact dialog box so that you can enter a new contact. You can edit the information for a contact at any time by doubleclicking the contact’s name in the Contacts list; this displays the contact’s information window. Alternatively, you can work on the
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 fields in a record directly in the Contacts list window. Click within the information listed below a contact’s name (such as the phone number or address) to position the insertion point in the text and then delete or enter text. Press Enter to complete the modifications you’ve made and move to the next contact in the list. TIP Other Tabs in the Contacts Window Most of the information that you need to enter for a contact is contained on the General tab. You can also add additional information, such as the person’s nickname or spouse’s name, on the Details tab. The Certificates tab allows you to specify a certificate to use to send encrypted e-mail to this particular contact.
 
 VIEWING
 
 THE
 
 CONTACTS LIST
 
 By default, you see the contacts in Address Cards view (Address Cards appear in the Current View list on the Outlook Advanced toolbar). The information you see displays the contact’s name and other data, such as addresses and phone numbers. The contact’s company name, job title, and comments, however, are not displayed by default. Figure 6.2 shows the Contacts list in the default Address Cards view. You can use the horizontal scrollbar to view more contacts, or you can click a letter in the index (on the right side of the screen) to display contacts beginning with that letter in the first column of the list.
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 FIGURE 6.2 View your contacts in Address Cards view.
 
 You can change how you view the contacts in the list by choosing one of these options from the Current View drop-down list on the Standard toolbar: • Address Cards—Displays full name, addresses, and phone numbers of the contacts, depending on the amount of information you’ve entered, in a card format. • Detailed Address Cards—Displays full name, job title, company, addresses, phone numbers, e-mail addresses, categories, and comments in a card format. • Phone List—Displays full name, job title, company, File As name, department, phone numbers, and categories in a table, organizing each entry horizontally in rows and columns.
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 • By Category—Displays contacts in rows by categories. The information displayed is the same as what’s displayed in a phone list. • By Company—Displays contacts in rows, grouped by their company. The information displayed is the same as what’s displayed in a phone list. • By Location—Displays contacts grouped by country. The information displayed is the same as what’s displayed in a phone list. • By Follow-Up Flag—Displays contacts grouped by followup flags. The view also displays the due date for the followup that you specified when you marked the contact with a flag (flags can be assigned to Contacts the same as they are assigned to e-mail messages).
 
 VIEWING
 
 A
 
 CONTACTS ACTIVITIES TAB
 
 Although the Contacts folder provides different views for perusing the actual contacts in the Contacts list, these views really don’t give you any indication of the messages that you have sent to a particular contact or the tasks that you might have assigned to a particular contact (assigning a task to a contact is covered later in this lesson). You can view all the activities related to a particular contact on the contact’s Activities tab. With the Contacts folder open, follow these steps: 1. Double-click a contact in the Contacts folder to open the
 
 contact. 2. Click the Activities tab on the contact’s window. All the
 
 activities, such as sent and received e-mails and any assigned tasks, appear in the Activities pane (see Figure 6.3).
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 FIGURE 6.3 You can view all the activities related to a particular contact.
 
 3. To see a subset of the Activities list, click the Show drop-
 
 down box. You can choose to view only E-Mail, Notes, or Upcoming Tasks/Appointments related to that particular contact (any items that you delete in the Activities list are removed from the list and the folder that contained them). 4. You open any of the items on the Activities list by double-
 
 clicking that item. Close an opened item by clicking its Close (X) button. 5. When you have finished viewing the activities related to a
 
 particular contact, you can close the contact’s window.
 
 COMMUNICATING
 
 WITH A
 
 CONTACT
 
 You can send messages to any of your contacts, arrange meetings, assign tasks, or even send a letter to a contact from within Outlook (this also includes any distribution lists that you have created in the Contacts folder). To communicate with a contact, make sure you’re in the Contacts folder. You do not need to open the specific contact’s information window to perform any of the following procedures.
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 SENDING MESSAGES To send a message to a contact, you must make sure you’ve entered an e-mail address in the General tab of the Contact dialog box for that particular contact. If Outlook cannot locate the e-mail address, it displays a message dialog box letting you know. To send a message from the Contacts folder, select the contact, select Actions, and then select New Message to Contact (or you can rightclick the contact or the distribution list and select New Message to Contact from the shortcut menu that appears). In the Untitled - Message dialog box, enter the subject and message and set any options you want. When you’re ready to send the message, click the Send button.
 
 SCHEDULING
 
 A
 
 MEETING
 
 WITH A
 
 CONTACT
 
 To schedule a meeting with a contact (or with contacts contained in a distribution list), you must first select the contact or distribution list (as with sending mail messages, the contacts involved must have an email address). After you’ve selected the contact or list, select Actions, and then select New Meeting Request to Contact to open the Untitled - Meeting dialog box. Enter the subject, location, time, date, and other information you need to schedule the meeting, and then notify the contact by sending an invitation (invitations are sent automatically during the process of creating the meeting).
 
 ASSIGNING
 
 A
 
 TASK
 
 TO A
 
 CONTACT
 
 As with mail messages and meetings, a contact must have an e-mail address to assign that individual a task. To assign a task to a contact, select the contact (tasks cannot be assigned to distribution lists), select Actions, and then select New Task for Contact. The Task dialog box
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 appears. Enter the subject, due date, status, and other information, and then to send the task to the contact, just click the Send Task button on the task’s toolbar.
 
 CALLING
 
 A
 
 CONTACT
 
 Another obvious way to communicate with a contact is over the telephone. For Outlook to dial the phone number for you, you must have a modem hooked to your computer that can dial out for you. With the right equipment, Outlook makes it easy for you to make a phone call to a contact by dialing the phone number for you. For Outlook to manage your calls, you must have a modem hooked to your computer that can dial out for you. If you’re in a networked environment that has access to a network modem pool, you can also dial out using your computer. The line you dial out on, however, must also be accessible by your telephone. To initiate a phone call to a contact, select the contact in the Contact list and follow these steps: 1. Select Actions, point at Call Contact, and then select the
 
 appropriate phone number from the cascading menu that appears (all the phone numbers for the selected contact appear, including business, home, and fax). You can also click the Dial button on the Standard toolbar and select the appropriate phone number from the drop-down list. In both cases, the New Call dialog box appears (see Figure 6.4).
 
 FIGURE 6.4 You can quickly initiate a telephone call to a contact using the Actions menu or the Dial button.
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 2. Click the Start Call button to allow Outlook to dial the con-
 
 tact’s phone number using your modem. 3. The Call Status dialog box appears. Pick up your phone and
 
 click the Talk button in the Call Status dialog box. This engages the phone, and you can speak to your contact when they answer your call.
 
 VIEWING
 
 A
 
 MAP
 
 OF A
 
 CONTACT’S ADDRESS
 
 A useful feature Outlook offers is the capability to view an area map based on the address of a particular contact (requires an active Internet connection). This can be incredibly useful when you aren’t sure where a particular contact is located. To view a map of a contact’s address, double-click the contact in the Contact list. The contact’s record opens in the Contact dialog box. Click the Display Map of Address button on the Contacts toolbar. Microsoft Internet Explorer opens to the Microsoft Expedia Web site and displays a map based on the contact’s address, as shown in Figure 6.5. You can zoom in and out on the map, and you can print a hard copy. When you are finished viewing the map and want to return to Outlook, simply close the Internet Explorer window.
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 FIGURE 6.5 You can view a map of a contact’s address.
 
 In this lesson, you learned to create a Contacts list, view the list, and send mail to someone on your Contacts list. You also learned how to view a map of a contact’s address. In the next lesson, you learn to navigate the Calendar, create an appointment, and plan events using the Outlook calendar.
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 Using the Calendar In this lesson, you learn how to navigate the Calendar, create appointments, and save appointments.
 
 NAVIGATING
 
 THE
 
 CALENDAR
 
 You can use Outlook’s Calendar to schedule appointments and create a task list. If necessary, Outlook can also remind you of appointments and daily or weekly tasks. You can schedule appointments months in advance, move appointments, cancel appointments, and so on. The Calendar makes it very easy to identify the days on which you have appointments. To open the Outlook Calendar, click the Calendar icon in the Outlook bar, or select the Calendar folder from the Folder List. Figure 7.1 shows the Calendar in Outlook. Outlook provides multiple ways for you to move around in the Calendar and view specific dates: • Scroll through the Schedule pane to view the time of an appointment. • In the Monthly Calendar pane, click the left and right arrows next to the names of the months to go backward and forward one month at a time. Click a date to display that day’s information in the Schedule pane.
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 Monthly Calendar pane Today's date
 
 Schedule pane
 
 Task Pad
 
 FIGURE 7.1 You can view all appointments and tasks at a glance.
 
 TIP Changing Calendar Views You can change to different views of the Calendar by clicking the Current View dropdown arrow on the Advanced toolbar. Views including Active Appointments, Recurring Appointments, and By Category are available.
 
 • In the monthly calendar pane, click a particular date on one of the months shown to display that date in the schedule pane.
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 • To view a different month in the Monthly Calendar pane, click the current month in the Monthly Calendar pane and select the name of the month from the shortcut list. Or you can use the Back or Forward arrows to the left and right of the shown months (respectively) to go back or forward on the calendar. • To view a week or multiple days in the Schedule pane, select them in the Monthly Calendar pane. • To add a task to the Task Pad, click where you see Click Here to Add a New Task on the Task Pad. • Use the scrollbars for the Task Pad to view additional tasks, if necessary. TIP Change the Date Quickly To quickly go to today’s date or to a specific date without searching through the Monthly Calendar pane, right-click in the Schedule pane and choose either Today or Go to Date.
 
 CREATING
 
 AN
 
 APPOINTMENT
 
 You can create an appointment on any day in the Outlook Calendar. When you create an appointment, you can add the subject, location, starting time, category, and even an alarm to remind you ahead of time. Follow these steps to create an appointment: 1. In the Monthly Calendar pane, select the month and the date
 
 for which you want to create an appointment. 2. In the Schedule pane, double-click next to the time at which
 
 the appointment is scheduled to begin. The Untitled Appointment dialog box appears, with the Appointment tab displayed (see Figure 7.2).
 
 77
 
 08 6602 ch07
 
 78
 
 11/8/01
 
 2:25 PM
 
 Page 78
 
 LESSON 7
 
 FIGURE 7.2 Enter all the details you need when scheduling an appointment.
 
 3. Enter the subject of the appointment in the Subject text box
 
 (you can use a person’s name, a topic, or other information). 4. In the Location text box, enter the meeting place or other
 
 text that will help you identify the meeting when you see it in your calendar. 5. Enter dates and times in the Start Time and End Time boxes
 
 (or click the drop-down arrows and select the dates and times). TIP Autodate It! You can use Outlook’s Autodate feature: Enter a text phrase such as next Friday into the Start time or End time box, and then press Enter; Outlook figures out the date for you and places it into the appropriate box.
 
 6. If you want your PC to let you know when you’re due for the
 
 appointment, select the Reminder check box and enter the amount of time before the appointment occurs that you want to be notified. If you want to set an audio alarm, click the
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 Alarm Bell button and browse your hard drive to select a specific sound file for Outlook to play as your reminder. 7. From the Show Time As drop-down list, you can select how
 
 the appointment time block should be marked on the calendar. The default is Busy. But you can also block out the specified time as Free, Tentative, or Out of Office. The drop-down list uses different colors and patterns to specify each of the different appointment types. 8. In the large text box near the bottom of the Appointment tab,
 
 enter any text that you want to include, such as text to identify the appointment, reminders for materials to take, and so on. 9. Click the Categories button and assign a category (or cate-
 
 gories) to the appointment. 10. Click the Save and Close button to return to the Calendar.
 
 The Scheduling tab enables you to schedule a meeting with co-workers and enter the meeting on your calendar.
 
 SCHEDULING
 
 A
 
 RECURRING APPOINTMENT
 
 Suppose you have an appointment that comes around every week or month or that otherwise occurs on a regular basis. Instead of scheduling every individual occurrence of the appointment, you can schedule that appointment in your calendar as a recurring appointment. To schedule a recurring appointment, follow these steps: 1. In the Calendar folder, choose the Actions menu, and then
 
 New Recurring Appointment. The Appointment dialog box appears, and then the Appointment Recurrence dialog box appears on top of the Appointment dialog box (as shown in Figure 7.3).
 
 79
 
 08 6602 ch07
 
 80
 
 11/8/01
 
 2:25 PM
 
 Page 80
 
 LESSON 7
 
 FIGURE 7.3 Schedule a recurring appointment once, and Outlook fills in the appointment for you throughout the Calendar.
 
 2. In the Appointment Time area, enter the Start and End times
 
 for the appointment. Outlook calculates the duration of the appointment for you. 3. In the Recurrence Pattern area, indicate the frequency of the
 
 appointment: Daily, Weekly, Monthly, or Yearly. After you select one of these options, the rest of the Recurrence Pattern area changes to provide you with appropriate options, such as days of the week for a weekly recurring appointment or dayof-the-month options for a monthly recurring appointment. 4. Enter the day and month, as well as any other options in the
 
 Recurrence Pattern area that are specific to your selection in step 3. 5. In the Range of Recurrence area, enter appropriate time lim-
 
 its according to the following guidelines: • Start—Choose the date on which the recurring appointments begin. • No End Date—Choose this option if the recurring appointments are not on a limited schedule.
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 • End After—Choose this option and enter the number of appointments if there is a specific limit to the recurring appointments. • End By—Choose this option and enter an ending date to limit the number of recurring appointments. 6. Click OK to close the Appointment Recurrence dialog box.
 
 The Appointment dialog box appears. 7. Fill in the Appointment dialog box using the steps in the
 
 “Creating an Appointment” section already discussed in this lesson. When you finish providing all the details for the recurring appointment, click the Save and Close button to return to the Calendar. The recurring appointment appears in your calendar on the specified date and time. A recurring appointment contains a circular doublearrow icon to indicate that it is recurring. TIP Make Any Appointment Recurring If you have already started creating an appointment and then would like to make it recurring, click the Recurrence button on the appointment’s toolbar. The Appointment Recurrence dialog box opens.
 
 PLANNING EVENTS In the Outlook Calendar, an event is any activity that lasts at least 24 hours, such as a trade show or a conference. You can plan an event in the Calendar program to block off larger time slots than you would for normal appointments. In addition, you can schedule recurring events (such as a monthly seminar you attend that lasts all day). To schedule an event, choose Actions, and then select New All Day Event. The Event dialog box appears (see Figure 7.4; it looks similar to the New Appointment dialog box).
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 FIGURE 7.4 You can block out an entire day on the Calendar by scheduling an All Day Event.
 
 Fill in the Subject, Location, Start Time, and End Time text boxes. Make sure the All Day Event check box is checked (that’s the only difference between an event and an appointment). Click the Save and Close button to return to the Outlook Calendar. The appointment appears in gray at the beginning of the day for which you scheduled the event. To schedule a recurring event, open a New All Day Event window and fill in the information as described earlier. To make the event recurring, click the Recurrence button in the Event window. The Event Recurrence dialog box opens; fill in the appropriate information and click OK (this dialog box is similar to the one for recurring appointments). Complete the information in the Event window, and then click the Save and Close button. To edit an event or a recurring event, double-click the event in your calendar. Like a mail message or appointment, Outlook opens the event window so that you can change times, dates, or other details of the event. In this lesson, you learned to navigate the Calendar, create appointments, and save appointments. You also worked with recurring appointments and the scheduling of events. In the next lesson, you will learn to work with Word documents.
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 Working with Word Documents In this lesson, you learn how to start a new document and enter text. You also learn how to take advantage of Word document templates and Word document wizards.
 
 STARTING
 
 A
 
 NEW DOCUMENT
 
 Microsoft Word is an efficient and full-featured word processor that provides you with all the tools you need to produce a tremendous variety of document types—everything from simple documents, such as memos and outlines, to complex documents, such as newsletters and Internet-ready Web pages. When you choose to start a new document in Word, you can take three routes. You can: • Create a blank new document using Word’s default template • Create a document using one of Word’s many other templates or a custom one you created yourself • Create a document using one of the Word wizards, such as the Fax or Envelope Wizard The amount of software assistance you get in creating your new document is greatly increased when you choose the template or wizard option. PLAIN ENGLISH Template A blueprint for a document that may already contain certain formatting options and text.
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 When you create a new document from scratch, you are actually using a template—the Blank Document template. Documents based on the Blank Document template do not contain any premade text (as some of the other templates do), and the formatting contained in the document reflects Word’s default settings for margins, fonts, and other document attributes (including any you customized specifically to your needs or preferences). To open a new document, follow these steps: 1. Select File, and then New. The task pane opens on the right
 
 side of your screen. Under New from Template, select General Templates and Word opens the Templates dialog box with a range of templates from which to choose (see Figure 8.1). 2. Make sure that the General tab is selected in the Templates
 
 dialog box, and then double-click the Word Blank Document icon. A new document appears in the Word application window. Although the steps shown here are designed for you to create a new blank document, you could have chosen any of the templates available in the Templates dialog box to create a new document. The fastest way to create a new blank document is to click the New Blank Document icon on the Word Standard toolbar. CAUTION What Happened to My Previous Document? If you were already working on a document, the new document will, in effect, open on top of the document you were previously working on. You can get back to the previous document by clicking the appropriately named document icon on the Windows taskbar (if you haven’t yet named the first document, it might appear as Document1 on the taskbar). You can also select the Windows menu to see a list of currently opened documents. Click any document in the list to switch to it.
 
 09 6602 ch08
 
 11/8/01
 
 2:29 PM
 
 Page 85
 
 Working with Word Documents
 
 FIGURE 8.1 When you choose New on the File menu, the task pane opens and you can choose General Templates.
 
 TIP Removing Multiple Document Icons from the Taskbar If you prefer not to see the open document icons on the taskbar, select the Tools menu, select Options, and click the View tab. Clear the Windows in Taskbar check box. You must then use the Windows menu to switch between documents.
 
 ENTERING TEXT After you have opened a new document, you are ready to start entering text. Notice that a blinking vertical element called the insertion point appears in the upper-left corner of your new document. This is where new text will be entered.
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 Begin typing text from the keyboard. The insertion point moves to the right as you type. As soon as you reach the end of the line, the text automatically wraps to the next line if you are using word wrap. When you reach the end of a paragraph in Word, you must press the Enter key to manually insert a line break. If you want to view the manually placed line breaks (called paragraph marks) in your document, click the Show/Hide button on the Word Standard toolbar. If the Show/Hide button is not visible on the Word toolbar, click the Tool Options button located at the end of the Standard toolbar. From the shortcut menu that appears, select Add or Remove Buttons and then Standard. A drop-down box of other buttons, including the Show/Hide button, appears. Clicking this button adds it to the Standard toolbar. When you are finished, click outside the drop-down box to return to your document. Now you can turn the Show/Hide option on and off as previously described. TIP How Word Views Paragraphs Word considers any line or series of lines followed by a line break (created when you press the Enter key) a separate paragraph. This concept becomes very important when you deal with paragraph formatting issues, such as line spacing, indents, and paragraph borders.
 
 USING DOCUMENT TEMPLATES You don’t have to base your new documents on a blank template. Instead, you can take advantage of one of the special document templates that Word provides. These templates make it easy for you to create everything from memos to newsletters. Templates contain special text and document attributes; therefore, the look and layout of the document you create using a template are predetermined by the options contained in the template. This can include margins, fonts, graphics, and other document layout attributes.
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 To base a new document on a Word template, follow these steps: 1. Select the File menu, and then click New. The task pane
 
 opens in your current document window. 2. Several template category links are available under the New
 
 from Template heading. These links include categories such as Normal, General Templates, and Templates on Microsoft.com. Select the category link for the type of document you want to create. For example, to create a new memo, click the General Templates link. In the Templates dialog box that appears, choose the Memos tab (see Figure 8.2). Select your favorite style of memo and click OK (or doubleclick the icon of choice).
 
 FIGURE 8.2 The document category tabs in the Templates dialog box contain templates for different document types.
 
 3. The new document based on the template appears as shown
 
 in Figure 8.3.
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 FIGURE 8.3 The new document contains predetermined text and formatting attributes derived from the template.
 
 Most new documents based on templates already contain text, such as headings, as well as a variety of document layouts and text attributes, such as a particular font. For example, the document based on the Elegant Memo template already contains the layout for a memo, and it automatically enters the current date in the memo for you. Text can easily be entered into the document using the Click Here and Type boxes that are placed in the document. Just click anywhere on the bracketed box and type the text you want to enter. Many templates (the Elegant Memo template, for example) contain text that gives you advice on how to use the template. Any of this explanatory text can be selected and removed or replaced with your own text.
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 USING WORD WIZARDS If you find that you would like even more help as you create a new document, you can use any of a number of Word document wizards. These wizards actually walk you through the document creation process, and in many cases, they make sure that you enter the appropriate text in the proper place in the new document. The wizards are found on the same tabs that housed the templates located in the Templates dialog box (reached through the task pane). The wizards can be differentiated from standard templates by a small wizard’s wand that appears over a template’s icon. To create a new document using one of the wizards, follow these steps: 1. Select the File menu, and then click New to open the task
 
 pane. 2. Under the New from Template heading, select the link for
 
 the document category you want to create (many useful templates are under the General Templates link). In the Templates dialog box that appears, choose the new document tab of your choice. 3. To start the document creation process using the wizard, dou-
 
 ble-click the appropriate wizard icon (for example, the Memo Wizard on the Memos tab). When you double-click the wizard icon, the wizard dialog box opens with an introductory screen and outlines the document creation process for the type of document you want to create. For example, the Memo Wizard shown in Figure 8.4 details the memo creation process on the left side of the wizard dialog box. To move to the next step in the document creation process, click the Next button at the bottom of the wizard screen.
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 FIGURE 8.4 The various document wizards, such as the Memo Wizard, outline the new creation process and then walk you through the steps of creating the document.
 
 The various document wizards walk you through the entire document creation process. After completing the steps for document creation, click the Finish button to close the wizard. A new document appears in the Word window based on the choices you made as you worked with the wizard. Figure 8.5 shows a new document created using the Memo Wizard. The wizards you use vary in look and feel, depending on the type of document you are trying to create. For example, the Resume Wizard produces a decidedly different product than the Envelope Wizard does. A good rule to follow is to read each wizard screen carefully. Remember that you can always back up a step by clicking the Back button if you find that you’ve made an inappropriate choice (or you can close the unwanted document and start over).
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 FIGURE 8.5 The Memo Wizard prompts you to input the appropriate information for a memo and provides the formatting for the new document.
 
 SAVING
 
 A
 
 DOCUMENT
 
 Whether you create your new document using the Blank Document template, a Word template, or a document wizard, at some point you will want to save the new document. Saving your work is one of the most important aspects of working with any software application. If you don’t save your Word documents, you could lose them.
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 CAUTION Save and Save Often You don’t want to lose your valuable documents as you create them in Word. Power failures, an accidentally kicked-out power cord, or your computer locking up as you work can all lead to lost work. If you are really absent-minded about periodically saving your work, use the AutoSave feature. Select the Tools menu, then Options. Click the Save tab on the dialog box. Make sure the Save AutoRecover Info Every check box is selected. Use the minutes box to set the time interval between autosaves. This feature doesn’t replace periodically saving your document using the Save command, but it will help you recover more of your document if there is a problem such as a power failure.
 
 To save a document, follow these steps: 1. Click the Save button on the Word toolbar, or select the File
 
 menu and then Save. The first time you save your new document, the Save As dialog box appears. 2. Type a filename into the File Name box. If you want to save
 
 the file in a format other than a Word document (.doc), such as a text file (.txt), click the Save As Type drop-down arrow and select a different file type. 3. To save the file to a different location (the default location is
 
 My Documents), click the Save In drop-down arrow. After you select a particular drive, all the folders on that drive appear. 4. Double-click the desired folder in the Save In box to open
 
 that folder. 5. After you have specified a name and a location for your new
 
 document, select the Save button to save the file. Word then returns you to the document window.
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 As you edit and enhance your new document, you should make a habit of frequently saving any changes that you make. To save changes to a document that has already been saved under a filename, just click the Save button. If you would like to keep a backup of a document (the version as it appeared the last time you saved it) each time you save changes to it, you need to set the backup option. 1. Click the Tools command on the toolbar, and then select
 
 Options. 2. In the Options dialog box, click the Save tab and then the
 
 Always Create Backup Copy check box. Click OK to return to the document. 3. Name your file and save it for the first time to an appropriate
 
 location. Now, when you use the Save command to save changes you’ve made to the document, a backup copy of the file (with the extension .wbk) is also saved. This backup copy is the previous version of the document before you made the changes. Each subsequent saving of the document replaces the backup file with the previous version of the document. There might be occasions when, rather than using the backup option, you want to save the current document under a new filename or drive location. This can be done using the Save As command. To save your document with a new filename, follow these steps: 1. Select File, and then Save As. 2. In the Save As dialog box, type the new filename into the
 
 File Name box (make sure that you are saving the document in the desired path). 3. Click Save. The file is saved under the new name.
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 CLOSING
 
 A
 
 DOCUMENT
 
 When you have finished working with a document, you need to save your changes and then close the document. To close a document, select the File menu and then select Close. You can also close a document by clicking the Close (X) button on the right side of the document window. If you are working with multiple documents, closing one of the documents does not close the Word application. If you want to completely end your Word session, select the File menu, and then select Exit. Before closing a document, Word checks to see whether it has changed since it was last saved. If it has, Word asks whether you want to save these changes before closing. If you don’t want to lose any recent changes, click Yes to save the document.
 
 OPENING
 
 A
 
 DOCUMENT
 
 Opening an existing document is a straightforward process. You will find that the Open dialog box shares many of the attributes that you saw in the Save As dialog box. To open an existing Word file, follow these steps: 1. Select the File menu, and then Open. The Open dialog box
 
 appears. 2. By default, Word begins showing the files and folders in your
 
 My Documents folder. If the document you need is located elsewhere on your computer, click the Look In drop-down arrow to select the drive on which the file is located, and navigate to the folder containing the document you need. 3. To open the file, click the file, and then click the Open but-
 
 ton (you can also double-click the file). The file appears in a Word document window. If you are working with text files or documents that have been saved in a format other than the Word document format (.doc), you must select the file type in the Files of Type drop-down box to see them.
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 In this lesson, you learned how to create a new blank document and base a new document on a Word template. You also learned how to create a new document using the Word wizards, how to open an existing document, and how to save your documents. In the next lesson, you will learn how to edit your document and delete, copy, and move text. You also will learn how to save your document under a new filename.
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 Editing Documents In this lesson, you learn how to do basic text editing in Word, including moving and copying text; you work with the mouse and keyboard to move your document, and you learn how to save existing documents under a new filename.
 
 ADDING OR REPLACING TEXT DOCUMENT
 
 AND
 
 MOVING
 
 IN THE
 
 After you have completed a draft of your document, you probably will find yourself in a situation where you want to add and delete text in the document as you edit your work. Word makes it very easy for you to add new text and delete text that you don’t want. You also will find that, whether you use the mouse or the keyboard to move around in your document as you edit, Word offers a number of special keystrokes and other tricks that make moving within the document a breeze. Figure 9.1 highlights some of these tools and Word screen areas.
 
 ADDING NEW TEXT You actually have two possibilities for adding text to the document: insert and typeover. To insert text into the document and adjust the position of the existing text, place the I-beam mouse pointer where you want to insert the new text. Click the mouse to place the insertion point at the chosen position. Make sure that the OVR indicator on the Status bar is not active (it will be gray rather than bolded). This means that you are in the insert mode.
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 I-beam: Used to place the insertion point in the document.
 
 Horizontal scrollbar: Scroll to the left and right in a document.
 
 Vertical scrollbar: Scroll up and down in a document.
 
 Status bar: Shows indicators for typeover and extend features.
 
 FIGURE 9.1 A number of different tools and approaches are available for editing and selecting text in Word and moving around in your Word documents.
 
 PLAIN ENGLISH I-beam The shape that the mouse pointer takes when you place it over any text in a Word document. Use it to place the insertion point at a particular position in a document.
 
 PLAIN ENGLISH Insert Mode The default text mode in Word. New text is added at the insertion point and existing text is pushed forward in the document so that it remains as part of the document.
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 Type your new text. It is added at the insertion point, and existing text (the text to the right of the inserted text) is pushed forward in the document.
 
 REPLACING TEXT If you want to add new text to a document and simultaneously delete text to the right of the insertion point, use the mouse to place the insertion point where you want to start typing over the existing text. Press the Insert key on the keyboard and add your new text. The added text types over the existing text, deleting it (see Figure 9.2). When you switch to Typeover mode using the Insert key, the Word status bar displays the message OVR. This means that you are currently in Typeover mode.
 
 Typeover indicator FIGURE 9.2 When you are in Typeover mode, existing text is overwritten by the new text.
 
 PLAIN ENGLISH Typeover Mode Press the Insert key to enter this mode; new text is added at the insertion point and types over the existing text, deleting it.
 
 If you want to return to Insert mode, press the Insert key again (it toggles Word between the Insert and Typeover modes) and the OVR message on the status bar is dimmed (you can also double-click OVR on the status bar to toggle this feature on and off).
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 CAUTION Undo That Typeover If you inadvertently type over text in a document because you are in the Typeover mode, click the Undo button (it might take several clicks in cases where you have added several words to the document) on the toolbar to return the deleted text to the document (or press Ctrl+Z).
 
 MOVING AROUND
 
 THE
 
 DOCUMENT
 
 Whether you are a mouse aficionado or prefer to stick close to your keyboard, Word provides several shortcuts and tools for moving around a document that you are trying to edit. When you use the mouse, you can move to a different position in the current page by placing the mouse pointer (the I-beam) over a particular text entry and then clicking. This places the insertion point where you clicked. You also can use the mouse to move through your document using the vertical and horizontal scrollbars. For example, clicking the up-scroll arrow on the vertical scrollbar moves you up through the document. Clicking the down-scroll arrow moves you down through the document. If you want to quickly move to a particular page in the document, you can drag the scroll box to a particular place on the vertical scrollbar. As soon as you click the scrollbox, a page indicator box appears that you can use to keep track of what page you are on as you drag the scroll box up or down on the vertical scrollbar. The vertical scrollbar also provides Previous Page and Next Page buttons (the double-up arrow and double-down arrow buttons on the bottom of the scrollbar) that can be used to move to the previous page and next page, respectively. Use the mouse to click the appropriate button to move in the direction that you want to go in your document.
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 The horizontal scrollbar operates much the same as the vertical scrollbar; however, it offers the capability to scroll only to the left and the right of a document page. This is particularly useful when you have zoomed in on a document and want to scrutinize an area of the page in great detail. You should be aware that clicking the mouse on the vertical scrollbar to change your position in a document allows you to view a different portion of a page or a different part of the document; however, it does not move the insertion point to that position on the page. To actually place the insertion point, you must move to a specific place or position in the document, and then click the mouse I-beam where you want to place the insertion point. When you’re typing or editing text, you might find that the fastest way to move through the document is with the help of the keyboard shortcuts shown in Table 9.1. Keeping your hands on the keyboard, rather than reaching out for the mouse, can be a more efficient way to move in a document while you compose or edit. TIP Scroll Quickly with a Wheel Mouse You might want to purchase a wheel mouse, such as Microsoft’s IntelliMouse, which provides a rolling device on the top of mouse (between the click buttons). With your finger on the wheel device, you can literally “roll” the vertical scrollbar through the document at the pace of your choice—rapidly or slowly.
 
 Table 9.1
 
 Using the Keyboard to Move Through the Document
 
 Key Combination
 
 Movement
 
 Home
 
 Move to the beginning of a line
 
 End
 
 Move to the end of a line
 
 Ctrl+Right arrow
 
 Move one word to the right
 
 Ctrl+Left arrow
 
 Move one word to the left
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 Table 9.1
 
 (continued)
 
 Key Combination
 
 Movement
 
 Ctrl+Up arrow
 
 Move to the previous paragraph
 
 Ctrl+Down arrow
 
 Move to the next paragraph
 
 PgUp
 
 Move up one window
 
 PgDn
 
 Move down one window
 
 Ctrl+PgUp
 
 Move up one page
 
 Ctrl+PgDn
 
 Move down one page
 
 Ctrl+Home
 
 Move to the top of a document
 
 Ctrl+End
 
 Move to the bottom of a document
 
 SELECTING TEXT Having a good handle on the different methods for selecting text in a document makes it easy for you to take advantage of many features, including deleting, moving, and formatting text. You can select text with either the mouse or the keyboard. Both methods have their own advantages and disadvantages as you work on your documents.
 
 SELECTING TEXT
 
 WITH THE
 
 MOUSE
 
 The mouse is an excellent tool for selecting text in your document during the editing process. You can double-click a word to select it and also use different numbers of mouse clicks (quickly pressing the left mouse button) or the mouse in combination with the Shift key to select sentences, paragraphs, or other blocks of text. You also can hold the left mouse button down and drag it across a block of text that you want to select. How you use the mouse to select the text depends on whether the mouse pointer is in the document itself or along the left side of the document in the selection bar. The selection bar is the whitespace on
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 the left edge of your document window, just in front of your text paragraphs. When you place the mouse in the selection bar, the mouse pointer becomes an arrow (in contrast to placing the mouse in the document where the pointer appears as an I-beam). Selecting text lines and paragraphs from the selection bar makes it easy for you to quickly select either a single line or the entire document. Table 9.2 shows you how to select different text items using the mouse. Figure 9.3 shows the mouse pointer in the selection bar with a selected sentence. Table 9.2
 
 Using the Mouse to Quickly Select Text in the Document
 
 Text Selection
 
 Mouse Action
 
 Selects the word
 
 Double-click a word
 
 Selects text block
 
 Click and drag Or Click at beginning of text, and then hold down Shift key and click at the end of text block
 
 Selects line
 
 Click in selection bar next to line
 
 Selects multiple lines
 
 Click in selection bar and drag down through multiple lines
 
 Selects the sentence
 
 Hold Ctrl and click a sentence
 
 Selects paragraph
 
 Double-click in selection bar next to paragraph Or Triple-click in the paragraph
 
 Selects entire document
 
 Hold down Ctrl and click in selection bar
 
 You will find these mouse manipulations are particularly useful when you are editing the document. Selected text can be quickly deleted, moved, or copied.
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 FIGURE 9.3 Place the mouse pointer in the selection bar to quickly select a line, a paragraph, or other text block.
 
 SELECTING TEXT
 
 WITH THE
 
 KEYBOARD
 
 You can also select text using only the keyboard. Press the F8 function key to turn on the extend (or select) feature; the EXT indicator becomes active on the Word status bar (meaning it is no longer “grayed” out). To select text using the extend feature, use the arrow keys to move over and highlight characters, words, or sentences you want to select. You can quickly select entire words by pressing F8 and then pressing the spacebar. To select an entire sentence, turn on the extend feature, and then press the period (.) key. Entire paragraphs can be selected using this method by pressing the Enter key. To turn off the extend feature, press the Esc key.
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 Finally, you can select text by pressing only the F8 function key. Press F8 once to turn on the select feature where you want it, press it twice to select a word, three times to highlight an entire sentence, four times to select a paragraph, and five times to select your entire document.
 
 DELETING, COPYING,
 
 AND
 
 MOVING TEXT
 
 Another important aspect of editing is being able to delete, move, or copy text in your document. Each of these tasks can be easily accomplished in Word and uses the mouse or the keyboard to select the text that you want to delete, move, or copy. Then, it’s just a matter of invoking the correct command to delete, move, or copy the selected text.
 
 DELETING TEXT Deleting text can be accomplished in more than one way. The simplest way to remove characters as you type is with the Backspace key or the Delete key. If there is no text selected, here is how these keys work: • Delete—Deletes the character to the right of the insertion point. • Backspace—Deletes the character to the left of the insertion point. You will probably find, however, that when you delete text you want to remove more than just one character, so use the keyboard or the mouse to select the text you want to delete. After the text is selected, press the Delete key. The text is then removed from the document. You can also delete text and replace it with new text in one step. After the text is selected, type the new text. It replaces the entire existing, selected text.
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 CAUTION Delete and Cut Are Different When you want to erase a text block forever, use the Delete key. When you want to remove text from a particular place in the document but want to have access to it again to place it somewhere else, use the Cut command on the Edit menu. When you cut an item, it is automatically placed on the Office Clipboard. These steps are covered later in this lesson.
 
 COPYING, CUTTING,
 
 AND
 
 PASTING TEXT
 
 Copying or cutting text and then pasting the copied or cut item to a new location is very straightforward. All you have to do is select the text as we have discussed earlier in this lesson and then invoke the appropriate commands. Use the following steps to copy and paste text in your document: 1. Using the mouse or the keyboard, select the text that you
 
 want to copy. 2. Select the Edit menu and then select Copy, or press Ctrl+C
 
 to copy the text. 3. Place the insertion point in the document where you want to
 
 place a copy of the copied text. 4. Select the Edit menu and then select Paste, or press Ctrl+V.
 
 A copy of the text is inserted at the insertion point. TIP Use the Copy, Cut, and Paste Icons To quickly access the copy, cut, and paste features, use the Copy, Cut, and Paste icons on the Word toolbar, respectively.
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 After pasting your selected text, the Paste smart tag icon appears just below the text that you have pasted. When you click this icon, it provides a shortcut menu that allows you to keep the formatting that was applied to the source text that you copied, match the formatting supplied by the destination for the text (the paragraph in which the text is placed), or just paste the text into the new location with no formatting at all (which means it will assume the formatting that is provided at the current location). Smart tags are a new feature found in Word 2002. Figure 9.4 shows pasted text and the Paste smart tag provided for the text.
 
 FIGURE 9.4 The Paste smart tag allows you to choose how the text is pasted into the new location.
 
 Cutting text from the document and then pasting it to a new location is every bit as straightforward as using copy and paste. Select the text, and then press Ctrl+X or click the Cut button on the Standard toolbar. Click the I-beam to place the insertion point on the document, and
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 then you can use Ctrl+V or the Paste button on the Standard toolbar to place the text in a new location. A Paste smart tag will appear below the pasted text as shown in Figure 9.4.
 
 USING
 
 THE
 
 OFFICE CLIPBOARD
 
 TO
 
 COPY
 
 AND
 
 MOVE MULTIPLE ITEMS
 
 The Office Clipboard feature now resides in the task pane of your Office application windows. If you want to copy or cut more than one item and then be able to paste them into different places in the document, you must use the Office Clipboard. Follow these steps: 1. To open the Clipboard task pane, select the Edit menu and
 
 select Office Clipboard. The Clipboard appears in the task pane. 2. As shown in Figure 9.5, select and copy each item to the
 
 Clipboard.
 
 FIGURE 9.5 The Clipboard can hold up to 24 separate items.
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 3. After you have copied your items onto the Clipboard, place
 
 the insertion point where you want the first item to be pasted. Then, return to the Clipboard and with the mouse, point to your first item and click; Word automatically inserts the item into the document. 4. Repeat step 3 as needed to paste other items from the
 
 Clipboard into your document. If you want to cut and paste (or move) multiple items, you must use the Office Clipboard. Follow these steps: 1. To open the Clipboard, select the Edit menu and select
 
 Clipboard. The Clipboard appears in the task pane. 2. Select and cut each item to the Clipboard. 3. After you have your cut items on the Clipboard, place the
 
 insertion point where you want the first item to be pasted. Then, return to the Clipboard and with the mouse, point to your first item and click; it will automatically be inserted into the document. 4. Repeat step 3 as needed to paste other items from the
 
 Clipboard into your document.
 
 USING DRAG
 
 AND
 
 DROP
 
 One other way to move text is by selecting it and dragging it to a new location. This is called drag and drop. After the text is selected, place the mouse on the text block and hold down the left mouse button. A Move pointer appears, as shown in Figure 9.6. Drag the Move pointer to the new location for the text. A dotted insertion point appears in the text. Place this insertion point in the appropriate position and release the mouse button. The text is moved to the new location.
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 FIGURE 9.6 Drag a block of selected text to a new location with drag and drop.
 
 COPYING
 
 AND
 
 MOVING TEXT BETWEEN DOCUMENTS
 
 You can copy and move text easily between documents. All you have to do is open the appropriate documents and then use the methods already discussed for copying or moving text. You can even use drag and drop to move information from one document to another. To copy information from one document to another, follow these steps: 1. Open the document you want to copy information from and
 
 the one you want to copy that information to (see Lesson 8, “Working with Word Documents,” for more information on opening documents).
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 2. Switch to the document that contains the text you want to
 
 copy by clicking the document’s button on the Taskbar or selecting the Windows menu and then the name of the document. 3. Select the text you want to copy, select the Edit menu, and
 
 then select the Copy command. 4. Using the instructions in step 3, switch to the document into
 
 which you want to paste the text. 5. Select the Edit menu and then select Paste. The text is pasted
 
 into your document. You can also use the preceding steps to move text from one document to another by substituting the Cut command for the Copy command. You can also use drag and drop to move text from one document to another. Working with multiple document windows can be tricky. You probably won’t want to have more than two documents open at a time if you want to use drag and drop. (There won’t be enough space in the Word workspace to scroll through the documents and find the text you want to move or the final resting place for the text in the other document.) To view multiple document windows, open the desired documents. Select the Windows menu and then select Arrange All. Each document is placed in a separate window in the Word workspace. The windows might be small if you have several documents open. Locate the text you want to move and select it. Drag it from the current document window to the document window and position where you want to place it. In this lesson, you learned basic editing techniques including the deleting, copying, and moving of text. You also learned to move around your documents and various ways to select text. You also worked with multiple documents and copied text from one document to another. In the next lesson you will learn how to modify the look of the text in your Word documents.
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 Changing How Text Looks In this lesson, you learn basic ways to change the look of your text. You work with fonts and learn how to change font attributes. You also work with text alignment, such as centering and right justification.
 
 UNDERSTANDING FONTS When you work in Word, you want to be able to control the look of the text in the documents that you create. The size and appearance of the text is controlled for the most part by the font or fonts you choose to use in the document. Each available font has a particular style or typeface. A variety of fonts exists, with names such as Arial, Courier, Times New Roman, CG Times, Bookman Old Style, and so on; the fonts you can choose depend on the fonts that have been installed on your computer (Windows offers a large number of default fonts; other font families are added when you install Office, and you can purchase software for special lettering and printing projects). Each font has a particular look and feel that makes it unique. TIP Keep Your Business Documents Standard The standard point size for most business documents is 12 point, which is 1/6 of an inch tall. So, when selecting a new font, it’s generally a good idea to make sure that you use 12 point for documents such as business letters and memos.
 
 You can change the font or fonts used in a document whenever you have the need, and you can also manipulate the size of the characters and their attributes, including bold, underlining, and italic. You can select a new font before you begin typing your document, or you can select text and change its fonts and text attributes at any time.
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 CHANGING FONT ATTRIBUTES The easiest way to change font attributes is through the use of the buttons provided on the Word Formatting toolbar. Figure 10.1 shows the Word Formatting toolbar with some of the most common font attribute buttons displayed. Underline Font box
 
 Bold
 
 Font color
 
 Size box Italic FIGURE 10.1 The Word Formatting toolbar gives you quick access to control the font attributes in your documents.
 
 You can quickly change the font of selected text by clicking the Font box and selecting a new font from the list that appears. Other attributes, such as bold, italic, and underline, require that you select the text and then click the appropriate button once to add that attribute to the text. For example, you might want to apply special formatting to a heading so that it stands out from the rest of the text. You can do that by adding bold to the text. To add bold to text in a document, follow these steps: 1. Select the word or other text to be bold. 2. Click the Bold button on the Formatting toolbar. The text
 
 appears in bold. 3. Click any other part of the document to deselect the text and
 
 view the results of your formatting. You can use this same technique to underline and italicize text in your documents.
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 TIP I Don’t Have Those Buttons on My Toolbar Click the Toolbar Options drop-down arrow, point at Add or Remove Buttons, and then select the name of the toolbar to which you want to add the buttons (such as the Formatting toolbar). From the drop-down list, select the buttons that you want to add to the Formatting toolbar. If you don’t see the Formatting toolbar at all, right-click any of the toolbars and select Formatting on the menu that appears.
 
 You can also use the various font buttons to select font attributes for the new text you type into a new document or insert into an existing document. Select the appropriate font attributes on the Formatting toolbar, and then type the text. To turn off a particular attribute, such as bold or italic, click the appropriate button a second time. To change to a new font or size, use the appropriate drop-down box. When you are typing in a document, you might find that selecting font attributes from the toolbar actually slows you down because you must remove one hand from the keyboard to use the mouse to make your selection. You can also turn on or off a number of the formatting attributes using shortcut keys on the keyboard. Table 10.1 shows some of the common keyboard shortcuts for formatting attributes. Table 10.1
 
 Font Attribute Shortcut Keys
 
 Attribute
 
 Shortcut Keys
 
 Bold
 
 Ctrl+B
 
 Italic
 
 Ctrl+I
 
 Underline
 
 Ctrl+U
 
 Double underline
 
 Ctrl+Shift+D
 
 Subscript
 
 Ctrl+equal sign (=)
 
 Superscript
 
 Ctrl+Shift+plus sign (+)
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 To use any of the shortcut key combinations, press the keys shown simultaneously to turn the attribute on, and then repeat the key sequence to turn the attribute off. For example, to turn on bold while you are typing, press the Ctrl key and the B key at the same time. Press these keys again to turn the bold off.
 
 WORKING
 
 IN THE FONT
 
 DIALOG BOX
 
 Although the Formatting toolbar certainly provides the quickest avenue for controlling various font attributes, such as the font and the font size, you can access several more font attributes in the Font dialog box. The Font dialog box gives you control over common attributes, such as font, font size, bold, and so on, and it also provides you with control over special font attributes, such as superscript, subscript, and strikethrough. To open the Font dialog box, click the Format menu and then select Font. The Font dialog box appears, as shown in Figure 10.2.
 
 FIGURE 10.2 The Font dialog box provides you with control over several font attributes not found on the Formatting toolbar.
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 As you can see, the Font dialog box enables you to choose from several font attributes. You can control the font, the font style, and other character attributes such as strikethrough, superscript, and shadow, as shown next. • To change the font, click the Font drop-down box and select the new font by name. • To change the font style to italic, bold, or bold italic, make the appropriate selection in the Font Style box. • To change the size of the font, select the appropriate size in the Size scroll box. • For underlining, click the Underline Style drop-down box and select an underlining style. • To change the color of the font, click the Font Color dropdown box and select a new color. • To select any special effects, such as strikethrough, superscript, or shadow, select the appropriate check box in the lower half of the dialog box. As you make the various selections in the Font dialog box, a sample of what the text will look like appears in the Preview box at the bottom of the dialog box. After you have made all your selections in the Font dialog box, click OK. TIP Change the Default Font To change the default font that you use for your documents (those created using the current or desired template), select the font attributes in the Font dialog box and then click the Default button at the lower left of the dialog box. Click Yes when Word asks for a confirmation of the change.
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 ALIGNING TEXT Another important basic attribute of the text in your documents is how that text is oriented on the page. When you first start typing in a new document, all the text begins at the left margin and moves to the right as you type; this means the text is left-justified using the default align-left feature. Left-justified text is characterized by text that is straight or unvarying on the left margin but has a ragged right-edged margin. Text that serves a special function in a document, such as a heading, would probably stand out better in the document if it were placed differently than the rest of the text. Word makes it easy for you to change the alignment of any text paragraph. Several alignment possibilities are available: • Align Left—The default margin placement for normal text that is aligned on the left. • Align Right—Text is aligned at the right margin and text lines show a ragged left edge. • Center—The text is centered between the left and right margins of the page (with both margins having irregular edges). • Justify—The text is spaced irregularly across each line so that both the left and the right margins are straight-edged and uniform (often used in printed publications such as the daily newspapers). Figure 10.3 shows examples of each of the alignment possibilities. The easiest way to change the alignment of text in the document is to use the alignment buttons on the Formatting toolbar. Also, a button exists in the Paragraph dialog box for each of the alignment possibilities. Table 10.2 shows the buttons and their functions.
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 Left justification
 
 Centered
 
 Full justification
 
 Right justification
 
 FIGURE 10.3 You can align the text in your document to suit your particular needs on a document page.
 
 Table 10.2 Button
 
 Alignment Icons on the Formatting Toolbar Justification Align left Center Align right Justify (full justification)
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 These justification buttons can be used to align new text or selected text. Again, if you are typing new text with a particular justification, your selected justification will still be in force even after you press Enter. You must change the justification as needed.
 
 ALIGNING TEXT
 
 WITH
 
 CLICK
 
 AND
 
 TYPE
 
 Word offers a unique and quick way to insert and align text (or to insert graphics, tables, and other items) in a blank area of a document. Before entering text or another item, place the mouse pointer on a blank line on the page. As you move the mouse pointer from right to left on the blank line, the pointer (or I-beam, in this case) changes shapes as you move it, denoting a particular line alignment. This makes it very easy to center or right-align the insertion point before you insert the text or other item. CAUTION Click and Type Option Must Be On To use Click and Type, you must also make sure that the Enable Click and Type box is selected on the Edit tab of the Options dialog box (select Tools and then Options to open this dialog box).
 
 To use the Click and Type feature, you must be in the Print Layout or Web Layout view. The feature is not available in the Normal view. To switch to the Print Layout or Web Layout view, select View, and then select the appropriate view from the View menu. Then, to use Click and Type to align your new text, follow these steps: 1. Move the mouse pointer toward the area of the page where
 
 you want to place the insertion point. The pointer icon changes to •
 
 Center (the centering pointer appears)
 
 •
 
 Right (the align-right pointer appears)
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 2. After the mouse pointer shows the centering or right-align
 
 icon, double-click in the document. The insertion point moves to the selected justification. 3. Type your new text.
 
 After you’ve typed the centered or right-aligned text and you’ve pressed Enter to create a new line, you can return to left justification by placing the mouse to the left of the line (the align-left icon appears on the mouse pointer) and double-clicking. In this lesson, you learned how change the font and font size in your document and work with various font attributes, such as bold, italic, and underline. You also learned how to align text in your document and worked with the various justification options. In the next lesson, you will learn how to use styles to format text in your documents.
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 Working with Styles In this lesson, you learn how to create text and paragraph styles. You also learn how to edit your styles and take advantage of the styles in the Style Gallery.
 
 UNDERSTANDING STYLES Word styles provide an excellent way to manage the character and paragraph formatting in a document. A style is a grouping of formatting attributes identified by a style name. You can create styles for text that contain character-formatting attributes such as bold, italic, or a particular font size; these types of styles are called character styles. You can also create styles for paragraphs that include paragraph attributes, such as alignment information, indents, and line spacing; this type of style is called a paragraph style. You view the style names in the Styles and Formatting task pane (see Figure 11.1). To open the Styles and Formatting task pane, select the Format command and then click Styles and Formatting. TIP Select Styles and Formatting at the Touch of a Button The easiest way to access the Styles and Formatting task pane is to use the Styles and Formatting button on the Formatting toolbar.
 
 Word includes several built-in styles, such as the headings, that you can take advantage of in your documents. Styles are particularly useful
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 because if you use them to format text or paragraphs in the document, you can change the attributes saved in the style at any time. These changes immediately take effect on all the text that has been assigned that style.
 
 FIGURE 11.1 The Styles and Formatting task pane is the starting place for creating, editing, and managing the styles and formatting in your documents.
 
 Updating the look of text or the layout of paragraphs by editing a style allows you to quickly edit the look of text in your document. Using styles also provides you with a way to make certain categories of text, such as headings or figure captions, look uniform throughout the document without having to assign each of them character or paragraph attributes individually. CAUTION Paragraph Styles Versus Text Styles Paragraph styles (the more commonly used option) assign both character and paragraph attributes to the paragraph containing the insertion point. Text styles affect only the word or words you select before you apply the style.
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 CREATING TEXT STYLES Creating text styles is extremely easy. Select the text you want to emphasize with special character formatting and assign it all the character attributes (font type, bold, underline, italic, and so on) that you want to include in the style. You may assign the attributes using either the Font dialog box (by selecting Format, Font) or the appropriate buttons on the Formatting toolbar. Make sure that the desired text is selected, and then follow these steps to create the style: 1. Select the Styles and Formatting task pane and then New
 
 Style; the New Style dialog box appears. 2. Click the Style Type drop-down box and select Character
 
 for the style type. 3. Look in the Formatting of Selected Text area of the Styles
 
 and Formatting task pane. Here you can see the text attributes that you have assigned to your selected text. Note that the new style is based on the current style (the default paragraph style or the normal style) plus your added attributes. 4. Type a name for your new style into the Name box. 5. Click OK to conclude the style creation process. You are
 
 returned to the Styles and Formatting task pane. Notice that your new style now appears in the Pick Formatting to Apply list in the task pane. You can now assign the new character style to text in your document as needed. Simply select the text to which you want to assign this unique style, and then select the Styles and Formatting task pane. Select your unique style from the list provided. The style is applied to the selected text.
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 TIP View All the Text Assigned a Particular Style If you would like to select all the different text items that you assigned a particular style, select the style in the Styles and Formatting task pane and then click the Select All button.
 
 CREATING PARAGRAPH STYLES Creating paragraph styles is similar to creating text styles. Apply to a paragraph the formatting that you want to include in the style (you can use alignment settings, indents, and all the paragraph attributes that you are familiar with). Make sure the insertion point is in the paragraph. You can create the style by following these steps: 1. Select the Styles and Formatting task pane and then New
 
 Style; the New Style dialog box appears. 2. Click the Style Type drop-down box and select Paragraph
 
 for the style type. 3. Type a unique name into the Name box for the style. 4. Click OK to return to the Styles and Formatting task pane.
 
 The style is now available on the Style list. You can now apply the style to any paragraph in the document by placing the insertion point in the paragraph.
 
 EDITING STYLES You can also edit or modify the attributes found in any of your styles or the default styles in the document. You edit styles using the Styles and Formatting task pane. Remember that when you edit a style, all the text to which the style was applied reflects the new text and paragraph attributes of your edited style.
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 To edit a style, follow these steps: 1. Select the Styles and Formatting task pane. 2. Under Pick Formatting to Apply, select the style you want
 
 to edit and place the mouse pointer on it until you see the box outline and down arrow appear. Then, click the down arrow and press Modify. The Modify Style dialog box appears as shown in Figure 11.2.
 
 FIGURE 11.2 The Modify Style dialog box allows you to edit the name of a style and modify all the attributes found in the style.
 
 3. To modify the style, select the Format button. A menu
 
 appears, allowing you to modify the following attributes in the style: • Font • Paragraph • Tabs • Borders
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 • Language • Frame • Numbering 4. Select one of the choices provided in the Format box. The
 
 appropriate dialog box appears, allowing you to edit the settings for the chosen attributes. For example, if you want to modify the font attributes for the style, click the Format arrow and select Font from the list provided. The Font dialog box appears. 5. When you have finished modifying the Font attributes for the
 
 style (or for whichever style type you chose to modify), click OK. You are returned to the Modify Style dialog box. 6. Modify other attributes of the style as needed by making the
 
 appropriate choices from the menus. 7. When you have completed your style modifications, click
 
 OK in the Modify Style dialog box and you return to the task pane with the changes made. TIP You Can Delete Unwanted Styles You can delete styles that you’ve created that you no longer need. Open the Styles and Formatting task pane and place the mouse pointer on the style in the Pick Formatting to Apply list. Wait for the box outline and down arrow to appear, and then click the Delete button under the down arrow. The style is removed from the Style list.
 
 USING
 
 THE
 
 STYLE ORGANIZER
 
 Word also has the capability to copy styles from other documents and templates into your current document. This provides you with an easy way to add already existing styles to a document (rather than reinventing the wheel or style).
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 To copy styles from another document or template, follow these steps: 1. Select the Tools command, and then choose Templates and
 
 Add-Ins. 2. In the Templates and Add-Ins dialog box, click the
 
 Organizer button. The Organizer dialog box appears as shown in Figure 11.3.
 
 FIGURE 11.3 The Organizer dialog box makes it easy for you to copy a style or styles from one document to another.
 
 3. The styles in the current document appear on the left side of
 
 the Organizer dialog box. Styles in the template that your current document was based on are shown on the right side of the Organizer dialog box (all documents are based on a template, even if it is just the Word Normal template). To close the template file on the right side of the dialog box, click the Close File button (in Figure 12.3, click Close File under the Normal.dot template on the right of the dialog box). 4. Now you can open a new template or document and copy the
 
 styles that it contains to the current document (shown on the left of the dialog box). Click Open File on the right side of the Organizer dialog box. Locate the document or template
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 from which you want to copy the styles. Double-click the file in the Open dialog box to open the file. 5. You are returned to the Organizer dialog box, and the styles
 
 for the recently opened template or document are listed on the right side of the dialog box. To copy a style or styles, select the style and click the Copy button. The style is copied to the styles in your current document. 6. When you have finished copying styles (styles can be copied
 
 from either of the documents in the Organizer dialog box), click Close to close the Organizer dialog box. As you can see, the Organizer makes it very easy for you to share the styles that you create between your documents. Remember, styles that you create reside only in the document where you create them. The only way to copy those styles to another document is to use the Style Organizer. In this lesson, you learned to create and assign character and paragraph styles. You also learned to modify your styles and how to copy styles from one document to another using the Organizer dialog box. In the next lesson, you learn how to enter data into an Excel worksheet.
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 Entering Data into an Excel Worksheet In this lesson, you learn how to enter different data types into an Excel worksheet and use special features, such as AutoComplete and the Speech feature.
 
 UNDERSTANDING EXCEL DATA TYPES Excel is a powerful spreadsheet program that can help you create worksheets and invoices and do both simple and sophisticated number crunching; it is designed to help you calculate the results of formulas and help you analyze numerical data. Excel also makes it easy for you to take numerical information and display the data in a variety of different chart types. When you work in Excel, you enter different types of information, such as text, numbers, dates, times, formulas, and functions (which is a special built-in formula provided by Excel). Excel data basically comes in two varieties: labels and values. A label is a text entry; it is called a label because it typically provides descriptive information, such as the name of a person, place, or thing. A label has no numerical significance in Excel; it’s just there to describe accompanying values. PLAIN ENGLISH Label
 
 Any text entry made on an Excel worksheet.
 
 A value is data that has numerical significance. This includes numbers, dates, and times that you enter on your worksheet. Values can be acted
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 on by formulas and functions. Formulas are discussed in Lesson 13, “Performing Simple Calculations in Excel,” and Excel functions are discussed in Lesson 14, “Performing Calculations with Functions.” PLAIN ENGLISH Values Entries, such as numbers and dates, that have numerical significance and can be acted upon by formulas or functions.
 
 ENTERING TEXT Text is any combination of letters, numbers, and spaces. By default, text is automatically left-aligned in a cell, whereas numerical data is right-aligned. As you work in Excel you are working in “blocks” that are created by the intersection of the rows and columns in the worksheet. One of these blocks is referred to as a cell. To enter text into a cell, follow these steps: 1. Use your mouse or the keyboard arrows to select the cell in
 
 which you want to enter text. 2. Type the text. As you type, your text appears in the cell and
 
 in the Formula bar, as shown in Figure 12.1.
 
 FIGURE 12.1 Data that you enter into a cell also appears in the Formula bar as you type it.
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 3. Press Enter. Your text appears in the cell, left-aligned. The
 
 cell selector moves down one cell. You also can press Tab or an arrow key to enter the text and move to the next cell to the right (or in the direction of the arrow). CAUTION But My Entry Doesn’t Fit! When text does not fit into a cell (because of the column width set for that column), you will be able to see only the portion of your entry that fits within the confines of the cell. Drag the column border at the top of the column to expand the column width.
 
 TIPS
 
 ON
 
 ENTERING COLUMN
 
 AND
 
 ROW LABELS
 
 Column and row labels identify your data. Column labels appear across the top of the worksheet beneath the worksheet title (if any). Row labels are entered on the left side of the worksheet. Column labels describe what the numbers in a column represent. Typically, column labels specify time intervals such as years, months, days, quarters, and so on. Row labels describe what the numbers in each row represent. Typically, row labels specify data categories, such as product names, employee names, or income and expense items in a budget. When entering your column labels, enter the first label and press the Tab key instead of pressing Enter. This moves you to the next cell on the right so that you can enter another column label. When entering row labels, use the down-arrow key instead of the Tab key. Figure 12.2 shows the various labels for a quarterly sales summary. If you need to enter similar data (such as a series of months or years) as column or row labels, you can enter them quickly as a series; this technique is discussed later in this lesson.
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 Column headings
 
 Row headings FIGURE 12.2 Column and row headings serve as labels for the data you enter on the worksheet.
 
 ADDING COMMENTS
 
 TO
 
 CELLS
 
 Although not really considered cell content (such as labels and values), you can add comments to particular cells. These comments allow you to associate information with a cell—information that does not appear (by default) with the worksheet when sent to the printer. Comments are similar to placing a Post-it note on a cell, reminding you that an outstanding issue is related to that cell. For example, if you need to check the value that you’ve placed in a particular cell to make sure that it’s accurate, you can place a comment in the cell (see Figure 12.3). Cells containing comments are marked with a red
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 triangle in the upper-right corner of the cell. To view a comment, place the mouse pointer on the comment triangle.
 
 FIGURE 12.3 Comments can be added to cells as a kind of electronic Post-it note.
 
 To insert a comment into a cell, follow these steps: 1. Click the cell in which you want to place the comment. 2. Select Insert, Comment. A comment box appears next to
 
 the cell. 3. Type your information into the comment box. 4. Click anywhere else in the worksheet to close the comment box.
 
 You also can easily remove comments from cells. Select the cell, and then select Edit and point at Clear. On the cascading menu, select Comments to remove the comment.
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 ENTERING NUMBERS Data that serves as the values in your workbooks can include the numeric characters 0–9. Because formulas also are considered values, other valid value characters include symbols such as +, –, /, and *. You also can use characters such as a comma (,), a percent sign (%), or a dollar sign ($) in your values. You will find, however, that you can save yourself a few data-entry keystrokes and add these characters using different Excel formatting options. For example, you could enter the dollar amount $700.00 including the dollar sign and the decimal point. However, it’s probably faster to enter 700 into the cell and then format all the cells that contain dollar amounts after you have entered all the data. To enter a value, follow these steps: 1. Click in the cell where you want to enter the value. 2. Type the value. To enter a negative number, precede it with a
 
 minus sign or surround it with parentheses. 3. Press Enter or the Tab key; the value appears in the cell
 
 right-aligned. Figure 12.4 shows various values entered into a simple worksheet.
 
 FIGURE 12.4 Values are right-aligned in a cell.
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 TIP What Are All Those Pound Signs? If you enter a number and it appears in the cell as all pound signs (#######) or in scientific notation (such as 7.78E+06), the cell just isn’t wide enough to display the entire number. To fix it, double-click the right border of the column’s heading. The column expands to fit the largest entry in that column.
 
 ENTERING DATES
 
 AND
 
 TIMES
 
 Dates that you enter into an Excel workbook have numerical significance. Excel converts the date into a number that reflects the number of days that have elapsed since January 1, 1900. Even though you won’t see this number (Excel displays your entry as a normal date), the number is used whenever you use this date in a calculation. Times also are considered values. Excel sees them as the number of seconds that have passed since 12 a.m. Follow these steps to enter a date or time: 1. Click in the cell where you want to enter a date or a time. 2. To enter a date, use the format MM/DD/YY or the format
 
 MM-DD-YY, as in 05/09/01 or 05-09-01. To enter a time, be sure to specify a.m. or p.m., as in 7:21 p or 8:22 a. TIP A.M. or P.M.? Unless you type am or pm after your time entry, Excel assumes that you are using a 24-hour international clock. Therefore, 8:20 is assumed to be a.m., not p.m. (20:20 would be p.m.: 8 plus 12 hours). Therefore, if you mean p.m., type the entry as 8:20 pm (or 8:20 p). Note that you must type a space between the time and the am or pm notation.
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 3. Press Enter. As long as Excel recognizes the entry as a date
 
 or a time, it appears right-aligned in the cell. If Excel doesn’t recognize it, it’s treated as text and left-aligned. After you enter your date or time, you can format the cells to display the date or time exactly as you want it to appear, such as September 16, 1998, or 16:50 (international time). If you’re entering a column of dates or times, you can format the entire column in one easy step. To format a column, click the column header to select the column. Then open the Format menu and select Cells. On the Numbers tab, select the date or time format you want to use.
 
 COPYING (FILLING)
 
 THE
 
 SAME DATA
 
 TO
 
 OTHER CELLS
 
 Another way to enter labels or values onto a sheet is to use the Fill feature. You can copy (fill) an entry into surrounding cells. For example, suppose you have a list of salespeople on a worksheet, and they will each get a $100 bonus. You can enter the 100 once and then use the Fill feature to insert multiple copies of 100 into nearby cells. To use the Fill feature for copying, follow these steps: 1. Click the fill handle of the cell (the small block in the lower-
 
 right corner of the cell) that holds the data that you want to copy (see Figure 12.5). 2. Drag the fill handle down or to the right to copy the data to
 
 adjacent cells. A data tag appears to let you know exactly what data is being copied into the cells. 3. Release the mouse button. The data is “filled” into the
 
 selected cells. When you release the mouse, a shortcut box for Fill options appears at the end of the cells that you filled. Copy Cells is the default option for the Fill feature, so you can ignore the shortcut box for the moment. It does come into play when you enter a series in the next section.
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 FIGURE 12.5 Drag the fill handle to copy the contents of a cell into neighboring cells.
 
 CAUTION Watch That Fill! The data you’re copying replaces any existing data in the adjacent cells that you fill.
 
 ENTERING A SERIES OTHER DATA
 
 OF
 
 NUMBERS, DATES,
 
 AND
 
 Entering a value series (such as January, February, and March or 1, 2, 3, 4, and so on) is accomplished using the Fill feature discussed in the preceding section. When you use the Fill feature, Excel looks at the cell holding the data and tries to determine whether you want to just copy that information into the adjacent cells or use it as the starting point for a particular series of data. For example, with Monday entered in the first cell of the series, Excel automatically inserts Tuesday, Wednesday, and so on into the adjacent cells when you use the Fill feature. Sometimes, Excel isn’t quite sure whether you want to copy the data when you use Fill or create a series. This is where the Fill options shortcut box comes in. It enables you to select how the Fill feature should treat the data that you have “filled” into the adjacent cells. Figure 12.6 shows the creation of a day series using Fill.
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 FIGURE 12.6 Fill also can be used to create a series of data in adjacent cells.
 
 When you create a series using Fill, the series progresses by one increment. For example, a series starting with 1 would proceed to 2, 3, 4, and so on.
 
 TAKING ADVANTAGE
 
 OF
 
 AUTOCOMPLETE
 
 Another useful feature that Excel provides to help take some of the drudgery out of entering information into a workbook is the AutoComplete feature. Excel keeps a list of all the labels that you enter on a worksheet by column. For example, suppose you have a worksheet tracking sales in Europe and you are entering country names, such as Germany, Italy, and so on, multiple times into a particular column in the worksheet. After you enter Germany the first time, it becomes part of the AutoComplete list for that column. The next time you enter the letter G into a cell in that column, Excel completes the entry as “Germany.” You also can select an entry from the AutoComplete list. This allows you to see the entire list of available entries. Follow these steps: 1. Enter your text and value data as needed onto the worksheet. 2. If you want to select a text entry from the AutoComplete list to
 
 fill an empty cell, right-click that cell. A shortcut menu appears. 3. Select Pick from List from the shortcut menu. A list of text
 
 entries (in alphabetical order) appears below the current cell. 4. Click a word in the list to insert it into the current, empty cell.
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 In this lesson, you learned how to enter different types of data and how to automate data entry with features such as AutoComplete. In the next lesson, you learn how to perform simple calculations in a workbook.
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 Performing Simple Calculations in Excel In this lesson, you learn how to use formulas to calculate results in your worksheets.
 
 UNDERSTANDING EXCEL FORMULAS One way to add calculations to an Excel workbook is to create your own formulas. Formulas typically are used to perform calculations such as addition, subtraction, multiplication, and division. More complex calculations are better left to Excel Functions, which is a built-in set of formulas that provide financial, mathematical, and statistical calculations. You learn more about functions in Lesson 14, “Performing Calculations with Functions.” Formulas that you create typically include cell addresses that reference cells on which you want to perform a calculation. Formulas also consist of mathematical operators, such as + (addition) or * (multiplication). For example, if you wanted to multiply two cells, such as C3 and D3, and then divide the product by 3, you would design a formula that looks like this: =(C3*D3)/3
 
 Notice that the formula begins with the equal sign (=). This lets Excel know that the information that you are placing in the cell is meant to do a calculation. The parentheses are used to let Excel know that you want C3 multiplied by D3 before the result is divided by 3. Creating appropriate formulas requires an understanding of the order of mathematical operations, or what is often called the rules of precedence. The natural order of math operations is covered in the next section.
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 As previously mentioned, you can create formulas that add, subtract, and multiply cells in the worksheet. Table 13.1 lists some of the operators that you can use and how you would use them in a simple formula. Table 13.1
 
 Excel’s Mathematical Operators
 
 Operator
 
 Performs
 
 Sample Formula
 
 Result
 
 ^
 
 Exponentiation
 
 =A1^3
 
 Enters the result of raising the value in cell A1 to the third power
 
 +
 
 Addition
 
 =A1+A2
 
 Enters the total of the values in cells A1 and A2
 
 –
 
 Subtraction
 
 =A1–A2
 
 Subtracts the value in cell A2 from the value in cell A1
 
 *
 
 Multiplication
 
 =A2*A3
 
 Multiplies the value in cell A2 by cell A3
 
 /
 
 Division
 
 =A1/B1
 
 Divides the value in cell A1 by the value in cell B1
 
 Figure 13.1 shows some formulas that have been created for an Excel worksheet. So that you can see how I wrote the formulas, I’ve configured Excel so that it shows the formula that has been placed in a cell rather than the results of the formula (which is what you would normally see).
 
 14 6602 ch13
 
 11/8/01
 
 2:34 PM
 
 Page 141
 
 Performing Simple Calculations in Excel
 
 FIGURE 13.1 You can create formulas to do simple calculations in your worksheets.
 
 ORDER
 
 OF
 
 OPERATIONS
 
 The order of operations, or operator precedence, simply means that some operations take precedence over other operations in a formula. For example, in the formula =C2+D2*E2, the multiplication of D2 times E2 takes precedence, so D2 is multiplied by E2 and then the value in cell C2 is added to the result. You can force the precedence of an operation by using parentheses. For example, if you want C2 and D2 added before they are multiplied by E2, the formula would have to be written =(C2+D2)*E2. The natural order of math operators follows: 1st
 
 Exponent (^) and calculations within parentheses
 
 2nd
 
 Multiplication (*) and division (/)
 
 3rd
 
 Addition (+) and subtraction (–)
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 In the case of operations such as multiplication and division, which operate at the same level in the natural order, a formula containing the multiplication operator followed by the division operator will execute these operators in the order they appear in the formula from left to right. If you don’t take this order into consideration, you could run into problems when entering your formulas. For example, if you want to determine the average of the values in cells A1, B1, and C1, and you enter =A1+B1+C1/3, you’ll get the wrong answer. The value in C1 will be divided by 3, and that result will be added to A1+B1. To determine the total of A1 through C1 first, you must enclose that group of values in parentheses: =(A1+B1+C1)/3.
 
 ENTERING FORMULAS You can enter formulas in one of two ways: by typing the entire formula, including the cell addresses, or by typing the formula operators and selecting the cell references. Take a look at both ways. To type a formula, perform the following steps: 1. Select the cell where you will place the formula. 2. Type an equal sign (=) into the cell to begin the formula. 3. Enter the appropriate cell references and operators for the
 
 formula. Figure 13.2 shows a simple multiplication formula. The formula also appears in the Formula bar as you type it. The cells that you specify in the formula are highlighted with a colored border. 4. Press Enter when you have finished the formula, and Excel
 
 calculates the result. TIP Unwanted Formula If you start to enter a formula and then decide you don’t want to use it, you can skip entering the formula by pressing Esc.
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 FIGURE 13.2 The formula appears in the cell and in the Formula bar as you type it.
 
 To enter a formula by selecting cell addresses, follow these steps: 1. Click in the cell where you will place the formula. 2. Type the equal sign (=) to begin the formula. 3. Click the cell whose address you want to appear first in the
 
 formula. You also can click a cell in a different worksheet or workbook. The cell address appears in the cell and in the Formula bar. 4. Type a mathematical operator after the value to indicate the
 
 next operation you want to perform. The operator appears in the cell and in the Formula bar. 5. Continue clicking cells and typing operators until the formula
 
 is complete. 6. Press Enter to accept the formula and have Excel place its
 
 results into the cell. CAUTION Error! If ERR appears in a cell, you’ve likely made a mistake somewhere in the formula. Be sure you did not commit one of these common errors: dividing by zero, using a blank cell as a divisor, referring to a blank cell, deleting a cell used in a formula, or including a reference to the same cell in which the formula appears.
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 TIP Natural Language Formulas Excel also enables you to create what are called Natural Language formulas. You can refer to a cell by its column heading name and the corresponding row label. For example, if you had a column labeled Total and a column labeled Discount for each customer, you can write a formula such as =Smith Total–Smith Discount. You are referring to cells by the labels that you have placed in the worksheet rather than the actual cell addresses.
 
 USING
 
 THE
 
 STATUS BAR AUTOCALCULATE FEATURE
 
 Using a feature that Excel calls AutoCalculate, you can view the sum of a column of cells simply by selecting the cells and looking at the status bar. The values in the selected cells are added. You also can right-click the AutoCalculate area of the status bar and choose different formulas, such as average, minimum, maximum, and count. This feature is useful if you want to quickly check the total for a group of cells or compute the average. It also allows you to “try out” an Excel function (discussed in Lesson 5) before actually entering it into a cell. You also can view the average, minimum, maximum, and count of a range of cells. To display something other than the sum, highlight the group of cells on which you want the operation performed, right-click the status bar, and select the option you want from the shortcut menu that appears (see Figure 13.3). TIP Where’s the Status Bar? If the status bar is not visible on your screen, you can display it by selecting the View menu and then selecting Status Bar.
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 FIGURE 13.3 You can view the results of different built-in formulas in the status bar.
 
 EDITING FORMULAS Editing a formula is the same as editing any entry in Excel. The following steps show how to do it: 1. Select the cell that contains the formula you want to edit. 2. Click in the Formula bar to place the insertion point in the
 
 formula, or press F2 to enter Edit mode (the insertion point is placed at the end of the entry in that cell). TIP In-Cell Editing To quickly edit the contents of a cell, double-click the cell. The insertion point appears inside the cell, and you can make any necessary changes.
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 3. Press the left-arrow key or the right-arrow key to move the
 
 insertion point within the formula. Then, use the Backspace key to delete characters to the left, or use the Delete key to delete characters to the right. Type any additional characters. 4. When you finish editing the data, click the Enter button on
 
 the Formula bar or press Enter to accept your changes. In this lesson, you learned how to enter and edit formulas. In the next lesson, you learn how to use functions for calculations in a worksheet.
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 Performing Calculations with Functions In this lesson, you learn how to perform calculations with functions and how to use the Insert Function feature to quickly insert functions into your worksheets.
 
 WHAT ARE FUNCTIONS? You already learned in Lesson 13, “Performing Simple Calculations in Excel,” how to create your own formulas in Excel. When you work with more complex calculations, you are better off using Excel’s builtin formulas—functions. Functions are ready-made formulas that perform a series of operations on a specified range of values. For example, to determine the sum of a series of numbers in cells A1 through H1, you can enter the function =SUM(A1:H1). Excel functions can do all kinds of calculations for all kinds of purposes, including financial and statistical calculations. Every function consists of the following three elements: • The = sign, which indicates that what follows is a function (formula). • The function name, such as SUM, which indicates the operation to be performed. • A list of cell addresses, such as (A1:H1), which are to be acted upon by the function. Some functions can include more than one set of cell addresses, which are separated by commas (such as A1,B1,H1).
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 You can enter functions into the worksheet by typing the function and cell references (as you did with your own formulas), or you can use the Insert Function feature, which walks you through the process of creating a function in a worksheet (you will work with the Insert Function feature in a moment). Table 14.1 lists some of the Excel functions that you probably will use most often in your worksheets. Table 14.1
 
 Commonly Used Excel Functions
 
 Function
 
 Example
 
 Description
 
 AVERAGE
 
 =AVERAGE(B4:B9)
 
 Calculates the mean or average of a group of cell values.
 
 COUNT
 
 =COUNT(A3:A7)
 
 Counts the number of cells that hold values in the selected range or group of cells. This also can be used to tell you how many cells are in a particular column, which tells you how many rows are in your spreadsheet.
 
 IF
 
 =IF(A3>=1000, ”BONUS”, ”NO BONUS”)
 
 Allows you to place a conditional function in a cell. In this example, if A3 is greater than or equal to 1000, the true value, BONUS, is used. If A3 is less than 1000, the false value, NO BONUS, is placed in the cell.
 
 MAX
 
 =MAX(B4:B10)
 
 Returns the maximum value in a range of cells.
 
 MIN
 
 =MIN(B4:B10)
 
 Returns the minimum value in a range of cells.
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 Table 14.1
 
 (continued)
 
 Function
 
 Example
 
 Description
 
 PMT
 
 =PMT Calculates the monthly pay (.0825/12,360,180000) ment on a 30-year loan (360 monthly payments) at 8.25% a year (.0825/12 a month) for $180,000.
 
 SUM
 
 =SUM(A1:A10)
 
 Calculates the total in a range of cells.
 
 TIP Specify Text with Quotation Marks When entering text into a function, the text must be enclosed within quotation marks. For example, in the function =IF(A5>2000, ”BONUS”, ”NO BONUS”), if the condition is met (the cell value is greater than 2000), the word BONUS will be returned by the function. If the condition is not met, the phrase NO BONUS will be returned in the cell by the function.
 
 Excel provides a large number of functions listed by category. There are Financial functions, Date and Time functions, Statistical functions, and Logical functions (such as the IF function described in Table 6.1). The group of functions that you use most often depends on the type of worksheets you typically build. For example, if you do a lot of accounting work, you will find that the Financial functions offer functions for computing monthly payments, figuring out the growth on an investment, and even computing the depreciation on capital equipment. Although some commonly used functions have been defined in Table 14.1, as you become more adept at using Excel, you might want to explore some of the other functions available. Select Help, Microsoft Excel Help. On the Contents tab of the Help window, open the Function Reference topic. Several subtopics related to Excel functions and their use are provided.
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 USING AUTOSUM Adding a group of cells probably is one of the most often-used calculations in an Excel worksheet. Because of this fact, Excel makes it very easy for you to place the SUM function into a cell. Excel provides the AutoSum button on the Standard toolbar. AutoSum looks at a column or row of cell values and tries to select the cells that should be included in the SUM function. To use AutoSum, follow these steps: 1. Select the cell where you want to place the SUM function.
 
 Typically, you will choose a cell that is at the bottom of a column of values or at the end of a row of data. This makes it easy for AutoSum to figure out the range of cells that it should include in the SUM function. 2. Click the AutoSum button on the Standard toolbar. AutoSum
 
 inserts =SUM and the cell addresses that it thinks should be included in the function (see Figure 14.1).
 
 FIGURE 14.1 AutoSum inserts the SUM function and selects the cells that will be totaled by the function.
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 3. If the range of cell addresses that AutoSum selected is incor-
 
 rect, use the mouse to drag and select the appropriate group of cells. 4. Press the Enter key. AutoSum calculates the total for the
 
 selected range of cells. TIP Quick AutoSum To bypass the step where Excel displays the SUM formula and its arguments in the cell, select the cell in which you want the sum inserted and double-click the AutoSum button on the Standard toolbar.
 
 USING
 
 THE INSERT
 
 FUNCTION FEATURE
 
 After you become familiar with a function or a group of functions, you place a particular function in an Excel worksheet by typing the function name and the cells to be referenced by the function (the same as you have done for formulas that you create). However, when you are first starting out with functions, you will find it much easier to create them using the Insert Function feature. The Insert Function feature leads you through the process of inserting a function and specifying the appropriate cell addresses in the function. For example, suppose you want to compute the average, maximum, and minimum of a group of cells that contain the weekly commissions for your sales force. Figure 14.2 shows how these three functions would look on a worksheet (the display has been changed in Excel to show you the functions rather than their results). You could use the Insert Function feature to create any or all of these functions.
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 FIGURE 14.2 Functions can be placed into a worksheet using the Insert Function feature.
 
 To use the Insert Function feature, follow these steps: 1. Click in the cell where you want to place the function. 2. Click the Insert Function button on the Formula bar. The
 
 Insert Function dialog box appears (see Figure 14.3). 3. To search for a particular function, type a brief description
 
 of what you want to do in the Search for a Function box (for example, you could type monthly payment and Excel would show you financial functions that help you calculate monthly payments), and then click Go to conduct the search. You also can select a function category, such as Financial or Statistical, using the Select a Category dropdown box. In either case, a list of functions is provided in the Select a Function dialog box.
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 FIGURE 14.3 The Insert Function dialog box helps you select the function you want to use.
 
 TIP Recently Used Functions The Insert Function dialog box by default lists the functions that you have used most recently.
 
 4. From the Functions list, select the function you want to
 
 insert. Then click OK. The Function Arguments dialog box appears. This dialog box allows you to specify the range of cells (some functions require multiple ranges of cells) that the function acts upon (see Figure 14.4).
 
 FIGURE 14.4 The Function Arguments dialog box is where you specify the cells that will be acted upon by the function. The argument specified in this case is for the Maximum function.
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 5. Next, you must enter the range of cells that will be acted
 
 upon by the function. Click the Collapse button on the far right of the Number1 text box in the Function Arguments dialog box. This returns you to the worksheet. 6. Use the mouse to select the cells that you want to place in the
 
 function (see Figure 14.5). Then click the Expand button on the right of the Function Arguments dialog box.
 
 FIGURE 14.5 The Function Arguments collapses and allows you to select the cells that will be acted upon by the function.
 
 7. Click OK. Excel inserts the function and cell addresses for
 
 the function into the selected cell and displays the result. If you find that you would like to edit the list of cells acted upon by a particular function, select the cell that holds the function and click the Insert Function button on the Formula bar. The Function Arguments
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 dialog box for the function appears. Select a new range of cells for the function, as discussed in steps 4 and 5. TIP What’s This Function? If you’d like to know more about a particular function, click the Help on This Function link at the bottom of the Function Arguments dialog box. The Help window will open with help on this specific function.
 
 In this lesson, you learned the basics of working with functions, and you learned how to use Excel’s Insert Function feature to quickly enter functions. You also learned how to quickly total a series of numbers with the AutoSum tool. In the next lesson, you learn how to create an Excel chart.
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 Creating Charts In this lesson, you learn how to create graphical representations (charts) of workbook data.
 
 UNDERSTANDING CHARTING TERMINOLOGY Charts enable you to create a graphical representation of data in a worksheet. You can use charts to make data more understandable to people who view your printed worksheets. Before you start creating charts, you should familiarize yourself with the following terminology: • Data Series—The bars, pie wedges, lines, or other elements that represent plotted values in a chart. For example, a chart might show a set of similar bars that reflects a series of values for the same item. The bars in the same data series all would have the same pattern. If you had more than one pattern of bars, each pattern would represent a separate data series. For example, charting the sales for Territory 1 versus Territory 2 would require two data series—one for each territory. Often, data series correspond to rows of data in your worksheet (although they can correspond to columns of data if that is how you have arranged the information in your worksheet). • Categories—Categories reflect the number of elements in a series. You might have two data series that compare the sales of two territories and four categories that compare these sales over four quarters. Some charts have only one category, and others have several. Categories normally correspond to the columns in your worksheet, with the category labels coming from the column headings.
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 • Axis—One side of a chart. A two-dimensional chart has an x-axis (horizontal) and a y-axis (vertical). The x-axis contains the data series and categories in the chart. If you have more than one category, the x-axis often contains labels that define what each category represents. The y-axis reflects the values of the bars, lines, or plot points. In a three-dimensional chart, the z-axis represents the vertical plane, and the x-axis (distance) and y-axis (width) represent the two sides on the floor of the chart. • Legend—Defines the separate series of a chart. For example, the legend for a pie chart shows what each piece of the pie represents. • Gridlines—Typically, gridlines appear along the y-axis of the chart. The y-axis is where your values are displayed, although they can emanate from the x-axis as well (the x-axis is where label information normally appears on the chart). Gridlines help you determine a point’s exact value.
 
 WORKING
 
 WITH
 
 DIFFERENT CHART TYPES
 
 With Excel, you can create many types of charts. Some common chart types appear in Figure 15.1. The chart type you choose depends on the kind of data you’re trying to chart, and how you want to present that data. The following are the major chart types and their purposes: • Pie—Use this chart type to show the relationship among parts of a whole. • Bar—Use this chart type to compare values at a given point in time. • Column—Similar to the bar chart. Use this chart type to emphasize the difference between items. • Line—Use this chart type to emphasize trends and the change of values over time.
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 • Scatter—Similar to a line chart. Use this chart type to emphasize the difference between two sets of values. • Area—Similar to the line chart. Use this chart type to emphasize the amount of change in values over time.
 
 FIGURE 15.1 Excel chart types enable you to analyze and present your data.
 
 Most of these basic chart types also come in three-dimensional varieties. In addition to looking more professional than the standard flat charts, 3D charts often can help your audience distinguish between different sets of data.
 
 CREATING
 
 AND
 
 SAVING
 
 A
 
 CHART
 
 You can place your new chart on the same worksheet that contains the chart data (an embedded chart) or on a separate worksheet (a chart sheet). If you create an embedded chart, it typically is printed side by
 
 16 6602 ch15
 
 11/8/01
 
 2:27 PM
 
 Page 159
 
 Creating Charts
 
 side with your worksheet data. Embedded charts are useful for showing the actual data and its graphical representation side by side. If you create a chart on a separate worksheet, however, you can print it independently. Both types of charts are linked to the worksheet data that they represent, so when you change the data, the chart is updated automatically. The Chart Wizard button on the Standard toolbar enables you to quickly create a chart. To use the Chart Wizard, follow these steps: 1. Select the data you want to chart. If you typed column or row
 
 labels (such as Qtr 1, Qtr 2, and so on) that you want included in the chart, be sure you select those, too. 2. Click the Chart Wizard button on the Standard toolbar. 3. The Chart Wizard - Step 1 of 4 dialog box appears (see
 
 Figure 15.2). Select a Chart Type and a Chart Sub-Type (a variation on the selected chart type). Click Next.
 
 FIGURE 15.2 Choose the chart type using the Chart Wizard.
 
 4. Next, Excel asks whether the selected range is correct. You
 
 can correct the range by typing a new range or by clicking the Shrink button (located at the right end of the Data Range text box) and selecting the range you want to use.
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 5. By default, Excel assumes that your different data series are
 
 stored in rows. You can change this to columns, if necessary, by clicking the Series in Columns option. When you’re ready for the next step, click Next. 6. Click the various tabs to change options for your chart (see
 
 Figure 15.3). For example, you can delete the legend by clicking the Legend tab and deselecting Show Legend. You can add a chart title on the Titles tab. Add data labels (labels that display the actual value being represented by each bar, line, and so on) by clicking the Data Labels tab. When you finish making changes, click Next.
 
 FIGURE 15.3 Select from various chart appearance options.
 
 7. Finally, Excel asks whether you want to embed the chart (as
 
 an object) in the current worksheet (or any other existing worksheet in the workbook) or if you want to create a new worksheet for it. Make your selection and click the Finish button. Your completed chart appears. TIP Create a Chart Fast! To create a chart quickly, select the data you want to use and press F11. Excel creates a column chart (the default chart type) on its own sheet. You then can customize the chart as needed.
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 The charts you create are part of the current workbook. To save a chart, simply save the workbook that contains the chart.
 
 MOVING
 
 AND
 
 RESIZING
 
 A
 
 CHART
 
 To move an embedded chart, click anywhere in the chart area and drag it to the new location. To change the size of a chart, select the chart and drag one of its handles (the black squares that border the chart). Drag a corner handle to change the height and width, or drag a side handle to change only one dimension. (Note that you can’t really resize a chart that is on a sheet by itself.)
 
 PRINTING
 
 A
 
 CHART
 
 If a chart is an embedded chart, it will print when you print the worksheet that contains the chart. If you want to print just the embedded chart, click it to select it, and then open the File menu and select Print. Be sure the Selected Chart option is turned on. Then, click OK to print the chart. If you created a chart on a separate worksheet, you can print the chart separately by printing only that worksheet. In this lesson, you learned about the different chart types and how to create them. You also learned how to save and print charts. In the next lesson, you will learn how to create an Access database.
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 Creating a New Database In this lesson, you learn how to create a blank database. You also learn how to create a new database using a database template and the Database Wizard. In addition, you learn how to close your database, open it, and how to find a misplaced database file.
 
 CHOOSING HOW
 
 TO
 
 CREATE YOUR DATABASE
 
 Before you can create the tables that will hold your data in Access and actually enter data, you must create a database file. The database is really just a container file that holds all the database objects, such as the tables, forms, and reports. You also have two options for creating a new database: You can create a blank database from scratch or create a new database based on a database template. Creating a new database based on a template means that you take advantage of the Database Wizard, which not only creates your new database file but also helps you quickly create tables, forms, and other objects for the database. TIP Database Wizard Access provides several templates for creating new database files, and the Database Wizard walks you through the process of creating objects, such as tables, for the new database.
 
 Whether you create your new database from scratch or use one of the database templates depends on how closely one of the Access templates
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 meets your database needs. If one of the templates provides you with the type of tables and other objects necessary for your project, it makes sense to use a template. For example, if you want to create a database that helps you manage your company’s inventory, you can take advantage of the Inventory Control template that Access provides. This template provides you with the basic tables and other objects to start the process of getting a handle on your inventory database. In some cases, the templates might not meet your needs. For example, if you want to create a complex database that allows you to track sales, customers, and employee performance, it might be easier to create a blank database and then create each table for the database from scratch. Let’s start the overview of database creation with creating a blank database.
 
 SELECTING
 
 A
 
 DATABASE FILE TYPE
 
 One thing to discuss before you look at creating a new database is the database file format. By default, new databases created in Access 2002 are created in the Access 2000 file format. This makes your database files compatible with earlier versions of Access, such as Access 2000 and Access 97. Saving the database in the Access 2000 file format does not negate you from using any of the tools or features available in Access 2002. If you use your database files only in Access 2002 and share the databases with co-workers who also use Access 2002, you can set the default file format for new databases to Access 2002. Select the Tools menu, and then select Options. The Options dialog box opens. Select the Advanced tab on the Options dialog box. Click the Default File Format drop-down box and select Access 2002. Now take a look at creating new databases.
 
 CREATING
 
 A
 
 BLANK DATABASE
 
 Creating a blank database is very straightforward. As mentioned previously, you are just creating the container file that holds all the objects
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 that actually make up the database. To create a blank database, follow these steps: 1. Open the Access window (click Start, Programs, Access). 2. Select Blank Database in the task pane or click the New but-
 
 ton on the Database toolbar. The File New Database dialog box appears (see Figure 16.1).
 
 FIGURE 16.1 Provide a location and a name for the new database file.
 
 3. Use the Save In drop-down box to locate the folder in which
 
 you want to save the new database. Type a name for the new file into the File Name text box. 4. When you are ready to create the database file, click Create.
 
 The new database window appears in the Access workspace (see Figure 16.2). The database window provides you with a set of icons that allows you to select a particular object type. For example, the Tables icon is selected by default after you create the new database (which makes sense, because you need to create at least one table before you can create any of the other object types such as a form or a report).
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 Object icons
 
 Object pane
 
 FIGURE 16.2 A new database window opens in Access.
 
 Shortcuts for different methods of creating tables are provided at the top of the Object pane on the right side of the database window. After you create a new table for the database, it is listed in this pane. The database window enables you to view the different objects that you’ve created for a particular database (or those that have been created when you use the Database Wizard). When you want to switch the database window’s focus to a different Access object, all you have to do is click the appropriate icon in the Objects list. TIP Different Ways to View the Database Windows The toolbar on the database window provides buttons for opening or creating a particular database object, such as a table or a form. The toolbar also provides buttons that can be used to change the view in the Object pane: Large Icons, Small Icons, List (the default view) and Details (which provides information such as when the object was last modified).
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 CLOSING
 
 A
 
 DATABASE
 
 When you finish working with a database, you might want to close it so that you can concentrate on creating a new database (such as you do in the next section). However, because Access allows you to have only one database open at a time, as soon as you begin creating a new database the currently open database closes. Opening an existing database also closes the current database (which is something you do later in this lesson). If you want to close a database, there are a couple of possibilities: you can click the Close (X) button on the database window, or you can select File, Close. In either case, the database window closes, clearing the Access workspace.
 
 CREATING
 
 A
 
 DATABASE
 
 FROM A
 
 TEMPLATE
 
 Another option for creating a new database is using one of the Access database templates. Templates are available for asset tracking, contact management, inventory control, and other database types. Another perk of using an Access template to create a new database is that a Database Wizard creates tables and other objects, such as forms and reports, for the new database. The wizard also sets up the relationships between the various tables (making your database relational). Your interaction with the Database Wizard is somewhat limited; the wizard allows you to select the fields that will be used in the tables that it creates for the database. However, you don’t have a say about which tables are initially created (tables can always be deleted later if you don’t need them). You are, however, given the opportunity to select the format for screen displays (for forms and reports) and to select the format for printed reports. To create a database from a template, follow these steps: 1. In the Access window, click General Templates on the task
 
 pane. If the task pane is not currently in the Access window, select File, New to open it.
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 TIP Opening the Task Pane When you are working on a particular database and want to open the task pane, select the View menu, point at Toolbars, and then select Task Pane.
 
 2. The Templates dialog box appears. If necessary, click the
 
 Databases tab on the dialog box to view the database templates (see Figure 16.3).
 
 FIGURE 16.3 Access provides several database templates.
 
 3. Click the database template you want to use (for example, the
 
 Contact Management template) and then click OK. The File New Database dialog box appears. 4. Specify a location for the database using the Save In drop-
 
 down list, type a name for the database, and then click Create to continue. A new database file is created, and then the Database Wizard associated with the template starts. For example, if you chose the Contact Management template, the wizard appears and explains the type of information that the database holds.
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 5. To move past the wizard’s opening screen, click Next. On the
 
 next screen, a list of the tables that will be created appears (see Figure 16.4). The tables in the database are listed on the left of the screen and the selected table’s fields appear on the right.
 
 FIGURE 16.4 You can examine and deselect (or select) the fields that will be contained in each table.
 
 6. Select a table to examine its fields. If you do not want to
 
 include a field in the table, clear the check box next to the field name. Optional fields are also listed for each field and are shown in italic. To include an optional field, click it to place a check mark next to it. When you have finished viewing the tables and their fields, click Next to continue. CAUTION Be Careful Deselecting Fields! Because you are stuck with the tables that the Database Wizard creates, you must be very careful removing fields from the tables. This is especially true of fields that uniquely identify the records in a table, such as Contact ID. These fields are often used to relate the tables in the database. You might want to leave all the fields alone initially when you use the wizard.
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 7. The next screen asks you to select the screen display style
 
 you want to use. This affects how forms appear on the screen. Click a display style in the list to preview the style; after selecting the style you want to use, click Next. 8. On the next screen, the wizard asks you for a style for your
 
 printed reports. Click a report style and examine the preview of it. When you decide on a style, click it, and then click Next. TIP Report Background The colored backgrounds used for some report styles look nice onscreen, but they don’t print well on a black-and-white printer. Unless you have access to a color printer, stick to plain backgrounds for the best report printouts.
 
 9. On the next wizard screen, you are asked to provide a title for
 
 the database. This title appears on reports and can be different from the filename. Enter a title as shown in Figure 16.5.
 
 FIGURE 16.5 Enter a title for the database, and as an option, choose a graphic to use for a logo.
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 10. (Optional) To include a picture on your forms and reports
 
 (for example, your company’s logo), click the Yes, I’d Like to Include a Picture check box. Then click the Picture button, choose a picture file from your hard drive (or other source), and click OK to return to the wizard. 11. Click Next to continue. You are taken to the last wizard
 
 screen; click Finish to open the new database. The wizard goes to work creating your database and its database objects. When the wizard has finished creating the database, the database’s Main Switchboard window appears (see Figure 16.6). The Main Switchboard opens automatically whenever you open the database.
 
 FIGURE 16.6 The Switchboard window is a database navigation tool provided by the Database Wizard.
 
 All the databases created using one of the Access templates (other than the Blank Database template) include a Main Switchboard. The Switchboard is nothing more than a fancy form with some programming built in to it. It enables you to perform common tasks related to database management by clicking a button. It is very useful when a person is unfamiliar with how to manipulate the various objects in a database.
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 Using the Main Switchboard is pretty much self-explanatory. After you become familiar with Access, you probably won’t even use it. To close the Switchboard, click its Close (X) button. TIP I Hate That Switchboard! To prevent the Switchboard from opening when you open the database, choose Tools, Startup. In the Startup dialog box, select the Display Form/Page drop-down list and select [None]. Click OK.
 
 After you close the Switchboard window, you will find that the database window has been minimized in the Access workspace. Just double-click its title bar (at the bottom-left corner of the screen) to open it. To see the tables that the wizard created, click the Tables object type. Click the other object types (such as forms) to see the other objects that were created by the wizard. The tables that the wizard creates are, of course, empty. After you fill them with data (either inputting the data directly into the table or using a form), you will be able to run queries and create reports.
 
 OPENING
 
 A
 
 DATABASE
 
 You have already taken a look at how to close a database; next, you walk through the process of opening a database file. The next time you start Access or after you finish working with another database, you need to know how to open your other database files. One of the easiest ways to open a database you’ve recently used is to select it from the File menu. Follow these steps: 1. Open the File menu. You’ll see up to four databases that
 
 you’ve recently used listed at the bottom of the menu. 2. If the database you need is listed there, click it.
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 TIP Want to See More Files? To increase the number of files displayed in this list, open the Tools menu and select Options. Then, from the General tab of the Options dialog box, select a number from 1 to 9 (the default is 4) in the Recently Used Files drop-down list.
 
 A list of recently used databases also appears on the tip of the Access task pane. You can open any of the files by clicking the filename (to open the task pane, select View, Toolbars, Task Pane). If a file you want to open is not listed either on the File menu or the task pane, you can open it using the Open command. Follow these steps: 1. Select File, Open, or click the toolbar’s Open button. The
 
 Open dialog box appears. 2. If the file isn’t in the currently displayed folder, use the Look
 
 In drop-down list to access the correct drive, and then double-click folders displayed in the dialog box to locate the file. 3. When you have located the database file, double-click the file
 
 to open it. In this lesson, you learned how to create a database from scratch and how to create a database from a template. You also learned how to close and open a database. In the next lesson, you learn how to create a table using the Table Wizard.
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 Creating an Access Table In this lesson, you learn how to create a table by using the Table Wizard and from scratch.
 
 TABLES ARE ESSENTIAL Access tables really provide the essential framework for your database. Tables not only hold the data that you enter into the database, but they are designed so that relationships can be established between the various tables in the database. Tables can be created from scratch, as discussed in the next lesson, or they can be created using the Table Wizard.
 
 WORKING
 
 WITH THE
 
 TABLE WIZARD
 
 The Table Wizard can save you a lot of time by supplying you with all the needed fields and field formats for entering your database information. Access provides a large number of different kinds of tables that you can create with the wizard. The wizard is also fairly flexible, allowing you to select the fields the table will contain and the way in which they will be arranged. You can also change the name of a field during the process. To create a table using the Table Wizard, follow these steps: 1. In the database window, click the Tables object icon, and
 
 then double-click Create Table by Using Wizard. The Table Wizard opens.
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 TIP Alternative Routes You can also start the Table Wizard by clicking the New button in the database window or choosing Insert, Table. In both cases, the New Table dialog box opens. Then, choose Table Wizard and click OK.
 
 2. On the first Table Wizard screen, you can select from two cate-
 
 gories of table types: Business or Personal. Your choice determines the list of sample tables that appears (see Figure 17.1).
 
 FIGURE 17.1 Select either the Business or Personal category to view a list of tables.
 
 3. Select a table in the Sample Tables list; its fields appear in
 
 the Sample Fields list. 4. To include a field from the Sample Fields list in the table,
 
 select the field and click the Add (>) button to move it to the Fields in My New Table list. You can include all the fields in Sample Fields list by clicking the Add All (>>) button. 5. If you want to rename a field that you have added, click the
 
 Rename Field button, type a new name into the Rename field box, and then click OK.
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 TIP Remove Unwanted Fields If you add a field that you don’t want in the table, select the field in the Fields in My New Table list and click the Remove () button. If you make a mistake, you can remove a field from the Selected Fields list by clicking it and then clicking either the Remove ( button. 5. (Optional) Select another table or query from the
 
 Tables/Queries list and add some of its fields to the Selected Fields list (this enables you to pull data from more than one table into the query). When you have finished adding fields, click Next. 6. On the next screen, enter a title for the query. Then, click
 
 Finish to view the query results. Figure 19.2 shows the results of a simple query.
 
 FIGURE 19.2 Queries created using the Simple Query Wizard list the data from the fields you selected.
 
 SAVING
 
 A
 
 QUERY
 
 When you create a query, Access saves it automatically. You don’t need to do anything special to save it. When you are finished viewing the results of the query, click its Close (X) button. The new query is then listed in the Query list that the database window provides.
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 RERUNNING
 
 A
 
 QUERY
 
 At any time, you can rerun your query. If the data has changed in the table fields that you included in a query, rerunning the query provides you with an updated set of results. To rerun a query, follow these steps: 1. Open the database containing the query. 2. Select the Queries icon in the database window. 3. In the Query list, double-click the query you want to run, or
 
 click it once and then click the Open button. TIP Queries Look Like Tables Queries can be manipulated in the Datasheet view just like a table. You can use the Sort and Filter features on a query, or you can delete records from the query.
 
 USING OTHER QUERY WIZARDS Access’s different query features are quite powerful; they can do amazingly complicated calculations and comparisons on data from several tables. Queries also can do calculations to summarize data or arrange the query data in a special format called a crosstab. Creating more advanced queries means that your database tables must be joined by the appropriate relationships; otherwise, the query cannot pull the data from multiple tables. You can create very complex queries from the Query Design view, which you learn about in the next lesson. However, Access also provides some wizards that can be used to create some of the more complex query types. These wizards include the following: • Crosstab Query Wizard—This wizard displays summarized values, such as sums, counts, and averages, from a field. One field is used on the left side of the Query
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 datasheet to cross-reference other field columns in the Query datasheet. For example, Figure 19.3 shows a Crosstab table that displays the different products that a customer has ordered, sorted on the customer’s first name.
 
 FIGURE 19.3 Crosstab queries allow you to cross-tabulate information between table fields.
 
 • Find Duplicates Query Wizard—This query is used to compare two tables and find duplicate records. • Find Unmatched Query Wizard—This wizard compares two tables and finds all records that don’t appear in both tables (based on comparing certain fields). You can access any of these query wizards from the database window. With the Query icon selected, click the New button on the database window toolbar. The New Query dialog box appears, as shown in Figure 19.4.
 
 FIGURE 19.4 The other query wizards can be accessed from the New Query dialog box.
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 Select the wizard that you want to use for your query and click OK. Work with the wizard as it walks you through the steps for creating your new query.
 
 UNDERSTANDING ACCESS QUERY TYPES Before this lesson ends, you should spend a little time learning about the different types of queries that Access offers. In this lesson, you created a select query that “selects” data from a table or tables based on your query criteria. You can also build other types of queries. The different query types are • Make Table Query—This type of query is similar to a select query, but it takes the data pulled together by the criteria and creates a new table for the database. • Update Query—This query updates field information in a record. For example, you might have placed a certain credit limit for customers and want to update it in all the records. You would use an Update query. • Append Query—This type of query is used to copy records from one table and place them (append them) into another table. For example, you might want to append employee records from an Active Employee table to a Former Employee table. • Delete Query—This type of query is used to delete records from a table. For example, you might want to delete old records from a table based on particular criteria. Now, you might be thinking that all these query types are a little too much to handle. However, you create different query types just as you would a select query.
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 As a matter of fact, you actually design each of these different query types as a select table (using a wizard, Query Design view, or a combination of both), and then you change the query type in the Query Design view. It’s just a matter of selecting the query type from the Query menu. In this lesson, you learned how to create a simple query. In the next lesson you learn how to create a PowerPoint Presentation.
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 Creating a New PowerPoint Presentation In this lesson, you learn several ways to create a presentation. You also learn how to save, close, and open an existing presentation.
 
 GETTING
 
 THE
 
 MOST OUT
 
 OF
 
 POWERPOINT 2002
 
 PowerPoint is a powerful presentation application that enables you to create presentations that can be viewed on a computer. Using PowerPoint, you can print handouts or create film slides for a presentation. PowerPoint also enables you to add animation and sound to your presentations, which makes it the perfect presentation tool for business presentations or classroom lectures. PowerPoint presentations are made up of individual slides. Each slide will contain a list of information, a chart, or an image that provides the viewer of the presentation with the appropriate information.
 
 THREE CHOICES
 
 FOR
 
 STARTING
 
 A
 
 NEW PRESENTATION
 
 PowerPoint offers several ways to create a new presentation. Before you begin, decide which method is right for you: • The AutoContent Wizard offers the highest degree of help. It walks you through each step of creating the new presentation. When you’re finished, you have a standardized group of slides, all with a similar look and feel, for a particular situation. Each slide created includes dummy text that you can replace with your own text.
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 • A design template provides a professionally designed color, background, and font scheme that applies to the slides you create yourself. It does not provide sample slides. • You can start from scratch and create a totally blank presentation. That means you build the presentation from the ground up and create each slide in the presentation (beginners might want to use the wizard or templates until they get a feel for the overall design approach used to create a cohesive slide presentation). PLAIN ENGLISH Design Template A design template is a preformatted presentation file (without any slides in it). When you select a template, PowerPoint applies the color scheme and general layout of the template to each slide you create for the presentation.
 
 CREATING
 
 A
 
 NEW PRESENTATION
 
 WITH THE
 
 AUTOCONTENT WIZARD
 
 With the AutoContent Wizard, you select the type of presentation you want to create (such as corporate, sales, or various projects), and PowerPoint creates an outline for the presentation. The following steps describe how you use the AutoContent Wizard: 1. Select the File menu and select New. The New Presentation
 
 task pane appears on the right of the PowerPoint window, as shown in Figure 20.1 (if the Presentation task pane was already open in the window, you can skip to step 2). 2. Click the From AutoContent Wizard link on the task pane. 3. The AutoContent Wizard starts. The opening wizard screen
 
 summarizes the process you should follow to create a new presentation. Click Next to continue. 4. The wizard provides you with category buttons for different
 
 categories of presentations: General, Corporate, Projects,
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 Sales/Marketing, and Carnegie Coach. Select a category by selecting the appropriate button (see Figure 20.2). To see all the presentations available, click the All button.
 
 FIGURE 20.1 Start the AutoContent Wizard from the task pane.
 
 FIGURE 20.2 Select a category button to view a list of presentation types.
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 PLAIN ENGLISH What Is the Carnegie Coach? The Carnegie Coach provides presentations that can be used to sell your ideas or motivate a team; they are named after Dale Carnegie, the motivational speaker and author.
 
 5. After selecting a particular category of presentations, select
 
 a presentation type in the list provided, and click Next to continue. 6. On the next screen, you select how you will give the presen-
 
 tation. Select one of the following options: • Onscreen Presentation—Choose this if you plan to use a computer and your PowerPoint file to present the show. • Web Presentation—Choose this if you are planning to distribute the presentation as a self-running or userinteractive show. • Black-and-White Overheads—Choose this if you plan to make black-and-white transparencies for your show. • Color Overheads—Choose this if you plan to make color transparencies for your show. • 35mm Slides—Choose this if you plan to send your PowerPoint presentation to a service bureau to have 35mm slides made. (You probably don’t have such expensive and specialized equipment in your own company.) 7. After selecting how you will give the presentation, click Next
 
 to continue.
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 8. On the next screen, type the presentation title into the text
 
 box provided (see Figure 20.3). If you want to add a footer (such as your name) that will appear at the bottom of each slide of the presentation, click in the Footer box and type the appropriate text. If you do not want a date and/or slide number on each slide, deselect the Date Last Updated and/or Slide Number check boxes.
 
 FIGURE 20.3 Provide a title for the presentation.
 
 9. After supplying the presentation title and any optional infor-
 
 mation, click Next to continue. 10. PowerPoint takes you to the last wizard screen, where you
 
 should simply click Finish. The title slide of your new presentation appears in the Slide pane. The entire presentation, including the dummy text placed on each slide, appears in the Outline pane on the left of the PowerPoint window (see Figure 20.4). You can start working on your presentation right away by replacing the dummy text on the slides with your own text. Just select the existing text in a text box and type right over it.
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 FIGURE 20.4 Your new presentation appears in the PowerPoint window.
 
 CREATING
 
 A
 
 NEW PRESENTATION
 
 WITH A
 
 DESIGN TEMPLATE
 
 A template is the middle ground between maximum hand-holding (the AutoContent Wizard) and no help at all (Blank Presentation). Two kinds of templates are available: presentation templates and design templates. When you use the AutoContent Wizard, you use a presentation template. It contains not only formatting, but also sample slides that contain placeholder text. The other kind of template is a design template. It contains the overall formatting for the slides of the presentation but does not actually create any slides. If you want to use a presentation template, use the AutoContent Wizard, as explained in the preceding section.
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 To start a new presentation using a design template, follow these steps: 1. Select the File menu and select New. The New Presentation
 
 task pane appears on the right of the PowerPoint window. TIP Select Your Task Pane If the task pane is already open for another PowerPoint feature, click the drop-down arrow on its title bar and select New Presentation from the list that appears.
 
 2. On the New Presentation task pane, click the From Design
 
 Template link. PowerPoint switches to the Slide Design side pane, which displays a list of design templates, as shown in Figure 20.5. A blank title slide for the presentation appears in the Slide pane.
 
 FIGURE 20.5 Design templates are listed in the task pane.
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 3. Click a template from the Available for Use section of the
 
 task pane. PowerPoint then formats the title slide in the Slide pane using the selected template. You can select different templates to determine the best look for your presentation. When you have found the design template that you want to use, you can immediately start working on the slides for the presentation. PLAIN ENGLISH The Next Step? Add more slides by clicking the New Slide button on the toolbar.
 
 CREATING
 
 A
 
 BLANK PRESENTATION
 
 Your third option for creating a new presentation is to create a blank presentation. This means that you have to create all the slides from scratch. You then can select a design for the slides using the Slide Design task pane. You open this task pane by selecting Format, Slide Design. In the Slide Design task pane, be sure that the Design Templates icon is selected. Creating a new, blank presentation takes only a click: Click the New button on the Standard toolbar or click the Blank Presentation link on the New Presentation task pane. The new presentation appears in the PowerPoint window. A blank title slide is ready for you to edit.
 
 SAVING
 
 A
 
 PRESENTATION
 
 After you create a new presentation, it makes sense to save it. To save a presentation for the first time, follow these steps: 1. Select File, Save, or just click the Save button on the
 
 Standard toolbar. The Save As dialog box appears (see Figure 20.6).
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 FIGURE 20.6 Type a name for your presentation into the Save As dialog box.
 
 2. In the File Name text box, type the name you want to assign
 
 to the presentation. Your filenames can be as long as 255 characters and can include spaces. 3. The Save In box shows in which folder the file will be saved.
 
 The default is My Documents. To select a different drive location for the file, click the Save In drop-down arrow and select one from the list that appears. To save to a specific folder in the drive location you’ve selected, double-click the folder in which you want to store the file. 4. Click Save.
 
 Now that you have named the file and saved it to a disk, you can save any changes you make simply by pressing Ctrl+S or clicking the Save button on the Standard toolbar. Your data is saved under the filename you assigned the presentation in the Save As dialog box. To create a copy of a presentation under a different filename or location, select File, Save As. The Save As dialog box reappears; follow steps 2 to 4 as discussed in this section to give the file a new name or location.
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 CLOSING
 
 A
 
 PRESENTATION
 
 You can close a presentation at any time. Note that although this closes the presentation window, it does not exit PowerPoint as with the methods discussed in Lesson 1. To close a presentation, follow these steps: 1. If more than one presentation is open, click a presentation’s
 
 button on the Windows taskbar to make it the active presentation, or select the Window menu and select the presentation from the list provided. 2. Select File and then select Close, or click the presentation’s
 
 Close (X) button. (It’s the lower of the two Close buttons; the upper one is for the PowerPoint window.) If you haven’t saved the presentation or if you haven’t saved since you last made changes, a dialog box appears, asking whether you want to save. 3. To save your changes, click Yes. If this is a new presentation
 
 that has never been saved, refer to the steps in the preceding section for saving a presentation. If you have saved the file previously, the presentation window closes.
 
 OPENING
 
 A
 
 PRESENTATION
 
 Because a presentation, like Rome, is not built in a day, you probably will fine-tune a presentation over time. To open a saved presentation file that you want to work on, follow these steps: 1. Select File, Open, or click the Open button on the Standard
 
 toolbar. The Open dialog box appears. 2. If the file isn’t in the currently displayed folder, select the
 
 Look In drop-down arrow to choose from a list of other drives and/or folders. 3. Browse to the location containing the file, and double-click it
 
 to open it in PowerPoint.
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 In this lesson, you learned how to create a new presentation. You also learned how to save, close, and open presentations. In the next lesson, you learn how to complete and show your presentation.
 
 22 6602 ch21
 
 11/8/01
 
 2:25 PM
 
 Page 207
 
 LESSON 21
 
 Completing Your PowerPoint Presentation In this lesson, you learn how to insert new slides and delete slides. You also learn how to complete your presentation and show your PowerPoint presentation on a computer.
 
 INSERTING
 
 A
 
 NEW SLIDE
 
 You can insert a slide into a presentation at any time and at any position in the presentation. To insert a new slide, follow these steps: 1. On the Outline or Slides panes, select the slide that appears
 
 just before the place you want to insert the new slide (you also can insert a new slide in the Slide Sorter view). 2. Choose the Insert menu and then New Slide, or click the
 
 New Slide button on the PowerPoint toolbar. A new blank slide appears in the PowerPoint window, along with the Slide Layout task pane (see Figure 21.1). 3. In the Slide Layout task pane, select the slide layout that you
 
 want to use for the new slide. Several text slide layouts and layouts for slides that contain graphics are provided. 4. Follow the directions indicated on the slide in the Slide pane
 
 to add text or other objects. For text boxes, click an area to select it and then type in your text. For other object placeholders, double-click the placeholder.
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 New Slide button
 
 FIGURE 21.1 Your new slide appears in the PowerPoint window.
 
 TIP Cloning a Slide To create an exact replica of an existing slide (in any view), select the slide you want to duplicate. Click Insert, and then select Duplicate Slide. The new slide is inserted after the original slide. You then can choose a different layout for the slide if you want.
 
 DELETING SLIDES You can delete a slide from any view. To delete a slide, perform the following steps: 1. Select the slide you want to delete. You can delete multiple
 
 slides by selecting more than one slide (on the Outline or Slides pane or in the Slide Sorter view; hold down the Ctrl key to select multiple slides).
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 2. Choose the Edit menu, and then choose Delete Slide. The
 
 slide is removed from the presentation. TIP Use the Delete Key You can quickly delete slides by selecting the slide or slides and then pressing the Delete key on the keyboard.
 
 CAUTION Oops! If you deleted a slide by mistake, you can get it back. Select Edit, Undo, or press Ctrl+Z. This works only if you do it immediately. You cannot undo the change if you exit PowerPoint and restart the application.
 
 VIEWING
 
 AN
 
 ONSCREEN SLIDE SHOW
 
 Before you show your presentation to an audience, you should run through it several times on your own computer, checking that all the slides are in the right order and that the timings and transitions between the slides work correctly. This also enables you to fine-tune any monologue you might have to give as you show the slides so that what you are saying at any point in the presentation is synchronized with the slide that is being shown at that moment. You can preview a slide show at any time; follow these steps: 1. Open the presentation you want to view. 2. Choose the Slide Show menu and choose View Show. The first
 
 slide in the presentation appears full screen (see Figure 21.2). 3. To display the next or the previous slide, do one of the following:
 
 • To display the next slide, click the left mouse button, press the Page Down key, or press the right-arrow or down-arrow key.
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 • To display the previous slide, click the right mouse button, press the Page Up key, or press the left-arrow or up-arrow key. 4. When you have finished running the slide show, press the
 
 Esc key.
 
 FIGURE 21.2 When you run your slide show, the entire screen is used to display the slides.
 
 TIP Start the Show! You can also start a slide show by clicking the Slide Show button in the bottom-left corner of the presentation window or by pressing F5.
 
 SETTING SLIDE ANIMATION SCHEMES After running the slide show a few times, you might find that the presentation doesn’t really provide the visual impact that you had hoped.
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 Even though you have designed your slides well and created slides that include images and movies, you are still looking for something with a more “artsy” feel. A great way to add visual impact to the presentation is to assign an animation scheme to a slide or slides in the presentation. An animation scheme controls how the text in the text boxes on the slide appear or materialize on the slide during the presentation. For example, you can select a slide animation scheme called Bounce, where the various text on the slide “bounces” onto the slide when it appears onscreen during the slide show. PLAIN ENGLISH Animation Scheme A scheme that controls how objects materialize onto the slide during the slide show.
 
 PowerPoint provides three categories of animation schemes that you can assign to a slide: Subtle, Moderate, and Exciting. Each of these categories provides a number of animation schemes. The great thing about the animation schemes is that you can assign them to a slide or slides and then try them out in the Normal view. If you don’t like the animation scheme, you can select another. To assign an animation scheme to a slide in the presentation, follow these steps: 1. Select the slide to which you will assign the animation
 
 scheme so that it appears in the Slide pane in the Normal view. 2. Select the Slide Show menu and select Animation Schemes.
 
 The Animation Schemes list appears in the Slide Design task pane on the right side of the PowerPoint window (see Figure 21.3).
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 FIGURE 21.3 The task pane houses the animation schemes that you can assign to the slides in your presentation.
 
 3. Scroll through the list of animation schemes. When you find a
 
 scheme that you want to try, select the scheme in the list box. 4. To try the scheme, click the Play button in the task pane. 5. If you don’t like the scheme, select another. 6. If you find a scheme that you would like to apply to all the
 
 slides in the presentation, click the Apply to All Slides button. TIP Assign Animation Schemes to Selected Slides You can select several slides in the Slide Sorter view and then use the Slide Design task pane to assign the same animation scheme to all the selected slides.
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 SETTING UP
 
 A
 
 SELF-RUNNING SHOW
 
 In a self-running show, the slide show runs itself. Each slide advances after a specified period of time. This allows you to concentrate on the narrative aspects of the presentation as you use the slide show for a speech or classroom presentation. For a self-running show, you must set timings. You can set the same timing for all slides (for example, a 20-second delay between each slide), or you can set a separate timing for each slide individually. When you set up a self-running show, you can also select different slide transitions. A slide transition is a special effect that is executed when the slide appears during the slide show. For example, you can have a slide dissolve onto the screen, or you can have the slide appear on the screen using a checkerboard effect. To configure the show to use timings and transitions, follow these steps: 1. Open the presentation you want to view. 2. Select the slide to which you would like to apply a timing or
 
 transition so that it appears in the Slides pane in the Normal view. 3. Select Slide Show and click Slide Transition. The Slide
 
 Transition task pane opens containing controls for the type of transition you want to use, the speed with which that transition executes, and the length of time the slide should remain onscreen (see Figure 21.4). 4. To select a transition for the slide, select one of the transi-
 
 tions supplied in the Apply to Selected Slides box. 5. To test the transition, click the Play button. 6. If you want to change the speed of the transition, click the
 
 Speed drop-down list and select Slow, Medium, or Fast (Fast is the default).
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 FIGURE 21.4 The Slide Transition task pane houses the controls necessary for tailoring the way a slide transitions onto the screen during a presentation.
 
 7. (Optional) If you want to select a sound to accompany the
 
 slide transition (such as Applause, Drum Roll, or Laser), click the Sound drop-down list and select one of the supplied sounds. 8. To set the timing for the slide in the Advance Slide section of
 
 the task pane, click the Automatically After check box. Use the click box below the check box to enter the number of seconds for the slide’s automatic timing. 9. If you want to apply the selected transition and the timing to
 
 all the slides in the presentation, click the Apply to All Slides button.
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 CAUTION My Slides Don’t Advance Using the Timings If you find when you run the slide show that the slides don’t advance using the timings that you have set, select Slide Show, Set Up Show. In the Set Up Show dialog box, be sure that the Using Timings, If Present option button is selected. Then click OK.
 
 When you run the slide show, the slides advance according to the timings that you have set. The slides also use any transitions that you have selected for them. Take the time to run the slide show several times so that you can gauge whether the transitions and timings work well. Remember that the slide must be onscreen long enough for your audience to read and understand the text on the slide. TIP Assign Transitions and Timings to Selected Slides You can select several slides in the Slide Sorter view and then use the Slide Transition task pane to assign the same transition and/or timing to the selected slides.
 
 CAUTION Don’t Get Too Fancy! If you are going to use slide transitions and animation schemes on each and every slide, you might find that your slide show is becoming “too exciting,” like a film with too many explosions, car chases, and other special effects. Viewers of the slide show will likely have trouble concentrating on the text on the slides if too many things are going on at once. Remember, everything in moderation.
 
 In this lesson, you learned how to insert and delete slides. You also learned how to complete a PowerPoint presentation and present it on a computer. In the next lesson you learn how to create a FrontPage Web site.
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 Creating a FrontPage Web Site In this lesson, you learn how to create a new Web site using the FrontPage Web Wizards. You also become familiar with the different Web views provided on the FrontPage Views bar.
 
 USING
 
 THE
 
 WEB SITE WIZARDS
 
 Microsoft FrontPage is a full-featured Web design application that provides you with all the tools you need to create your own Web page or Web site and get it onto the Web. Wizards and templates are provided that make it easy for you to create simple, personal Web sites or complex Web sites for your business. FrontPage not only makes it easy for you to create your own Web pages and sites, it also enables you to test and troubleshoot the site before publishing it to the World Wide Web. Web pages and sites must be created in the HTML (Hypertext Markup Language) programming language for them to function when viewed in a Web browser such as Microsoft Internet Explorer. PLAIN ENGLISH Web Page A single page containing text and graphics that has been labeled with the appropriate HTML coding for the Web.
 
 PLAIN ENGLISH Web Site A collection of linked Web pages containing various content that can easily be navigated using a Web browser.
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 FrontPage provides several wizards you can use to create your own Web site (in FrontPage, a Web site is called a web). These wizards can create different kinds of sites, ranging from the personal to the professional, or they can help you add certain types of functions to your current Web site (such as a discussion page or a page for project management). Table 22.1 lists the Web Wizards that are available and the type of web they help you create. Table 22.1
 
 Selecting a Web Wizard for Your New Web Site
 
 Web Wizard
 
 Site Created
 
 One Page Web
 
 A web consisting of a single blank page (the home page).
 
 Corporate Presence
 
 A multipage web with pages for products and services and links for e-mail messages to the company.
 
 Customer Support
 
 A web that provides a FAQ (frequently asked questions) page, a suggestion page, a download page, and a search page to help support customers using the site.
 
 Discussion Web
 
 A web consisting of a discussion page that allows visitors to your site to post and read discussion messages.
 
 Database Interface
 
 A web that connects to a database and allows you to view and update records.
 
 Empty Web
 
 A web consisting of no pages.
 
 Import Web
 
 A web based on imported files from a Web site created in another program or directly from the World Wide Web.
 
 Personal Web
 
 A multipage web consisting of interests, photos, and links pages.
 
 Project Web
 
 A multipage web used to manage a particular project. A schedule page, a discussion page, and other project management pages are created. This type of site would typically be used on an intranet (a corporation’s private web).
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 When you work with the various wizards, you will find that they provide you with blank pages, partially completed pages, or pages containing text, links, and picture placeholders. In all cases, you must add and edit material in the site to complete your web before you can publish it to the World Wide Web where Web users can access it. Remember that when you provide a name for the web you are going to create using the wizard, you are actually creating a folder on your computer where the web will reside. Webs do not consist of a single file like an Excel worksheet or Word document does. Webs consist of several page files, picture files, and other elements. When you specify the name for the web, you are making a place for FrontPage to store all the files that make your web look the way it does. A complex web can contain many files, so be sure you have plenty of space on the drive that you use to store the web.
 
 CREATING
 
 A
 
 NEW WEB
 
 The various Web Wizards that you can use to walk you through web creation determine the level of sophistication of your new web. Although the wizards act in similar ways, the more complex the site, the more questions you have to answer and the more steps you have to complete before the site is created. For example, the Personal Web Wizard provides a fast and easy avenue to a simple Web site for your own use, whereas the Corporate Web Wizard helps you create a complex web that contains a great deal of information (that you provide) about the company that the site is for. To create a site using one of the wizards, follow these steps: 1. With the FrontPage application running on the Windows
 
 desktop, select the File menu and point at New. This opens the New page or Web task pane. Select Web Site Templates from the New from Templates section. The Web Site Templates dialog box opens showing the Web Site Wizards (see Figure 22.1).
 
 23 6602 ch22
 
 11/8/01
 
 2:29 PM
 
 Page 219
 
 Creating a FrontPage Web Site
 
 FIGURE 22.1 The Web Site Templates dialog box is where you select the wizard you want to use to build your new web.
 
 2. Select one of the wizard icons in the dialog box, such as
 
 Corporate Presence Wizard. 3. In the Specify the Location of the New Web text box in the
 
 Options section, specify a name and location for the new web. The default main folder for FrontPage webs is My Webs; however, you can use the Browse button to select a new location. 4. Click OK to begin the web creation process. 5. Depending on the wizard you selected, your next action
 
 begins either with editing and enhancing the Web pages that the wizard creates or answering some questions that the wizard poses before it creates the pages. For example, in the case of the Corporate Presence Web (and other business-related webs such as the Customer Support site), a wizard screen appears, describing the purpose of the wizard. Click Next to continue.
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 6. Answer the questions on each wizard screen and click Next
 
 to continue. Figure 22.2 shows a screen from the Corporate Presence Web Wizard in which it asks you to determine the topic areas that should appear on the new web’s home page.
 
 FIGURE 22.2 The wizard screens let you determine the pages in the web as well as topic areas and items found on individual pages.
 
 7. Depending on the wizard that you chose to create your new
 
 web, you might be asked to select a theme for your new site. FrontPage themes provide design elements and color schemes that can really help you create eye-catching webs. Themes are discussed in the next lesson. Click Finish to end the web creation process.
 
 UNDERSTANDING
 
 THE
 
 WEB VIEWS
 
 When you complete your new web, you are taken to the Navigation view of the web, which shows all the pages that were created for your new site and their relationship to other pages in the site. The site consists of a home page and several other pages that branch from the home page (and are subordinate to it). Figure 22.3 shows the Navigation view of a web created using the Personal Web Wizard. Each wizard creates a different number of pages for the site and arranges them in a manner that depends on the purpose of the web.
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 Navigation icon on the Views bar FIGURE 22.3 The various wizards end the creation process by showing your new web pages and their configuration in the Navigation view.
 
 CAUTION Some Wizards Dump You into the Task View The Corporate Presence Wizard provides an option on the second-to-last wizard screen to take you to the Task view rather than to the Navigation view. If you do not deselect the check box for Task view, you will end up there on completion of the web. The different views available to you in FrontPage are covered in the remainder of this lesson.
 
 The key to completing a web that has been created using a web wizard is understanding how the various views on the FrontPage Views bar are used as you edit and enhance the new web. Each view provides a different information set that shows you how the overall construction of the web is progressing. These views are defined in the sections that follow.
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 THE NAVIGATION VIEW The Navigation view (refer to Figure 22.3) enables you to see all the pages in the web in a flowchart format, which gives you the hierarchy for the site. (This view is usually the default view for a site created using one of the wizards.) The home page for the site is at the top of the hierarchy, and all pages that branch from the home page are shown below the home page with a connecting line. FrontPage calls the pages that are below the home page in the web child pages. Child pages are not limited to the home page, however, and any page in the Web site can have child pages. A page that has child pages is called a parent page. You can drag and drop pages in the Navigation view to change their location in the web structure. New pages created for a site are inserted into the web in this manner. To move to the Navigation view from any other FrontPage view, click the Navigation icon on the Views bar.
 
 THE PAGE VIEW The Page view is used to view and edit a particular page in your web. You use the Page view when you add text, pictures, or other objects to the individual Web pages in the site. The Page view is similar to an Excel worksheet window or a Word document window. It provides a workspace. To enter the Page view for a specific page in the Web, follow these steps: 1. Go to the Navigation view by clicking the Navigation icon
 
 on the Views bar (refer to Figure 22.3). 2. Double-click a particular page in the Navigation view. The
 
 page opens in the Page view (as shown in Figure 22.4). The look of the page depends on the theme that you chose.
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 FIGURE 22.4 The Page view is where you focus on a particular page in the web and edit and enhance it.
 
 When you are in the Page view, you can edit the current page as needed. TIP Quickly Return to the Previously Opened Page If you open a particular page in the Page view by double-clicking it in the Navigation view (or Folders view) and then move to a different view (such as returning to the Navigation view), you can quickly return to the previously opened page by clicking the Page View icon on the Views bar.
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 THE FOLDERS VIEW The Folders view shows the folders and files in the current web. When you create a web using one of the wizards, several folders and files are created (the files created depend on the wizard that you used). Click the Folders icon in the Views bar to view the folders and files in the web. Figure 22.5 shows the folders and files that are created when you use the Personal Web Wizard to create a new web.
 
 FIGURE 22.5 The Folders view enables you to view the folders and files contained in the current web.
 
 The folders created for any of your new webs (no matter which wizard you use) consist of the following: • Web Folder—This is designated by the name that you provided for the web’s location in the Specify the Location of the New Web box in the New dialog box.
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 • Private Folder—This folder is created to hold any data that is input into special forms or other data input objects that you place on a page or pages in your Web site. Because the folder is private, a visitor to your Web site cannot gain access to the information that it holds. • Images Folder—This folder provides a place to save pictures and clip art that are part of the Web site. Any images placed in the web by the wizard are contained in this folder. Files that are contained in the web can also be seen in the Folders view. Each web typically contains an index.htm file that serves as the home page for the web; the other pages in the web depend on the wizard that was used (each with the .htm extension, which means the page is an HTML document). You can delete files from the web in the Folders view (select the file and press Delete). You can also open pages in the Folders view by double-clicking them. They open in the Page view.
 
 THE REPORTS VIEW The Reports view enables you to view statistics and other information related to your web. These statistical reports are created automatically when you create the web, and they are updated as you work on the web. To view the statistics for your site, click the Reports View icon on the Views bar. Figure 22.6 shows the Reports view for a personal web. Statistics such as the number of files and pictures in the web are reported as minireports. Other data provided include unverified links in the web (these usually consist of links to other Web sites on the World Wide Web that have not yet been verified by going online with your web). The Reporting toolbar enables you to change the statistics displayed in the Reports window (it appears directly below the other FrontPage toolbars). The default list for the Reports view is the Site Summary (refer to Figure 22.6), which shows all the statistics. If you want to
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 view a certain statistic, such as unlinked files (in the web), click the drop-down box on the Reports toolbar and select the statistic—in this example, Unlinked Files—from the Problems list. These files are listed. Any views found in the Site Summary view can be viewed alone by selecting the appropriate report title from the toolbar dropdown list.
 
 FIGURE 22.6 The Reports view provides you with important statistics related to your web.
 
 THE HYPERLINKS VIEW The Hyperlinks view enables you to view the hyperlinks from a particular page in the site to other pages in the site and to other Web sites on the World Wide Web. Figure 22.7 shows the Hyperlinks view for the Favorites page in a Personal Web site. The page has internal links to the other pages in the web (so that you can quickly go to those pages). It also contains external links that enable you to jump to other sites found on the World Wide Web.
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 FIGURE 22.7 The Hyperlinks view shows you the internal and external hyperlinks on a specific page in your web.
 
 To go to the Hyperlinks view for a page in your web, be sure that you first select the page in the Folders view or the Navigation view. Then click the Hyperlinks View icon on the Views bar. The page and its hyperlinks are displayed.
 
 THE TASKS VIEW The Tasks view enables you to see tasks that are used to help you complete various aspects of your Web site. You can create tasks related to specific pages in the web or items on a Web page, such as a picture or other item. When you start a task that appears on your Tasks list, the task automatically opens the page or goes to the item on the page for which the task was created. Some of the wizards, such as the Corporate Presence Wizard, automatically create a list of tasks that is used to make sure all aspects of the new web are addressed before the web is
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 placed on the World Wide Web for viewing. Tasks are covered in more detail in Lesson 24, “Completing and Publishing Your Web Site.” To go to the Tasks view, click the Tasks View icon on the Views bar. Figure 22.8 shows the tasks that were created when the Corporate Presence Wizard was used to create a new web.
 
 FIGURE 22.8 The Tasks view enables you to create and monitor tasks that are related to the completion of your web.
 
 In this lesson, you learned how to create a web using the FrontPage web wizards. You also learned how to navigate the views provided on the FrontPage Views bar and how each view gives you different information about your Web site. In the next lesson, you learn how to work with Web pages and assign FrontPage themes to your Web.
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 Working with Web Pages and Themes In this lesson, you learn how to create new Web pages using the FrontPage templates and how to delete pages and import pages created in other applications. You also learn how to enhance the look of your Web pages with FrontPage themes.
 
 CREATING
 
 A
 
 NEW WEB PAGE
 
 FrontPage makes it easy for you to create new Web pages and place them into your web. You can create blank pages or pages that use a FrontPage template. These templates provide you with pages that can add functionality to your Web site. To create a new page in a web, follow these steps: 1. To open the web where you want to place the new page,
 
 select the File menu and point at Recent Webs; from the cascading menu that appears, select the web you want to open. CAUTION My Web Isn’t on the Recent Webs Menu! If you have created more than four webs using FrontPage, there is a good chance your most infrequently used webs will no longer appear on the Recent Webs menu, which shows only the last four webs). To open webs not listed, select File, Open Web. Use the Open Web dialog box to specify the location for the web. When you have located the web, select it and then click Open.
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 2. With the appropriate web open, you can now create a new
 
 page for the web. First, click the Page View icon in the View bar to go to the Page view. 3. Select the File menu, point at New, and the New Page or
 
 Web task pane opens. Under New from Template, select Page Templates, which opens the Page Templates dialog box (see Figure 23.1).
 
 FIGURE 23.1 The General tab of the Page Templates dialog box is where you select the template for your new page.
 
 4. The new page templates are available on the General tab of
 
 the Page Templates dialog box. Click the template that you want to use for your new page. Then click OK to create the new page. The new page appears in the FrontPage Page view. Figure 23.2 shows a two-column page that was created using the Two-Column Body template. The templates create pages that contain placeholder text and other items that you can modify.
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 FIGURE 23.2 The new page appears in the FrontPage editing window in the Page view.
 
 You will also find that the new page (even though it’s not included in the navigational structure of your web yet) embraces the theme that you assigned to the current web. (FrontPage themes are covered later in this lesson.) Now that you have the new page, you need to save it. Follow these steps: 1. Click the Save button on the FrontPage toolbar. The Save As
 
 dialog box opens. 2. Type a filename for your new page into the File Name box. 3. You also should change the page title for the new page. This
 
 title appears in the Web browser when you view the particular page on the World Wide Web. To change the page title, click the Change button. The Set Page Title dialog box opens (see Figure 23.3).
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 FIGURE 23.3 Type the page title that you want to appear in the Web browser when the page is viewed on the World Wide Web.
 
 4. Type the new page title and click OK. You are returned to the
 
 Save As dialog box. Click Save to complete the process.
 
 INSERTING
 
 A
 
 NEW PAGE
 
 INTO THE
 
 WEB
 
 After you’ve created and saved the new page, you must make the page part of the current web. You might think creating the page when the current web is open in FrontPage should have taken care of that, but it doesn’t. You add the page to the current web by linking the page to either your site’s home page (which in most cases will have the name index.htm) or to any other subordinate page in the web. To add the new page to the navigational structure of your web, follow these steps: 1. Click the Navigation icon on the Views bar. The current nav-
 
 igational structure of your page appears. 2. To the left of the Navigation view, a Folder List should appear.
 
 If you don’t see a list of all the pages available in the web (in the Folder List), click the Folder List button on the toolbar. 3. To add the new page to the structure of the web, locate the
 
 file in the Folder List, and then drag the file onto the Navigation view, placing the box that represents the file underneath your home page. Figure 23.4 shows a page named “all about whales.htm” being added to the web structure.
 
 24 6602 ch23
 
 11/8/01
 
 2:28 PM
 
 Page 233
 
 Working with Web Pages and Themes
 
 FIGURE 23.4 The Navigation view makes it easy for you to add new pages to your web.
 
 After the page has been added to the web structure, it appears as a page box, as the other pages in the web appear when you are using the Navigation view. If you want to view the page itself, double-click its page box in the Navigation view and it will open in Page view.
 
 DELETING
 
 A
 
 PAGE
 
 FROM THE
 
 WEB
 
 Deleting a page from the web is best done in the Navigation view. This not only allows you to quickly delete the page from the navigational structure of the web, but it also removes the appropriate HTML document from the Folder List at the same time. To delete a page from your web, follow these steps: 1. Click the Navigation icon on the Views bar to go to the
 
 Navigation view. 2. Click the page that you want to remove from the web (in the
 
 Navigation window).
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 3. Press the Delete key on the keyboard. The Delete Page dialog
 
 box appears. 4. You have the choice of removing the page from the naviga-
 
 tional structure of the web (this does not delete the page file) or deleting the page from the web (this removes it from the structure and deletes the file). Select the appropriate option button in the Delete Page dialog box, as shown in Figure 23.5.
 
 FIGURE 23.5 You can easily remove a page from the web in the Navigation view.
 
 5. Click OK. The page is removed from the structure. (The file
 
 is deleted if Delete This Page from the Web was selected in the dialog box.)
 
 IMPORTING FILES
 
 FROM
 
 OTHER APPLICATIONS
 
 You can also import page files into your web that you create in other applications. For example, suppose you designed a Web page in Microsoft Word and saved the document as an HTML file. You can easily import that particular file into the current web. To import a file into the current web, follow these steps: 1. Select the File menu and select Import. The Import dialog
 
 box appears. 2. Click the Add File button. The Add File to Import List dialog
 
 box appears.
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 3. Use the Look In drop-down box to locate the drive that holds
 
 the file you want to import, and then navigate the folders in the main window until you reach the file’s exact location. After selecting the file, click the OK button. 4. The filename appears in the Import dialog box (see Figure 23.6).
 
 Repeat steps 2 and 3 if you want to add more files to the Import list.
 
 FIGURE 23.6 You can import one or several files into the current web.
 
 5. When you have added all the files to the Import list that you
 
 want to import into the current web, click the OK button. The file (or files) is imported into the current web. You can find the files listed in the Folder List of your web. The files then must be made part of the web’s navigational structure. Go to the Navigation view and drag the file or files from the Folder List and add them to the Navigation window as discussed earlier in this lesson.
 
 USING
 
 THE FRONTPAGE
 
 THEMES
 
 Whereas the page templates available in FrontPage for creating new pages control the overall functional layout of the page, the FrontPage
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 themes control things such as the look, the design, and the color scheme of the pages. When you create a new web using some of the wizards (such as the Corporate Presence Wizard), you are asked to choose a theme during the web creation process. However, you can select a theme for the pages that are inserted into an empty web or created with one of the wizards (such as the Personal Web Wizard) that use the default theme (Straight Edge theme) for the newly created web. To choose a theme for your Web pages, follow these steps: 1. Go to the Page view by clicking the Page icon on the Views
 
 bar. 2. Select the Format menu and select Theme. The Themes dia-
 
 log box appears (see Figure 23.7).
 
 FIGURE 23.7 The Themes dialog box gives you access to all the FrontPage themes.
 
 3. You can apply the theme to the currently open Web page (the
 
 page that was shown in the Page view) or apply the theme to all the pages in the web. Click either the Selected Page(s) or the All Pages option button, respectively.
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 4. To choose your theme, scroll down through the themes in the
 
 Theme scroll box. Select a particular theme to see a preview of the theme in the Sample of Theme box in the dialog box. 5. When you have found the theme you want to use for your
 
 page or pages, select it and then click the OK button. The theme is applied to the page (or pages) in your web. Figure 23.8 shows a page to which the Spiral theme has been applied.
 
 FIGURE 23.8 Each theme embraces a unique color scheme and related design elements.
 
 Themes can help set the tone for a Web site and can also add a great deal of visual interest to a web. You will find that you do have control over some aspects of the theme’s design. When you are in the Themes dialog box, click the Modify button located near the bottom center of the dialog box. Three buttons appear just above the Modify button: Color, Graphics, and Text. Click the
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 Color button to select a new color scheme for the theme. To change the background graphic used in the theme, click the Graphics button and then use the drop-down box to select a new graphic file. To modify the font used in the theme, click the Text button and make a font selection using the Font scroll box that appears. In this lesson you learned how to add a page to your Web. You also learned how to use FrontPage themes. In the next lesson, you learn how to add graphics to your Web and then publish your site to the World Wide Web.
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 Completing and Publishing Your Web Site In this lesson, you learn how to add graphics to your Web site. You also learn to complete a web using tasks and how to publish your web to the World Wide Web.
 
 USING TASKS
 
 TO
 
 COMPLETE
 
 A
 
 WEB
 
 As you create and fine-tune a web you want to place on the World Wide Web, you will find that you must complete many individual tasks before the site is ready to be published. You have to make sure that graphics or other images have been placed in the appropriate places and that hyperlinks correctly point to their particular destinations. Even the simplest of sites requires you to make changes and improvements to pages in the web, even if you created the web with a wizard. FrontPage offers a tool for helping you to stay organized as you create and complete a web. FrontPage tasks provide a way to keep a running list of your web duties as you work on the site. This Tasks list can be viewed any time in the Tasks view. You will find that tasks are automatically created by some of the FrontPage wizards, such as the Corporate Presence Wizard. Figure 24.1 shows a list of tasks associated with a new web created using the Corporate Presence Wizard.
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 FIGURE 24.1 Tasks are automatically created by some of FrontPage’s web wizards.
 
 CREATING
 
 A
 
 NEW TASK
 
 You can create tasks and link them to an entire web page or to items on that page, such as pictures or other objects. The easiest way to create a new task that is linked to a particular page is to create the task with the page in the Page view. For example, suppose you have a page that will contain hyperlinks to your favorite sites. You can create a task for this page to make sure you’ve placed all the appropriate hyperlinks (to your favorite sites) on the page before you publish the web. Follow these steps to create a new task: 1. Open the page (double-click it in the Navigation view) for
 
 which you want to create a task. 2. Select the File menu, point at New, and then select Task (or
 
 select Edit, Task, and Add Task). The New Task dialog box opens (see Figure 24.2).
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 FIGURE 24.2 The New Task dialog box is where you name, set the priority for, and describe your new task.
 
 3. Type a task name into the Task Name box. To assign a prior-
 
 ity to the task (other than the default, which is Medium), click the appropriate option button in the Priority area. 4. Type a description for the task into the Description box. 5. Click OK to create the new task.
 
 The new task is created and linked to the current page. To view the new task, click the Tasks button on the Views bar. TIP Create Your Task List Up Front To help you plan the work flow on a new Web site, create the tasks for that web as soon as you (or a wizard) create the pages for that web. Staying organized ensures that your site is complete before you place it on the World Wide Web.
 
 STARTING
 
 A
 
 TASK
 
 After you create the task (or several tasks), you can view the task in the Tasks view. This view is also where you start a task, mark a task as complete, or delete an unwanted task.
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 To start a particular task, follow these steps: 1. In the Tasks view, double-click the task you want to start.
 
 The Task Details dialog box opens (see Figure 24.3).
 
 FIGURE 24.3 Start your task using the Task Details dialog box.
 
 2. Click the Start Task button.
 
 FrontPage takes you to the page or other object to which the task was linked. For example, if your task is to create hyperlinks on a particular page, you are taken to that page where you can begin creating the needed hyperlinks.
 
 COMPLETING
 
 A
 
 TASK
 
 After you finish a particular task, you can mark that task as completed. Saving the page that the task was assigned to does this. Follow these steps: 1. Click the Save button on the toolbar. A message box appears,
 
 letting you know that this page was opened from the Tasks view. 2. To mark the task as completed, click Yes (if you haven’t
 
 completed the task but want to save your changes, click No, and you can complete the task at a later time).
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 When you return to the Tasks view (click the Tasks icon on the Views bar), the task is marked as completed. You can also mark tasks as completed directly in the Tasks view. Right-click the task and select Mark Complete on the shortcut menu that appears. If you find that you end up with redundant tasks or create a task that doesn’t end up fitting into your web plan—for example, you might want to delete the page associated with the task—you can easily delete any task on the list. Right-click the task and select Delete on the shortcut menu. FrontPage asks whether you want to delete the current task. Click Yes to delete the task. CAUTION Check the Web Reports Even if you use tasks to make sure that you cover all the details related to your web, check the Reports view before publishing the site. Reports concerning unverified or broken hyperlinks or unlinked graphics (these reports are generated automatically by FrontPage) can help you avoid the embarrassment of publishing a Web site that doesn’t work the way you intended it to.
 
 INSERTING PICTURES As we already mentioned in this lesson, one of the tasks that you may need to complete to finish up your Web is to add graphics to your Web pages. FrontPage makes it easy for you to insert images, clip art, and special animated images into your Web pages. You can insert pictures that you download from the World Wide Web, scan with a scanner, or capture with a digital camera. You can also insert clip art and motion clips from the Clip Art Gallery. You will find that FrontPage enables you to insert several picture file formats into your Web pages: • CompuServe GIF (.gif) • Encapsulated PostScript (.eps)
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 • Various paint programs (.pcx) • Tagged Image File format (.tif) • Windows bitmap (.bmp) • JPEG File Interchange format (.jpg) Inserting a picture onto a Web page is really just a matter of placing the insertion point at the appropriate position and then locating the picture file that you want to insert. To insert a picture file, follow these steps: 1. Open the page (double-click it in the Navigation view) where
 
 you want to place the picture. You are in the Page view. 2. Place the insertion point where you want to place the graphic. 3. Select Insert, point at Picture, and select From File on the cas-
 
 cading menu. The Picture dialog box appears (see Figure 24.4).
 
 FIGURE 24.4 The Picture dialog box allows you to insert picture files into your Web pages.
 
 4. Use the Look In drop-down list (near the top left of the dia-
 
 log box) to locate the drive that contains the picture file, and double-click to open the folder that holds the file. After you locate the picture, click the file to select it.
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 5. Click OK, and the image is placed on your page (see
 
 Figure 24.5).
 
 FIGURE 24.5 Pictures can add visual interest to your Web pages.
 
 INSERTING CLIP ART You can also insert any number of images from the Clip Art Gallery. Drawings of animals, computers, and even cartoons are available for you to use on your Web pages. To insert clip art images, follow these steps: 1. Open the page (double-click it in the Navigation view) where
 
 you want to place the picture. You are in the Page view. 2. Place the insertion point where you want to place the clip art.
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 3. Select the Insert menu and point at Picture. Select Clip Art
 
 from the cascading menu. The Insert Clip Art task pane opens. 4. Type a subject or category (such as Animals) into the Search
 
 text box to view a set of images (see Figure 24.6).
 
 FIGURE 24.6 Each Clip Art Gallery category provides a set of related images.
 
 5. When you locate the image you want to use, click the image.
 
 A drop-down list appears, which contains several options for using that piece of clip art. 6. Click Insert on the list to place the image on your page.
 
 PUBLISHING YOUR WEB After you added graphics, cleaned up your Web pages and completely finished your site (check the Tasks view to decide whether you are
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 truly finished), you are ready to publish the web. Publishing the web means that you place all the folders and files in the web onto a Web server. The Web server then serves up your site to visitors on the World Wide Web. You can take two routes to get your web onto your Web server: You can use HTTP (Hypertext Transfer Protocol) to upload your web to the server, or you can use FTP (File Transfer Protocol) to move the files. If you use HTTP, the server you send your web files to must have the FrontPage server extensions installed on it. You should check with your Internet service provider before you upload a FrontPage web to the server to be sure the extensions are available. If the server is not enabled with the FrontPage extensions, you can still upload to your Web server by using FTP. Be advised, however, that Web servers that do not support the FrontPage extensions preclude you from using special components on your Web pages—for example, FrontPage hit counters and themes might not work correctly. Specifying whether you are publishing your site using HTTP or FTP is determined by how you enter the address for the Web server into the FrontPage Publish Web dialog box (covered in detail in the steps that follow). For example, suppose your Web server on the World Wide Web is called joe.com. If you are using HTTP to upload your web files, this server’s address is specified as http://www.joe.com. If you are using FTP to upload the files, the address for this site is ftp.joe.com. To publish your web, follow these steps: 1. Connect to the Internet using your dial-up connection to your
 
 Internet service provider. 2. In FrontPage, select the File menu and then select Publish
 
 Web. The Publish Destination dialog box appears (see Figure 24.7).
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 FIGURE 24.7 Enter your Web site’s address into the Publish Destination dialog box.
 
 3. Enter the address of the server that you will upload your web
 
 to in the Enter Publish Destination box (using either an HTTP or FTP address, as discussed earlier in this section). Click OK. 4. The Publish Web dialog box appears (see Figure 24.8). This
 
 box displays all the files in your web. If the web has been published previously to the address you specified in step 3, you can see the files currently stored on the Web server by clicking the Show button. This opens a second pane in the Publish Web dialog box showing the destination server and the web files it contains. 5. (optional) If you are publishing this web to update a Web site
 
 that has been published previously, you can choose to update only pages that have changed (since the last time you published the web). Click the Options button on the Publish Web dialog box. The Options dialog box appears. 6. (optional) In the Options dialog box, click the Changed
 
 Pages Only option button, and then click OK to return to the Publish Web dialog box. 7. If the current web contains hyperlinks to other webs that you
 
 have created but not published (called subwebs), select the
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 Include Subwebs check box to publish these along with the current web. 8. Click the Publish button.
 
 FIGURE 24.8 The Publish Web dialog box is where you select publishing options.
 
 You are kept apprised of the progress of the publishing of your web while you wait. When the process has completed, click the Done button to close the notification box. Your web is now available on the World Wide Web. You can use your Web browser to visit your Web site and be sure it is functioning correctly. If you need to modify pages or update the Web site, modify the original web in FrontPage and then publish the web to the server again, making sure that you check the option for changed pages to replace pages already on the server. In this lesson you learned how to use tasks to complete your Web and how to insert images onto your Web pages. You also learned how to publish your site to the World Wide Web.
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 A a.m., 134 Access commands, Tools, Speech, 6 opening new databases, 164 templates, 166, 170 windows, 164 Access 2000 file format, 163 Access 2002 file format, 163 Access 97 file format, 163 accessing Formatting toolbar, 113 New Query dialog box, 193 Action menu commands Call Contact, 72 New All Day Event, 81 New Contact, 64 New Meeting Request to Contact, 71 New Message to Contact, 71 New Recurring Appointments, 79 New Task for Contact, 71 activating Office XP, 15-16 Active Appointments, 76 Activities tab, 69-70 Add All, 174, 186
 
 Add File button, 234 Add Horizontal Line button, 44 Add or Remove Buttons (Word toolbar), 86 Add to Outlook Bar shortcut menu, 62 adding address, 40 bullets, 44 contacts, 64-66 distribution lists, 40 fields to tables, 174 folder shortcuts, 62 numbers, 44 signatures. 46-48 text, 96-98 addition, 140 Address button, 65 Address Cards, 67-68 addresses, 139. See also cell addresses business, 65 cells, 147 creating, 63, 65-67 Home, 65 Other, 65
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 adjacent cells, 136 Advanced tab, 163 Alarm Bell button, 79 alarms, 78. See also audio alarms Align Left button, 43-44, 117 Align Right button, 43-44 aligning text, 116-119 alignment, 44 All Day Event check box, 82 All Day Event scheduling, 81 All Pages option button, 236 Always Create a Backup Copy check box, 93 Animation Schemes command (PowerPoint Slide Show menu), 211 animation slide shows, 210-212 Answer Wizard, 34-35 answering received messages, 54-55 Append Query, 194 Apply to All Slides button, 214 applying fonts, 44 applying type style, 44 Appointment dialog box, 79-81 Appointment Recurrence dialog box, 79-81 Appointment tab, 77-79 Appointment Time, 80 appointments creating in Calendar, 77-79 double-clicking, 77 entering details when scheduling, 77 managing with Calendar, 75 scheduling, 79-81 viewing in Calendar, 75 area, chart type, 158 arrows, 75-77 Ask a Question box, 28-30 assigning tasks, 71
 
 attachments forwarding mail, 60 represented by icons, 52 saving from received messages, 52-54 saving to folders, 53 attributes, fonts, modifying, 112-114 audio, Speech feature, 6 audio alarms, 78 AutoCalculate, 144 AutoComplete, 137 AutoContent Wizard, 197-201 Autodate feature, 78 AutoForm, 184-185 Automatic Permanent Delete, 58 AutoNumber, 179-181 AutoRecover (Word), 92 AutoSum, 150-151 Available Fields list, 186, 191 AVERAGE, 148 averages, 144 axis, 157
 
 B Back arrow, 77 backgrounds for reports, 169 Backspace key, 40, 104, 146 backups, 92-93. See also saving bars chart type, 157 data series, 156 Formula, 142, 152 navigation, 188 selection bar, 101 Black-and-White Overheads (AutoContent Wizard), 199 Blank Database creating, 163-165 task pane, 164 template, 170
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 Blank Document template, 84 blank presentations, 203 blind carbon copy (Bcc) messages, 39 Bold button, 43-44 Bold button (Formatting toolbar), 112 bold text, 112 BONUS, 149 Browse button, 219 building query types, 194 Bulleted list style, 44 Bullets button, 43-44 Business addresses, 65 Business Table Wizard table types, 174 By Category Calendar, 76 Current View options, 69 By Company, Current View options, 69 By Follow-Up Flag, Current View options, 69 By Location, Current View options, 69
 
 C calculations AutoCalculate, 144 formulas, 139-140 editing, 145 entering, 142-144 functions, 147-151 mathematical operators, 140 operator precedence, 141 Calendar creating appointments, 77-79 creating task lists, 75-77 daily or weekly tasks, 75 folder, 75 icon, 75 managing appointments, 75
 
 navigating, 75-77 planning events, 81-82 viewing appointments, 75 viewing tasks, 75 Calendar Views, 76 Call Contact command (Actions Menu), 72 Call Status dialog box, 73 calling contacts, 72-73 calls, 72. See also phone calls Carnegie Coach (AutoContent Wizard), 199 categories contact information, 63 defined, 156 Categories button, 79 Cc (carbon copy), 39, 60 cells, 129 addresses formulas, 139 lists, 147 selecting, 143 adjacent, 136 comments, adding, 131-132 data, filling, 135-136 formatting, 133 navigating, 130 references, entering, 142 specifying functions, 153 totaling, 144 Cells command (Format menu), 135 center alignment, 44 Center button, 43-44, 117 centering text, 116 Certificates tab, 67 Change button, 231 Changed Pages Only option button, 248 changing Calendar views, 76 character styles, 120 Chart Sub-Type, 159 Chart Type, 159 Chart Wizard, 159
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 charts appearance options, 160 creating, 158-161 data, analyzing, 157 embedded, 158-161 moving, 161 printing, 161 resizing, 161 saving, 158-161 sheets, 158-161 terminology, 156-157 types, 157-158 check boxes All Day Event, 82 Always Create a Backup Copy, 93 Empty the Deleted Items Folder Upon Exiting, 58 Include Subwebs, 249 Reminder, 78 Use Microsoft Word to Edit Email Messages, 45 Windows in Taskbar, 85 Yes, I’d Like to Include a Picture, 170 Check Full Name dialog box, 64 child pages, 222 choosing alignment, formatting text, 44 choosing AutoForm options, 184 choosing colors, formatting text, 44 circular double-arrow icon, 81 Click and Type, 118-119 Click Here to Add a New Task, 77 clicking database window icons, 165 clicking filenames, opening databases, 172 clip art FrontPage Web pages, 245-246 Insert Clip Art task pane, 23 Clip Art command (FrontPage Insert, Picture menu), 246 Clipboard, 23, 107-108
 
 Clipboard command (Edit menu), 108 Clippit, 28. See also Office Assistant clocks, international, 134 Close button, 56, 70, 166, 171, 181 Close command, 94, 166, 205 Close File button, 126-127 Closing contacts, 70 databases, 166 documents, 94 Help window, 34 presentations, 205 Switchboard window, 171 Table Wizard, 176 tables, 181 Collapse button, 154 color, 115 Color button, 44, 238 Color Overheads (AutoContent Wizard), 199 Columnar AutoForm options, 184 form layout choices, 186 columns chart type, 157 Description, 179 labels, entering, 130 commands Actions menu Call Contact, 72 New All Day Event, 81 New Contact, 64 New Meeting Request to Contact, 71 New Message to Contact, 71 New Recurring Appointments, 79 New Task for Contact, 71 Edit menu Clipboard, 108 Copy, 105 Cut, 105
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 Delete, 57-58 Mark All As Read, 51 Mark As Read, 51 Mark As Unread, 51 Move to Folder, 57 Office Clipboard, 107 Paste, 105 PowerPoint, 209 Primary Key, 181 Undo, 44 Undo Delete, 57 File menu Close, 94, 166 Exit, 94 FrontPage, 229-230, 234, 240, 247 New, 84, 87-89, 166, 218 Open, 94, 172 PowerPoint, 197, 202-205 Print, 56, 161 Save, 53, 66 Save and New, 66 Save As, 93 Word, 92 Format menu Cells, 135 Font, 114, 122 Styles and Formatting, 120 Format menu (FrontPage), 236 Help menu, Microsoft Excel Help, 149 Help menu (Office XP) Microsoft Word Help, 32 Show the Office Assistant, 31 What’s This?, 36 Insert menu Comment, 132 FrontPage, 244-246 PowerPoint, 207 Signature, 48 Table, 174
 
 Mail Message, 38 Open, 172 PowerPoint menu (Word), 6 Slide Show menu (PowerPoint) Animation Schemes, 211 Set Up Show, 215 Slide Transition, 213 View Show, 209 Tools menu, 6, 126 Options, 47, 58, 163, 172 Options command, 45 Send/Receive, 52 Startup, 171 View menu Next, 50 Office XP, 24 Previous, 50 Status Bar, 144 Toolbars, 42, 167, 172 voice commands, 5, 11 Comment command (Insert menu), 132 comment text box, 66 comments adding to cells, 131-132 contact information, 63 deleting, 132 red triangles, 132 communicating, contacts, 70, 73 company name contact information, 63 comparing tables, 193 Compose in This Message Format drop-down box, 45 composing messages, 38-41 computing averages, 144 contact, definition, 63 contact addresses, viewing maps, 73 Contact dialog box, 64, 71-73 contact information, 63 Contact list, 59 Contact Management template, 167 contact names, 66
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 contacts adding, 64-66 assigning tasks, 71 calling, 72-73 closing, 70 communicating, 70, 73 creating, 63-67 defaults, 66 deleting, 64-66 editing, 64-66 entering information, 64 modifying, 66 opening by double-clicking, 69 saving, 66 scheduling meetings, 71 sending mail, 71 sending messages, 71 viewing activities, 69 viewing using Activities tab, 69-70 viewing using Address Cards, 67 viewing using horizontal scrollbars, 67 Contacts folder, 63-64, 69 Contacts list, 38, 66-70 Contacts window, 67 container files, 163 Contents tab, 33-34, 149 Copy button, 105, 127 Copy Cells, 135 Copy command (Edit menu), 105 copying, 135-136. See also filling e-mail messages, 38 records, 194 styles, 127 text, 105-107 corner handles (charts), 161 Corporate Presence, Web Wizard, 217-219 COUNT worksheet functions, 148 Create a New Signature dialog box, 47
 
 Create button, 164, 167 Create New Folder dialog box, 60 Create Query by Using Wizard, 190 Create Signature dialog box, 47 Create Table by Using Wizard, 173 in Design View, 178 cross-tabulate tables and Crosstab queries, 193 Crosstabs, 192-193 Crosstab Query Wizard, 192 Ctrl key, 57 Ctrl+Enter keyboard shortcut, 48 Ctrl+P keyboard shortcut, 56 Currency, 182 Current View drop-down arrow, 76 list, 67 options, 68 Address Cards, 68 By Category, 69 By Company, 69 By Follow-Up Flag, 69 By Location, 69 Detailed Address Cards, 68 Phone List, 68 Customer Support, Web Wizard, 217 Customize dialog box, 19 customizing forms, Form Wizard, 187 Cut button (Standard toolbar), 105-106 Cut command (Edit menu), 105 cutting text, 105-107
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 26 6602 Index
 
 11/8/01
 
 2:28 PM
 
 Page 257
 
 Index
 
 entering using forms, 183 organizing queries, 189 series, 136 Data Labels tab, 160 Data Range text box, 159 data series, 156 data tags, 135 Data Type column, 179 Data Type drop-down list, 179 data types, 182 AutoNumber, 182 Currency, 182 Date/Time, 182 Excel, 128-129 Hyperlink, 182 Lookup Wizard, 182 Memo, 182 Number, 182 OLE, 182 settings, 179 Text, 182 Yes/No, 182 Database Interface, Web Wizard, 217 Database toolbar, 164 Database Wizard, 162, 166 databases blank, 163-165 creating using templates, 162-163, 166-171 entering logos, 169-170 entering titles, 169 exiting, 166 files double-clicking, 172 formats, 163 locating using Look In drop-down list, 172 opening, 171-172 selecting locations, 164 selecting names, 164 viewing, 172
 
 navigating using Switchboard window, 170 new, 164 opening, 170 opening by clicking filenames, 172 template options, 167 windows Form tab, 188 Forms object type, 184-185 icons, 164-165 New button, 174 Object pane, 176 opening, 171 Tables icon, 178 Tables object icon, 173 toolbar, 165, 184 Databases tab, 167 Datasheet AutoForm options, 184 form layout choices, 186 queries, 192 View, 176-177 Date and Time functions, 149, 182 dates, 134-136 Decrease button, 44 Decrease Indent button, 43 decreasing indents, 44 Default File Format drop-down box, 163 defaults contacts, 66 fonts, 115 formats, 45 message, 45 options, 135 setting, 163 Delete button, 56-58, 125 Delete command (Edit menu), 57-58 Delete key, 40, 104, 146, 179, 234 Delete Page dialog box (FrontPage), 234 Delete Query, 194
 
 257
 
 26 6602 Index
 
 258
 
 11/8/01
 
 2:28 PM
 
 Page 258
 
 Ten Minute Guide to Microsoft Office XP
 
 Delete shortcut menu, 62 Delete Slide command (PowerPoint Edit menu), 209 Deleted Items folder, 57-58 deleting contacts, 64-66 fields, 175, 179 folders, 62 mail, 56-58 messages, 56 records, 192-194 slides, 208-209 styles, 125 tasks (FrontPage), 243 text, 104-105 Web pages (FrontPage), 233-234 Deleting Items folder, 58 Description column, 179 descriptions, 63 deselecting Switchboard window, 171 deselecting table fields, 168 design templates, 197, 201-203 Design View automatic saving, 177 creating tables, 176-179 definition, 177 opening, 178 Detailed Address Cards, 68 Details button, 165 Details tab, 67 Dial button, 72 dialing phone numbers, 72 dialog boxes, 22-23 Appointment, 79-81 Appointment Recurrence, 79-81 Call Status, 73 Chart Wizard, 159 Check Full Name, 64 Contact, 64, 71-73 Create a New Signature, 47 Create New Folder, 60 Create Signature, 47
 
 Edit Signature, 47 Event, 81 Event Recurrence, 82 File New Database, 164, 167 Font, 114-115 FrontPage Delete Page, 234 Import, 234-235 New Task, 241 Open Web, 229 Page Templates, 230 Picture, 244 Publish Destination, 248 Publish Web, 249 Set Page Title, 232 Task Details, 242 Themes, 236 Function Arguments, 153-155 Insert Function, 152 Modify Style, 124-125 Move Items, 57 navigating fields, 65 New, 224 New Call, 66, 72 New Folder, 61 New Form, 184 New Query, 193 New Style, 122-123 New Table, 174 Open, 94, 172 Options, 45, 47, 58, 163, 172 Organizer, 126 Outlook Options, 45 PowerPoint Save As, 204 Set Up Show, 215 Print, 56 Save As, 93, 181 Save Attachment, 53 Select a Function, 152 Select a Signature, 48 Select Names, 39, 59 Simple Query Wizard, 190 Startup, 171
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 Task, 72 Templates, 87, 167 Templates and Add-Ins, 126 Untitled - Appointment, 77 Untitled - Meeting, 71 Web Site Templates, 218 Word, 92 dictation, 5, 9-11, 138 Dictation button, 9-10 Discussion Web, Web Wizard, 217 Display Form/Page drop-down list, 171 Display Map of Address button, 73 display styles, 169 distribution lists, 38-40 dividing messages, 44 division, mathematical operators, 140 document templates, 86-88 documents, 12 backups, 93 closing, 94 creating, 83-85 with templates, 86-88 with wizards, 89-90 files, 94 fonts, 111-115 insertion points, 85 navigating, 99-101 opening, 94 Recovery pane, 14-15 saving, 91-93 searching, 94 text adding, 96-98 entering, 85-86 moving between, 109-110 replacing, 98-99 toggling between, 84 Done button, 249 dragging fill handles, 135 handles (charts), 161
 
 dragging/dropping text, 108 drop-down arrow, 44, 76 drop-down boxes Compose in This Message Format, 45 Default File Format, 163 File As, 65 Look In, 235 Save In, 164 Select a Category, 152 Show, 70 drop-down button, 60 drop-down lists Data Type, 179 Display Form/Page, 171 Font Size, 44 Location, 61 Look In, 172 Phone, 65 Recently Used Files, 172 Save In, 167 Show Time As, 79 Tables/Queries, 185, 191 duplicate e-mails, 39
 
 E e-mail address, 63 deleting, 56-58 duplicate, 39 emptying Deleted Items folder, 58 formats, 45-46 forwarding, 58-60 messages adding signatures, 46-48 blind carbon copy (Bcc), 39 composing, 38-41 composing in Untitled Message window, 38 copying, 38
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 default formats, 45 entering, 38-40 formatting text, 41-44 forwarding, 38 plain text, 41 sending, 40, 48 reading, 49-52 sending to contacts, 71 storing, 60 text box, 65 undeleting, 57 Edit Menu commands Clipboard, 108 Copy, 105 Cut, 105 Delete, 57-58 Mark All As Read, 51 Mark As Read, 51 Mark As Unread, 51 Move to Folder, 57 Office Clipboard, 107 Paste, 105 PowerPoint, 209 Primary Key, 181 Undo, 44 Undo Delete, 57 Edit mode, 145 Edit Signature dialog box, 47 editing contacts, 64-66 events, 82 elements, 147 embedded charts, 158-161 Empty the Deleted Items Folder Upon Exiting check box, 58 Empty Web, Web Wizard, 217 emptying Deleted Items folder, 58 enabling Click and Type, 118 End After Range of Recurrence, 81 End By Range of Recurrence, 81 End Time box, 78 End Time text box, 82 Enter keys, 40, 67, 78, 179
 
 equal (=) sign, 139, 142-143, 147 ERR, 143 Esc, 142 Event dialog box, 81 Event Recurrence dialog box, 82 Event window, 82 events, 81-82 examples, queries, 191 Excel charts, 156-161 commands, Tools, Speech, 6 data types, 128-129 features, 137 formulas, 139-140 cell addresses, 139 editing, 145 entering, 142-144 ERR, 143 Natural Language, 144 functions, 147-151 AutoSum, 150 cells, specifying, 153 Date and Time, 149 elements, 147 Financial, 149 Logical, 149 names, 147 searching, 152 Statistical, 149 SUM, 150 worksheets, 148-149 starting, 128 Exit command (File menu), 94 exiting databases, 166 Help, 34 maps, 73 Switchboard window, 171 Expand button, 154 exponentiation, mathematical operators, 140
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 F F11 keyboard shortcut, 160 field information, Update Query, 194 Field Name column, 178-179 fields adding to tables, 174 AutoNumber, 181 deleting, 179 deselecting, 168 identification, 180 navigating in dialog boxes, 65 optional in tables, 168 removing, 175 removing for forms, 186 renaming, 174 selecting for forms, 185-186 Simple Query Wizard, 190 using Tables/Queries dropdown list, 185 table structure, 179 tables, 168 Fields in My New Table list, 174-175 File As drop-down box, 65 file formats, 163 File menu commands, 171 Close, 94, 166 Exit, 94 File, 94 FrontPage Import, 234 New, 166, 218, 230 New, Task, 240 Open Web, 172, 229 Publish Web, 247 Recent Webs, 229 New, 84, 87, 89 PowerPoint Close, 205 New, 197, 202 Open, 205 Save, 203
 
 Print, 56, 161 Save, 53, 66 Word, 92 File Name box, 54 File Name text box, 164 File New Database dialog box, 164, 167 files, 94. See also documents database, 164, 171 double-clicking, 172 locating using Look In drop-down list, 172 opening, 172 opening using Open dialog box, 172 viewing, 172 container, 163 Folders view, 225 importing into FrontPage, 234-235 Fill feature, 135-136 Fill handle, 135 Fill options, 135 Fill options shortcut box, 136 filling adjacent cells, 136 data, 135-136 Filter feature queries, 192 filtering data queries, 189 Financial functions, 149 Find Duplicates Query Wizard, 193 Find Unmatched Query Wizard, 193 finding Help, 31 Finish button, 47, 170, 187, 220 First Name First, 65 Folder List, 60 Folder List button (FrontPage Standard toolbar), 232 folder shortcuts, adding to Outlook Bar, 62 folders Calendar, 75 contacts, 63-64, 69 creating, 60
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 Deleted Items, 57-58 deleting, 62 Inbox, 49 Personal, 61 saving attachments, 53 webs, 224 Folders icon, 224 Folders view, 224-225 Font boxes, 44 Font Color button, 43 Font command (Format menu), 114, 122 Font dialog box, 114-115 Font Size drop-down list, 44 Font Size text box, 44 fonts, 111 applying when formatting text, 44 attributes, 112-115 default setting, 115 e-mail messages, 44 Form Design view, 185 form layout types, 186 Form tab, 188 Form Wizard. 185-187 Format button, 124 Format menu commands Cells, 135 Font, 114, 122 FrontPage Theme, 236 Styles and Formatting, 120 formats, 163. See also file formats data types, 182 MM/DD/YY, 134 formatting documents, 111-115 FrontPage Web pages, 235-238 modifying using Formatting toolbar, 42 removing, 44 text, 41-44
 
 toolbar, 42-44, 112 accessing, 113 Align Left button, 117 Align Right button, 117 Bold button, 112 Center button, 117 Justify button, 117 Styles and Formatting button, 120 modifying formatting, 42 Formatting Toolbar buttons, 43 forms, 184. See also AutoForm creating, 183 from tables using Form Wizard, 185 using AutoForm, 184 using Form Wizard, 185 customizing using Form Wizard, 187 editing using Form Design view, 185 entering data, 188 titles, 187 moving using navigation bars, 188 using Shift+Tab keyboard shortcut, 188 using Tab key, 188 object types, 171, 184-185 opening, 188 previewing layout types, 186 removing fields, Selected Fields list, 186 saving using Save As box, 185 selecting fields, 185-186 layout types, 186-187 Formula bar, 142, 152 formula operators, 142 Forward arrows, 77 Forward button, 59 Forward Mail, definition, 59
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 forwarding e-mail messages, 38, 58-60 From File command (FrontPage Insert, Picture menu), 244 FrontPage, 216 commands File, Import, 234 File, New, 230 File, New, Task, 240 File, Open Web, 229 File, Publish Web, 247 File, Recent Webs, 229 Format, Theme, 236 Insert, Picture, Clip Art, 246 Insert, Picture, From File, 244 creating new pages, 229-232 deleting pages, 233-234 dialog boxes Delete Page, 234 Import, 234-235 New Task, 241 Open Web, 229 Page Templates, 230 Picture, 244 Publish Destination, 248 Publish Web, 249 Set Page Title, 232 Task Details, 242 Themes, 236 importing files, 234-235 inserting pages into webs, 232-233 publishing Web sites, 246-249 Standard toolbar, Folder List button, 232 tasks, 239-240 completing/saving, 242-243 creating, 240-241 deleting, 243 starting, 241-242
 
 templates, 230 themes, 235-238 views Navigation view, 233-234 Page view, 231 Reports view, 243 Web Wizards, creating webs, 217 FrontPage toolbar (FrontPage), 232 Full Name button, 64 Function Arguments dialog box, 153-155 Function Reference topic, 149 functions, 147-153 AutoSum, 150 cells, specifying, 153 Date and Time, 149 elements, 147 entering in worksheets, 151 Financial, 149 Logical, 149 names, 147 searching, 152 Statistical, 149 SUM, 150 worksheets, 148-149
 
 G General tab, 64, 67, 71, 172 General Templates task pane, 166 General Templates button, 166 Go to Date Schedule pane, 77 graphical images, 52 graphics, FrontPage Web pages, 243-246 Graphics button, 238 gridlines, 157
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 H Handles, 135, 161 Help, 28 Answer Wizard tab, 34-35 Ask a Question box, 28-30 Help window, 32-36 closing, 34 Contents tab, 33-34 viewing (showing) tabs, 33 Index tab, 35 keyboard shortcut, 32 Office Assistant, 30-32 asking questions, 31 selecting Assistants, 32 turning off/on, 31 printing, 34 What’s This?, 36 Help Menu commands Excel, 149 Show the Office Assistant, 31 What’s This?, 36 Word, 32 Help on This Function link, 155 hiding Office Assistant, 31 hierarchies, webs, 222 Home addresses, 65 horizontal scrollbars, viewing contacts, 67 HTML (Hypertext Markup Language), 41, 45 HTML Stationery, 46 hyperlinks data types, 182 definition, 45 message formats, 45 Hyperlinks view, 226-227 Hypertext Markup Language. See HTML
 
 I icons Calendar, 75 circular double-arrow, 81 Corporate Presence Wizard, 219 database windows, 164-165 Deleted Items, 57 Folders, 224 Hyperlinks View, 227 Inbox, 57 Mail and Post, 61 Navigation, 222, 232-233 Page, 236 Page View, 223 paper clip, 52 Paste Smart Tag, 106 Queries, 190-192 Reports View, 225 representing attachments, 52 Tables, 164, 178 Tables object, 173, 176 Tasks View, 228 identification fields, primary keys, 180 IF, worksheet functions, 148 images, 52 Images Folder, 225 Import command (FrontPage File menu), 234 Import dialog box (FrontPage), 234-235 Import Web, Web Wizard, 217 importing files into FrontPage, 234-235 In-Cell Editing, 145 Inbox folder, 49-50 Inbox icon, 57 Include Subwebs check box, 249 Increase Indent button, 43-44 indents, 44 Index tab (Help window), 35 input, dictation, 9-11
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 Insert Function, 148-155 Insert Horizontal Line button, 43 Insert menu commands Comment, 132 FrontPage, 244-246 PowerPoint, 207 Signature, 48 Table, 174 Insert mode, 97 insert option (adding text), 96 inserting graphics, FrontPage, 243-246 pictures, 170 signatures, 48 slides , 207-208 insertion points, 85 IntelliMouse, 100 international clocks, 134 international times, 135 invitations, sending for meetings, 71 Italic button, 43-44 item, definition, 51
 
 J job title, contact information, 63 Justified, form layout choices, 186 Justify button (Formatting toolbar), 117 justifying text. See aligning text
 
 K key symbol, 181 keyboard. 103-104 keys Backspace, 40, 146 Ctrl, 57 Delete, 40, 146, 179, 234 Enter, 40, 67, 78, 179 primary keys, 180-181 Shift, 57 Tab, 65, 179, 188
 
 shortcuts copying text, 105 Ctrl+Enter, 48 Ctrl+P, 56 cutting text, 106 F11, 160 font attributes, 113-114 Help, 32 navigating documents, 100-101 pasting text, 105 PowerPoint, Save, 204 scrolling, 100 Shift+Tab, 188 Undo, 99
 
 L labels, 128-130 Language bar (Speech feature), 9-10 Large Icons button, 165 Last Name First, 65 layout types (forms), 186-187 layouts, slides, 207 left alignment, 44 left arrow, 75 Legend tab, 160 legends, defined, 157 lines, 156-157 links, Help on This Function, 155 List button, database window toolbar, 165 Location drop-down list, 61 Location text box, 78, 82 locations, selecting for database files, 164 Logical functions, 149 logos, entering in databases, 169-170 Look In drop-down box, 235 Look In drop-down list, 172 Lookup Wizard, 182
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 M mail. See e-mail Mail and Post icon, 61 Mail Format tab, 45-47 Mail Message command, 38 Main Switchboard window, 170 Make Table Query, 194 managing appointments with Calendar, 75 calls, 72 mail creating folders, 60 deleting, 56-58 emptying Deleted Items folder, 58 undeleting, 57 maps (contact addresses), 73 Mark All As Read command (Edit Menu), 51 Mark As Read command (Edit Menu), 51 Mark As Unread command (Edit Menu), 51 mathematical operators, 140 MAX, worksheet functions, 148 meetings, scheduling, 71, 79-81 Memo, data types, 182 Memo Wizard, 89 menus, 62. See also shortcut menus File, 171 Office, 18-20 message formats, hyperlinks, 45 message information, Inbox, 49 Message Recipients list, 39 Message toolbar, 48 message windows, Inbox, 50 messages answering, 54-55 composing, 38-41 composing in Untitled Message window, 38 copying, 38 default, setting formats, 45 deleting, 56
 
 e-mail, 46-48 dividing when formatting text, 44 formatting text, 41-44 forwarding, 38 forwarding mail, 59 opening, 50 plain text, 41 printing, 56 saving attachments, 52-54 sending, 40 in HTML format, 45 in plain-text format, 45 in RTF (Rich Text Format), 45 to contacts, 71 storing, 60 Microphone button, 10-11 Microphone Wizard, 6-7 Microsoft Excel Help command (Help Menu), 149 Microsoft Expedia Web site, 73 Microsoft Word Help command (Help menu), 32 MIN, worksheet functions, 148 mini-reports, 225 miscellaneous Query Wizards, 192-194 MM/DD/YY format, 134 modems, dialing phone numbers, 72 modes Edit, 145 Insert mode, 97 Typeover mode, 98-99 Modify button, 237 Modify Style dialog box, 124-125 modifying contacts, 66 documents, 96-99 formatting, Formatting toolbar, 42 indents, formatting text, 44 styles, 121-125 table design, Table Wizard, 176 text, 115
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 Monthly Calendar pane, 75-77 mouse pointer, 36 text, selecting, 101-103 wheel mouse, 100 Move Items dialog box, 57 Move pointers, 108 Move to Folder command (Edit menu), 57 moving charts, 161 text, between documents, 109-110 multiplication, mathematical operators, 140
 
 N names contact information, 63, 66 field, rules, 178 functions, 147 selecting for database files, 164 naming tables, 175, 181 Natural Language formulas, 144 navigating Calendar, 75-77 databases, Switchboard window, 170 documents, 99-101 fields, dialog boxes, 65 Help window, 36 wizard screens, 168 navigation bars, moving in forms, 188 Navigation icon, 222, 232-233 Navigation view, 220-222, 233-234 New All Day Event (Actions Menu), 81 New Blank Document button (Standard toolbar), 84 New button, 38, 47 Database toolbar, 164 database window, 174
 
 database window toolbar, 184 PowerPoint Standard toolbar, 203 New Call dialog box, 66, 72 New command File menu, 84, 87-89, 166, 218 FrontPage File menu, 230, 240 PowerPoint File menu, 197, 202 New Contact button, 64 New Contact command (Action Menu), 64 New dialog box, 224 New File task pane, 23 New Folder dialog box, 61 New Folder shortcut menu, 60 New Form dialog box, 184 New from Templates section, 218 New Meeting Request to Contact (Action menu), 71 New Message to Contact (Action menu), 71 New Message to Contact shortcut menu, 71 New Office Document menu (Start, New Office Document), 17-18 New Query dialog box, 193 New Recurring Appointment (Actions menu), 79 New Slide command (PowerPoint Insert menu), 207 New Style dialog box, 122-123 New Table dialog box, 174 New Task dialog box (FrontPage), 241 New Task for Contact (Actions menu), 71 Next button, 168-170, 175, 186-187 Next command (View menu), 50 Next Item button, 50 Next Page buttons, 99 NO BONUS, 149 No End Date, Range of Recurrence, 80 notes, contact information, 63 Numbered list style, 44 Numbering button, 43-44
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 numbers adding when formatting text, 44 data types, 182 entering, 133-134 formatting cells, 133 phone numbers, 72 series, 136 Numbers tab, 135
 
 O Object Linking and Embedding. See OLE Object pane, 165, 176 object types, 171, 184 Office dialog boxes, 22-23 Help, 28-32 menus, 18-20 opening applications, 17-18 task panes, 23-25 toolbars, 20-21 Office Assistant, 30-32 asking questions, 31 hiding, 31 selecting Assistants, 32 turning off/on, 31 Office Clipboard, 23, 107-108 Office Clipboard command (Edit menu), 107 Office XP, 5 activating, 15-16 new features document recovery/Recovery pane, 14-15 product activation, 15-16 smart tags, 12-13 task panes, 13-14 voice dictation/commands, 5 OK button, 57, 81-82, 170, 174, 181, 185 OLE (Object Linking and Embedding), 182
 
 One Page Web, Web Wizard, 217 Onscreen Presentation (AutoContent Wizard), 199 Open button, 172, 205 Open command, 94, 172, 205 Open dialog box, 94, 172 Open File button, 126 Open It button, 53 open messages, 56 Open Web command (FrontPage File menu), 229 Open Web dialog box (FrontPage), 229 operator precedence, 141 operators formula, 142 mathematical, 140 option buttons All Pages, 236 Changed Pages Only, 248 Selected Page(s), 236 Using Timings, If Present, 215 optional fields, 168 Options command (Tools Menu), 45-47, 58, 163, 172 Options dialog box, 25-26, 45-47, 58, 92, 163, 172 Options tab (Customize dialog box), 19 Organizer button, 126 Organizer dialog box, 126 organizing data, queries, 189 Other addresses, 65 Other tab, 58 Outlook, 37-38 Address Book, 39 Autodate, 78 bar, 62 Contacts list, 38 Inbox, 38 Options dialog box, 45 Shortcuts, 58 status bar, 49 toolbar, 56
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 P p.m., 134 Page icon, 236 Page Templates dialog box (FrontPage), 230 Page view, 222, 231 Page View icon, 223 pages child, 222 opening, Folders view, 225 parent, 222 panes Monthly Calendar, 75-77 Object, 165 Preview, 49 Schedule, 75-77 task, Styles and Formatting, 125, 164, 218 paper clip icon, 52 paragraph marks, 86 paragraph styles, 120-123 parent pages, 222 parentheses (), 141 Paste button (Standard toolbar), 105 Paste command (Edit menu), 105 Paste Smart Tag icon, 106 pasting text, 105-107 Personal, Table Wizard table types, 174 Personal Folders, 61 Personal Information Manager (PIM). See PIM (Personal Information Manager), 37 Personal Web, Web Wizard, 217 phones calls, managing, 72 contact information, 63, 72-73 drop-down lists, 65 Phone List, 68 phone numbers, 72 Pick from List, 137 Picture button, 170 Picture command (FrontPage Insert menu), 244-246
 
 Picture dialog box (FrontPage), 244 pictures, inserting, 170 pie chart, 157 pie wedges, 156 PIM (Personal Information Manager), 37 plain text messages, 41 plain-text format, 45 planning events, Calendar, 81-82 Play button, 213 PMT, worksheet functions, 149 pointers, 108 pound (#) signs, 134 PowerPoint commands Edit, Delete Slide, 209 Edit, Undo, 209 File, Close, 205 File, New, 197, 202 File, Open, 205 File, Save, 203 Insert, New Slide, 207 Slide Show, Animation Schemes, 211 Slide Show, Set Up Show, 215 Slide Show, Slide Transition, 213 Slide Show, View Show, 209 Tools, Speech, 6 dialog boxes Save As, 204 Set Up Show, 215 keyboard shortcuts, Save, 204 layout, Slide Layout pane, 207 presentations, 196 slide shows animation, 210-212 timings/transitions, 213-215 viewing, 209-210 Standard toolbar, 203-205 starting, 196
 
 269
 
 26 6602 Index
 
 270
 
 11/8/01
 
 2:28 PM
 
 Page 270
 
 Ten Minute Guide to Microsoft Office XP
 
 presentations closing, 205 creating, 196 35mm Slides (AutoContent Wizard), 199 AutoContent Wizard, 197-201 Black-and-White Overheads (AutoContent Wizard), 199 blank presentations, 203 Carnegie Coach (AutoContent Wizard), 199 Color Overheads (AutoContent Wizard), 199 design templates, 197, 201-203 Onscreen Presentation (AutoContent Wizard), 199 Web Presentation (AutoContent Wizard), 199 deleting slides, 208-209 duplicate slides, inserting, 208 onscreen slide shows animation, 210-212 timings/transitions, 213-215 viewing, 209-210 opening, 205 saving, 203-204 slides, inserting, 207-208 Preview pane, 49 previewing form layout types, 186 signatures, 48 Previous command (View Menu), 50 Previous Item button, 50 Previous Page buttons, 99 Primary Key button, 181 Primary Key command (Edit Menu), 181
 
 primary keys, 181 creating, 181 definition, 176 fields, 181 identification fields, 180 selecting using Table Wizard, 176 setting, 180-181 tables, 175, 180-181 Print command (File Menu), 56, 161 Print dialog box, 56 printing charts, 161 Help, 34 toolbar shortcut, 56 received messages, 56 Private Folder, 225 Problems list, 226 Programs menu (Start, Programs), 17 Project Web, Web Wizard, 217 Properties box, 66 Publish button, 249 Publish Destination dialog box (FrontPage), 248 Publish Web command (FrontPage File menu), 247 Publish Web dialog box (FrontPage), 249 publishing, Web sites (FrontPage), 246-249
 
 Q queries Datasheet view, 192 definitions, 189 deleting records, 192 example, 191 Filter feature, 192 opening, 192 organizing data, 189 Query Wizard, 190-192 rerunning, 192 saving, 191
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 select, 190 Sort feature, 192 titles, 191 Queries icon, 190-192 Query Design view, 192 Query menu, 195 query types, 194-195 Append Query, 194 building, 194 Delete Query, 194 Make Table Query, 194 Query menu, 195 Update Query, 194 Query Wizards, 192-194 Quick AutoSum, 151 quotations marks (“”), 149
 
 R Range of Recurrence area options, 80-81 reading received mail, 49-52 receiving mail, 49-52 messages, 54-56 saving attachments, 52-54 Recent Webs command (FrontPage File menu), 229 Recently Used Files drop-down list, 172 records, queries, 192-194 Recovery pane, 14-15 Recurrence button, 81-82 Recurrence Pattern, 80 Recurring Appointments, 76, 79-81 recurring events, 82 recurring meetings, scheduling, 79-81 red triangles, 132 references, cell, 142 Reminder check box, 78 Remove (					    
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